General Disclaimer of Warranties/Liabilities
Applies to All Users

Neither the State of Oklahoma, nor the Oklahoma Department of Transportation, nor their
employees make any representations or warranties, express or implied, with respect to the use of
or reliance on the data provided herewith, regardless of its format or means of transmission.
There are no guarantees or representations to the user as to the accuracy, currency,
completeness, suitability or reliability of this data for any purpose. THE USER ACCEPTS THE
DATA "AS IS" AND ASSUMES ALL RISKS ASSOCIATED WITH ITS USE. The Oklahoma
Department of Transportation assumes no responsibility for actual, consequential, incidental,
special or exemplary damages resulting from, caused by or associated with any user's reliance on
or use of this data, even if appraised of the likelihood of such damages occurring.
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PREFACE

The ODOT MAPPING Policy & Procedures Manual is to be used to develop
Computer Aided Drafting and Design (CADD) County and City maps for the
Oklahoma Department of Transportation. This document is written for CADD users

in a transportation mapping design environment and is to present the direction of map
preparation in conjunction with CADD software operating in Windows NT operating
system. The Oklahoma Department of Transportation makes no warranty, expressed
or implied, as to the documentation, function, compatibility, or performance of the

prograrhs described within this document.
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INTRODUCTION

Purpose

This manual of CADD mapping policy & procedures sets forth computer aided drafting
and design (CADD) policies for Oklahoma Department of Transportation mapping
projects.

Authority

The ODOT CADD mapping policy & procedures manual was written by the Mapping
section of GIS Management / Planning Division as directed by the Office of the
Assistant Director for Preconstruction.

General
This document is intended to be used as a basis for uniform CADD application for

transportation mapping design. It is not intended to replace or supersede engineering
documents or publications.
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County Maps

Overview

County Maps are updated from new inventories every 7 to 10 years. Each county must be
evaluated as to the changes needed and drawn to conform to the new standards of the Intergraph
CADD system . These vectorized maps will replace the original manually drafted maps now on
file in raster scanned form.

County maps are named and stored by their county number and sheet number as shown in the
following example:

c01xx01.dgn = where c01=Adair County, xx = is the divider, and 01 = sheet number.
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Subject: Format Policy No. 100-1
Page 1 of 1
Effective Date: 1 Aug. 2000

County maps are positioned on the Oklahoma Plane Coordinate System that aligns all county and
city information together on an overall State Base Map. The digital maps eventually will be
linked to GIS Management’s Road Inventory GIS database . When completed, this will allow the
graphic representations to be more information based by cross-referencing known road data,
traffic and other data files to the positions of road locations on each map. County maps are
actually drawn on the computer to full scale, 1:1, but are formatted for general use on the layout
for printing at 1 inch to the mile. Paper copies are also shot at a more convenient half size at
approximately %2 inch to the mile. Counties are numbered alphabetically from 1 to 77. Since
several counties cover 2 sheets and Osage takes 4 to complete, there are 102 total sheets in a full

eat nf county mans
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The Oklahoma Plane Coordinate System conforms to a 20,000 foot grid that is either in the North
or South Projection Zone. The North and South grids overlap several miles in the center of the
state where counties and their subsequent USGS Topographic maps cross both projections. Each
county is drawn on the projection that best covers its county area. Depending on their shape and
size, counties are drawn on either horizontal or vertical layouts. There is also a state base map
of the corresponding latitude and longitude lines, as well as an outline map showing the placement
of all the 7% minute topographic maps in Oklahoma. All of these base maps are used as reference
files to warp scanned copies of the 1927 North American Datum or 1983 (corrected NAD)
Topographic maps to the county. When conforming to the base map each county has to be
drawn at an adjusted active angle to allow the text, symbols and lines to be parallel to the roads
and base lines. ‘

The first sheet of each county contains the title block, a county legend, county to state location
guide, and a sheet to county location guide, if necessary. Also listed is the date of inventory, date
of the original drafting, initials of the draft person and revision information. Along the edges of
each county sheet are range and township numbers, county road ID numbers, the 20,000 ft. grid
lines and numbers, latitude and longitudes in 15 minute notations, highway destination arrows,
adjoining county names and dashed match lines when needed.
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Subject: Mapping Menus and Special Palettes Policy No. 100-2
Page 1 of 1
Effective Date: 1 Aug. 2000

To standardize the drafting of county maps special palettes and custom pull-down menus have been
built that employ user commands to replicate map graphics. The special county map menu designed
using Microstation’s CADD sofiware is called CoMaps. Several additional custom palettes have also
been created for small and large city maps. The CoMaps menu is inserted along the upper right end
of the Command Window that contains Microstation’s other main pull-down menus.

The custom menus have sub-menus with user commands. Comaps submenus are: Roads, Symbols,
Linework, Drainage, Text and Tools. Some of these have separate or group palettes that arrow out
and open the movable palettes on the design screen. These palettes and menus are used to draw
county and other maps and correspond to a mapping cell library that should be attached to the
drawing files.

Others groups of special custom graphic palettes are designed as additional line styles. When
viewing a county map file on a computer not containing these files the custom line styles and cells -
will need to be imported and attached separately.
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Subject: Mapping Menus and Special Palettes (continued) Policy No. 100-2
Page 1 of 1

Effective Date: 1 Aug. 2000

The special user commands are designed so that each graphic element is placed on the appropriate
level with the correct line weight, color and size. The buttons on the movable palettes sometimes
have arrows in the lower right corners that conceal groups of like symbols or commands. These
can be left open on the design screen by dragging off the initial group symbol, if needed. Default
settings can be configured so that your design area will always come up with the special palettes
you wish to use when starting the program.

vace Window CoMaps SmCity LrgCity Formats Help
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Subject: Mapping Menus and Special Palettes (continued) Policy No. 100-2
Page 1 of 1
Effective Date: 1 Aug. 2000

The entire selection of attached cells can be
placed on screen by using the Cell Selector
submenu from the Utilities pull-down on
Microstation.

This example has symbols removed that are used
one time or rarely used. Mostly just those
. symbols that are used to show culture, and
~ appear in the county map legend, are kept in the

Cell Selector so it won’t take up too much space
on the de,sign screen

L322 L2A 2 SLiTeal.

On Microstation, a facilitating Tool Settings
palette can be set to come up and will change
with each palette user command. This is turned

“on or off from the Tools pull-down on the
Command Window. It can be especially useful
for keeping track of your work in progress and
adjusting symbols or commands.

The culture symbols, shown here, are mostly only
used in drawing county maps, as most culture is
not shown on city maps or within the city limits
on a county map. Exceptions might be; town
centers, airports, schools, hospitals and
cemeteries.

The Comap submenus for Linework, Text and Tools are not palette menus but set up user
commands. They change the tool or desktop settings to allow placement of graphics and text in the
proper drawing modes. Each user command has been given very specific settings to make sure all
maps consistently conform to their drawing standards. Individual maps at times may require specific
changes to address their own problem areas, but all effort is placed on keeping maps as similar in
design as possible.
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Subject: Legend and Title Block Policy No. 100-3
Page 1 of 1

Effective Date: 1 Aug. 2000

The County map legend is placed on the side or bottom of each county and only on sheet 1 of any
multiple sheet county. It should be placed close to the Title Block whenever possible. The entire
Legend and a Title Block are in the Comap Symbol pull-down submenu Border/Legend Symbols.
The Title Block should be placed in the right bottom corner. The Legend should be placed above and
close to the Title Block when possible. The Legend may have to be separated in equal parts and
placed in sections or realigned horizontally along the bottom edge. This will be determined by the
area of the county on the sheet. To change cells, their cell status must be dropped. This is always
the case with the Title Block once it has been positioned. The county name will have to be Text
Edited after dropping its cell properties.

N
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| Subject: Civil Townships Policy No. 100-4

Page 1 of 1
Effective Date: 1 Aug. 2000

The original Civil Townships that were established at statehood vary in size. The areas are defined
using the historical township maps from the Mapping files. The Civil Township names are lettered
by spacing each letter apart evenly in the most central and open rural areas of each township. These
historical townships are outlined in thick dashed lines when not following roads or other borders.
Otherwise they are designated along roads with the letters "T.L."for Township Line.
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Subject: Range and Township Numbers Policy No. 100-5
Page 1 of 1
Effective Date: 1 Aug. 2000

Civil townships are not to be confused with the 6 mile square townships that define the mile section
lines from the original survey. Oklahoma was surveyed beginning in 1870 from an Initial Point. The
Initial Point designated as “0,0" lies on the north side of the Arbuckle Mountains west of the Davis
exit from I-35 and on the Murray and Garvin County Line. Ranges & Townships begin at the
“0,0",which defines the intersection of the principal meridian, a North-South line called the Indian
Meridian and an East-West line called simply the Base Line. Range & Township numbers derived
from this point are the center points of 6x6 mile square Townships that are numbered into 36 mile
sections. Township numbers are for the north or south distance and Range numbers designate the
east or west position from the Initial Point. The Panhandle was surveyed separately from an Initial
Point starting at its most southwest corner. The Cimarron Base Line is the East-West line numbered
only to the East and the Cimarron Meridian is the North-South line numbered only to the North.
Range numbers will be placed on both the north and south borders of a county map. Township

numbers will be placed on both the east and west borders of a county map.

Township mile sections are numbered in a descending pattern starting with number 1 in the northeast
going west to the corner and descending from 6 to 7 on the next row and east and back and forth in
6 mile rows to the number 36 in the southeast corner. The 4 corner sections of each 6 square mile
Township on a county map should show the section numbers for sections 1, 6, 31 and 36, whenever
possible. Where creeks or other features interfere with showing these corner numbers other sections
may be shown or in some cases all 36 section numbers may need to be indicated.
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Subject: County Road ID Numbers Policy No. 100-6
Page 1 of 1
Effective Date: 1 Aug. 2000

Section Line Numbers are also defined by County Road ID Numbers that provide a state-wide
numbering system and aid in designating numbers for county roads. The letters "EW" or "NS" plus
a three digit number are positioned around the outside borders. These numbers are generally onthe
east and south sides, every six miles, in line with the township corners, with single number counts in
between. Roads that lie directly or very near actual Section Lines are also known by that number.

The letters "N","E" and "D"(diagonal) plus five digits are designated for county roads that run

‘between Section Lines and are placed inside the actual map area. The fourth number on these

represents a tenth of a mile designation, the fifth is for hundredths, between actual Mile Section Line
numbers which would be in exact miles with both being just zeros. The letters are chosen to show

the prominent direction ofthe road. These County Road Numbers are used to allow state and county

governments full account-ability of county road projects and provide a system to quickly locate these
roads. Where State Highways cross county lines they are extended .5 inches and a destination arrow
is added to show the next incorporated town.
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Subject: Enlarged Area Insets Policy No. 100-7
Page 1 of 1
Effective Date: 1 Aug. 2000

When rural communities have houses, roads and buildings that are not easily defined in the one inch
per mile scale Enlarged Area Insets are used to fairly represent the culture and development in these
areas. The amount of space available around the edges of a county map also determine how much
information is placed in an inset. Areas that have at one time been incorporated and have community
or place names take priority over other more recent developed areas. To be eligible to be drawn on
an enlarged inset the area must have a town center and place name.

Enlarged area insets are outlined on the county with a thin line showing the edges of the area depicted
in the inset. Individual insets often have different scales of enlargement depending on the space
available and the amount of information being represented. The Comap pulldown submenu,
Linework, is selected for using Inset Border and Inset Border on Map commands. The Section
Number, Range and Township locations are denoted under the name of the place depicted in the

enlarged area, as well as its own mileage scale below.

R
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City Maps
Overview

City Maps are drafted in one of four categories :

(1.) Small City Maps (less than 2,500 pop.) - drawn using County Map conventions for road band
widths.

(2.) Large City Maps (2,500-5,000 pop.) - drawn to accommodate scale, density and detail.

(3.) Urban City Maps (5,000-50,000 pop.) - drawn to accommodate scale, density and detail.

(4.) Large Urban City Maps (over 50,000 pop.) - where adjoining populated areas surrounding
Oklahoma City and Tulsa require that they all be drawn to the same scale so that they match each
other.

City maps use the same map levels for similar features as the county maps. Different levels apply and
are turned on or off accordingly. Cities are enlargements of the city areas shown on the county maps
but remain proportionate while often using different line styles and lettering.

City maps are named and stored by their county number, city number and sheet number as shown in
the following example:

t041001.dgn = where t04=Beaver County, 10 = is the city number, and 01 = sheet number.
(See Appendix F for a list of county and city numbers)
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Subject: Small City Maps (less than 2,500 pop.) Policy No. 200-1
: Page 1 of 1
Effective Date: 1 Aug. 2000

Small city maps are drawn using the comap and small city menus. The city is drawn from the line

work which is taken from the roughed-out county map. While in the county drawing, save the file.

as the city name for the new file, modify the drawing using small city standards. Should a map be too
large to be drawn at a reasonable scale (min. 4"), the city should be drawn using the large city menus
and formats. Do not use custom city streets on a small city which has not been drawn in large city
format. Small cities should be drawn at the scale that best shows the area represented on a 18" x 30"
printed format. Horizontal or vertical layouts are selected according to city shape and growth. Ifa
city is obviously growing wider than what it was the last time it was drawn, the direction of the layout
and/or the scale may have to be changed to account for the variation in size. Enough area, usually
a mile or so, should be allowed around the edges of cities to allow for future growth. The next time
the city is drawn, it can then, hopefully, be redrawn without having to rescale and completely redraw
the entire map.

If more than one sheet is required a “sheet_ of sheets” notation and an index showing the different
sheet areas needs to be added. Match lines between sheets are also a consideration, in this case,
especially when formatting a newly drawn or redrawn city. The scales for most cities should be a
number divisible by 4 or 5 and not larger than 12 (4" -5"-10" to 12" = 1 mile) This may vary for small
cities within Metro Area Maps or for some Custom Cities.

As is the case for all counties or cities, a supervisor or someone else will check completed cities
before they are photo reproduced. Any corrections or changes will be made then and a black and
white Mylar copy will be plotted to go to the photo lab.

Small cities are drawn at their final scale. A 100% Positive clear reproduction is shot of the final city
map and saved in GIS Management’s city map flat files. The Reproduction Department also shoots
a micro-film version for their city map file from this photo. They are also scanned and stored on CD-
ROM by reproduction. The new digitized version is placed on the computer server’s City Map
Library of .dgn files.

N
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Subject: Large City Maps (2,500 - 5000 pop.) Policy No. 200-2
' Page 1 of 1
Effective Date: 1 Aug. 2000

Large cities are defined as those with a population of 2500 to 5000. Large cities have their own road
band, lettering and symbol palettes. They are drawn at 2:1 scale. This means they plotted on a larger
36" x 60" format that is shot down to match the 18" x 30" size of the smaller cities when reproduced
on the camera. A 50% positive clear and micro-film version are shot and stored. They are also
scanned and stored on CD-ROM by reproduction.

Large city maps drawn using large city menus and formats. The city is drawn from the roughed-out
county map. While in the county drawing, save the file as the new city name and modify the drawing
by using the large city standards and menus. Should the map be too large to fit at a reasonable scale
to clearly name all streets, urban city format may be used. Adjoining cities on the same map should
show both corporate limits and streets which are within the area of the map. If more than one sheet
is required a “sheet_ of sheets” notation and an index showing the different sheet areas needs to be
added. Match lines between sheets are also a consideration, in this case, especially when formatting

a newly drawn or redrawn city.
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Subject: Urban City Maps (5,000 - 50,000 pop.) Policy No. 200-3
- Page 1 of 1
Effective Date: 1 Aug. 2000

Urban city maps are drawn the same as large city except interior streets are drawn using line style
100sol. They are drawn at 2:1 scale. This means they are plotted on a larger 36" x 60" format that
is shot down to match the 18" x 30" size of the smaller cities when reproduced on the camera. A
50% positive clear and micro-film version are shot and stored. They are also scanned and stored on
CD-ROM by reproduction.

“p/

e



PN

OKLLAHOMA DEPARTMENT
OF TRANSPORTATION
MAPPING POLICY AND PROCEDURES MANUAL

Subject: Large Urban City Maps (Over 50,000 pop.) Policy No. 200-4
' Page 1 of 1
Effective Date: 1 Aug. 2000

The two largest cities in Oklahoma have grown to include the surrounding areas. Oklahoma City and
Tulsa are drawn as Metro Area Maps with single line roads plotted at a scale of 4" to the mile.
Oklahoma City has two separate composite maps that include neighboring cities along North-South
and East-West directions. These include the adjacent cities that lie along major highway corridors.
Tulsa has one composite that includes parts of the neighboring cities.

The Oklahoma City Metro Area has communities that are completely surrounded by its city limits and
these areas included within its map. These surrounded cities, however, still have separate city maps
drawn and kept in the flat file of incorporated cities.

All of the larger cities that are included in the Metro Area and the Composite maps are drawn at the
same scale (4"= mile) so they can be easily attached together to make the long corridor maps or be
plotted together where areas often overlap possible highway projects.

The Oklahoma City area now includes:

Norman, Hall Park, Moore, Edmond, Arcadia, Midwest City, Del City, Bethany, Woodlawn Park,
Warr Acres, The Village, Nichols Hills, Forest Park, Lake Aluma, Valley Brook, Smith Village,
Yukon, Mustang, Choctaw, Nicoma Park, Spencer, Jones and Harrah. The North/South corridor
runs from southern Logan County to northern McClain County. The East/West corridor runs from
eastern Canadian County to western Lincoln County.

The Tulsa area includes parts of:
Sands Springs, Jenks, Bixby, Broken Arrow, Fair Oaks, and all of Catoosa.

Large urban city maps are drawn the same as large city except interior streets are drawn using line
style 100sol and undivided highways are drawn using line style 200sol. In city maps where streets are
still too restricted in space to allow complete street names, an index numbering system is often used.
The mile sections are designated with numbers from east to west and with letters from north to
south. All the streets affected within the same mile section are given consecutive numbers inside
parenthesis where the names would be.

The street names are then listed by mile section index numbers and their street numbers along the
borders of the city map sheets. This is true for other large cities also when necessary. Some cities
or towns may have so few of these that using just consecutive numbers without indexing is a plausible
alternative. These maps are taken to reproduction to be shot, microfilmed and scanned onto CD-
ROM.
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Subject: Ground Inventory Policy No. 300-1
Page 1 of 1

Effective Date: 1 Aug. 2000

The Inventory Section of GIS Management works closely with the Mapping Section and provides
county folders of recently inventoried counties and cities. The ground field crew drives down every
county road and looks for changes that have occurred since the last time the county was inventoried.
These folders include :

A previous full size county map marked with changes discovered during the field and aerialinventory.
These field maps are color coded by road-surface-types and contain symbols and special coded
lettering describing what additions and subtractions were found.

0.ORANGE -(Paved)Concrete 3.GREEN- Grade & Drain
1.RED -(Paved)Asphalt 4 GREEN DASH- Unimproved
2 BLUE- Gravel 5.BROWN- Deleted/Non-existent

Other field map markings include new map culture symbols and new names for culture features.
Culture symbols in disrepair, condemned or no longer in existence may be marked with an "X", or
marked over in brown pencil. Brick streets may also be marked with a series of small “X’s”.

Incorporated City Maps from the same county are often marked up in a similar manner. Some of
these, if located on the border may be in an adjoining county's file folder. Local City Planning Maps
from town halls are also included, when available. Sometimes these have additional street names but
must be checked with photos and the rest of the inventory since they often contain proposed streets
and additions that may have been zoned but not built.

D
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Subject: Aerial Inventory Policy No. 300-2
Page 1 of 1
Effective Date: 1 Aug. 2000

Also in the county file is a half size county map guide depicting locations of the latest aerial photos.

The actual photos are kept in a separate county photo file. Each photo is given a number showing
the date and sequence of the photo coverage. The county map guide shows the photo’s number and
its center point. '

These numbers may also be referred to as a reference on the full size county inventory map.
Sometimes a more detailed visualization of major changes can only be realized from the photos,
especially when the final construction project differs from the original design plans. Some additional
photos are often provided for any recent State Highway Projects which are at or near completion.
These photgs may be used as a visual reference or scanned and wa__rped to use as reference files when

necessary.

Photos are also sometimes marked up on the photo. Only consider these markings when referred to
-on the full size city or county inventory map. These should be circled in blue on the map.
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Subject: U.S.G.S. Topographic Maps Policy No. 300-3
Page 1 of 1

Effective Date: 1 Aug. 2000

Topographic Maps provided by the GIS Council on CD-ROM are scanned digital images that are
geo-referenced to the base map coordinates used in the mapping and GIS seed files. They are a
primary source of map data. These are either on a server as .TIF files or on their appropriate CD-
ROM. Some topos which overlap county boundaries may be used in adjoining counties.

—”



OKLAHOMA DEPARTMENT
OF TRANSPORTATION
MAPPING POLICY AND PROCEDURES MANUAL

Subject: County Base Maps Policy No. 300-4
Page 1 of 1
Effective Date: 1 Aug. 2000

The Oklahoma Plane Coordinate System conforms to a 20,000 foot grid that is either in the North
or South Projection Zone. The North and South grids overlap several miles in the center of the state
where counties and their subsequent USGS Topographic maps cross both projections.

When conforming to the base map each county has to be drawn at an adjusted active angle to allow
the text, symbols and lines to be parallel to the roads and base lines.
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Subject: Highway Plans Policy No. 300-5
Page1of 1

Effective Date: 1 Aug. 2000

As new alignments and highways are constructed, the Design Divisions will forward the cover sheets
to these projects to GIS Management. Keeping a close eye on agenda items being approved by the
Transportation Commission can also alert one to the upcoming revisions that affect county and city
maps. The Systems section of GIS Management should know what these projects are as they usually
record and keep track of approved projects, lettings, reassigned routes and finished constructions.
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Subject: Digital Orthophoto Quarter Quad Aerials Policy No. 300-6
Page1of 1
Effective Date: 1 Aug. 2000

Digital Orthophoto Aerials are provided by the Oklahoma GIS Council for the entire state. These
are a primary source of map data. The DOQ’s are digital photo images are geo-referenced to the
base map coordinates used in the mapping and GIS seed files. These are on the Image server as
.COT’s or on the Onenet Internet site for the GIS Council. Some DOQ’s which overlap county
boundaries may be used in adjoining counties.
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Subject: Additional Sources Policy No. 300-7
Page 1 of 1

Effective Date: 1 Aug. 2000

Other sources of information that you might want to refer to or have readily available are:

A current version of the Oklahoma Department of Transportation's Official State Map, State Railroad
Map and an original copy of your county's Civil Township Map (from Mapping Section's flat files).

A copy of Oklahoma Aeronautics Commission's Airport Directory showing size, status and location
of state airports and the latest available Oklahoma Aeronautical Chart.

The Inventory Section's booklet of Control Section Maps is useful for showing routes, known
changes and proposed projects. Their Road Inventory Manual shows for field inventory procedures.

1518 3 =2, LAAUAL AN AAAVRALRL Y AVaAgLi Al 221 4

The Wildlife Department's “Public Hunting Lands” is available in book form and as CADD files.

The U.S. Department of Interior prints "Decisions on Geographical Names", a booklet updating
changes in official names approved by the Federal Government.

In some cases the need arises to personally contact certain City, County or State offices by telephone
or through field workers or department channels. Ask your supervisor if a question that may require
a long-distance phone call or direct correspondence is necessary before personally making these
decisions. A city/county directory of local officials is available through your supervisor.

The most dramatic highway changes on County Maps over a period of six to ten years are in the
development of cities, towns and communities. So the logical first step before drafting your county
map is to examine city map changes first. City boundaries often change and will affect both county
and city map drawings differently.

Iftopographic maps were recently updated, city streets and other geographic locations are often fairly
accurately depicted. These areas when scanned provide a helpful guide for both City and County
layouts. New inventoried items will have to be added to the existing streets but the basic street layout
will help in the placement of cities on the county format.

The city maps can then be drawn on their city map layers which are separate with their own line styles
and formats. Sometimes aerial photographs which are more recent than topos or city planning maps
can also be used in this way for small cities, communities or complicated interchanges.
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APPENDIX A: Printing Specifications
Al.1 Computer Generated Plots

County maps and city maps on the computer are drawn to scale at 5,280 feet to 1 mile. This allows
for measurements and engineering applications to be accurate. Specific size formats for flat sheet
reproductions, however, are plotted at standardized reasonable sizes for general use.

When plotting use the Fence (Shape) tool to define the plot area.
Select IPLOT from the Microstation File menu or Windows group.
Set the Active Angle to that of the county or city drawing.

Select the que for the plotter.

To make it easier to control these plot standards, special settings are configured when using IPLOT
to make sure that the various maps are consistent in format and appearance.

From IPOT File menu select Settings ...
Go to where your .set files are stored and choose the proper one
Select Plot from the File menu.

County maps use the IPLOT setting - comap.set

Half size county maps use the IPLOT setting - half co.set.
City maps use the IPLOT setting - bwcity.set.

Half size city maps use the IPLOT setting - half city.set.

These files contain these standard settings for planning’s plotter and workstation setup.

File name comap.set
Plotter #queue=<pln_hp3c>
Scale scale=5280:1
.ctb location color_table=c:\win32app\ustation\wsmod\planning\tables\bw.ctb
.pen location pen_table=none
half co.set

#queue=<pln_hp3c>

scale=10560:1
color_table=c:\win32app\ustation\wsmod\planning\tables\bw.ctb
pen_table=c:\win32app\ustation\wsmod\planning\tables\halfdot.pen

bwecity.set
#queue=<pln_hp3c>
scale=5280:1
color_table=c:\win32app\ustation\wsmod\planning\tables\bw.ctb
pen_table=c:\win32app\ustation\wsmod\planning\tables\ray.pen



half _cty.set
#queue=<pln_hp3c>
scale=10560:1
color_table=c:\win32app\ustation\wsmod\planning\tables\bw.ctb
pen_table=c:\win32app\ustation\wsmod\planning\tables\halfcity.pen

Al.2 Camera Reproductions

Plots can be printed on paper for checking but are plotted on Mylar for the final corrected version
to be sent to Reproduction’s camera room. A photo work order is filled out and rubber banded to
the plot or plots to be placed in the camera work bin downstairs.

County Maps include : 3 - 100% Positive Clear film
1 - 49% Positive Clear film
1 - 49% Negative film

Small City maps include : 1 - 100% Positive Clear film

Large City maps include : 1 - 100% Positive Clear film
1 - 50% Positive Clear
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APPENDIX B: Speciality maps
B1.1 Open Band

One of the most used maps produced in the Mapping Section is the statewide highway map with an
open band for roadways. This map shows the cities, counties and the entire highway system.

Tt is used as a base map for reports, special projects and highway studies. The roadways are often
colored or filled with patterns to depict information and areas of interest. It is a simple enough map
that it can be reduced and still be legible in most cases.

B1.2 Control Section

The Control Section Map is similar to the open band map but each highway is broken up into
numbered sections. This map shows the cities, counties and the entire highway system. The map is
essentially derived from the Inventory Section’s Oklahoma Highway Data File for department use and
Maintenance projects. A Control Section Number is given to road segments that shows the highway
number, county number and section number. The road bands are drawn as arrows following the
route’s direction from origin. For more detail in urban areas and numbers of major interchanges, the
Control Section Maps book published by the Inventory Section is available.

B1.3 Commission District - Maintenance

Eight individual maps are also drawn for the eight Commissioner Districts and Maintenance Divisions.
These are essentially reformatted open band maps that are used regionally in the Divisions and
Districts or as a set for various projects originating at the Central Office.

B1.4 Election Board Maps

© After every new U.S. Census the state must sit down and reapportion the election districts in
Oklahoma. Two full sets of county maps and some city maps are also kept up to date for the Election
Board.

These include: a county set of the State House of Representatives Districts, a county set of the State
Senate Districts and a set of major cities with multiple State Senate Districts. Some smaller 8 %2” by
11" depictions of these maps and several statewide maps also show election boundaries and are
prepared for printing. These include the U.S. Representatives to Congress of which Oklahoma
presently has six and some of Oklahoma’s Local Judicial Districts where the density of population
is highest.



B1.5 Bridge Clearance Map

A special map is updated periodically to depict the latest figures for bridges, underpasses and
overpasses. The Bridge Clearance Map is a two sided color printing that is provided free to the
public for the safety of over height loads on Oklahoma’s highways.

The front side is a statewide single line highway map with clearance figures for structures crossing
the State Highway System. The reverse side has more detail in urban areas and has insets of the major
interchanges where structures are most complicated. Divided highways which can have different
clearances are listed with separate directional numbers for each structure on either side of the map.

B1.6 Official State Map

Oklahoma is required to publish an updated Official State Highway Map annually. This is the most
distributed map that the Department of Transportation publishes. It is a full four-color offset
lithographic printing. The map is joint project involving ODOT, the Oklahoma Turnpike Authority
and the Oklahoma Tourism and Recreation Department. The Department of Transportation is the
main resource of input but accommodates the needs of the other two agencies. Tourism generally
provides some artwork and a promotional theme, plus is the major distributor of the map at the
Information Welcome Centers. A special section of the map has insets of the state’s turnpikes. The
front map side and the city insets are being revised in a digital format using CorelDraw. A
Microstation version should come later when the conversion technology improves to make it more
feasible.

B1.7 Rail Road Map

Another map which is biennially printed in four color offset is the Railroad Map. This is used for
industrial and economic development and is distributed by the Railroad Branch of the Intermodal
Division. Railroads are predominantly depicted over the primary and secondary highway system.
Insets of major cities and junctions are also drawn on the reverse side. Railroad issues and
photographic themes are also incorporated into the overall layout.

B1.8 Historical Maps

Since the 1963 Official State Map was printed commemorating the Civil War in the Indian Territory,
a special Oklahoma historical Civil War Map has been reprinted when necessary.

Also reprinted from time to time is a 1925 Oklahoma Highway Map. This was the first official map
of state highways printed for the public.
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APPENDIX C Updates
C1.1 Census Updates

Every ten years when the new U.S. Census is officially completed all populations on city and county
maps are updated to reflect the new figures. The new numbers are also revised on the Official State
Map city index.

C1.2 Construction Updates

When highway projects are completed and open to traffic the resulting changes are revised or noted
to be revised on all maps affected. This information is provided by the Systems Branch from
Transportation Commission Meetings, from Need Study which is always updating their database and
checking the construction files and from Design Plan Cover Sheets which are sent to GIS
Management periodically. To best draw the new alignments or structures the Survey Division may
be able to provide aerial photos if the plan sheets are not accurate enough or if changes have occurred
during construction.

Changes will affect these maps in most cases :
General County Maps City Maps Control Section Maps

Official State Map Open Band Map Commission District Maps



APPENDIX D Scanning
D1.1 Raster file types (Binary & Continuous tone)

All the city and county files which were previously hand drawn have been scanned and stored on
the mainframe. These are generally scanned using IRAS-B binary software.

Binary scans are essentially result in solid black and white pixels. The contrast level setting chooses
whether the scanned area is read as a positive black or a negative white. The resolution settings
determines the number of pixels per square inch. IRAS-B files have the .cit extension.

Topographic maps and aerial photos are also scanned as needed for use as reference files. These are
generally scanned using IRAS-C continuous tone software. Continuous tone scans allow for several
levels of grey and are more sensitive to detail in resolution. IRAS-C files require more storage space
as they are much larger than IRAS-B files. IRAS-C files have the .cot extension.

The Eagle scanning setup has initial perimeter files that are saved with the user’s log-in name. These
allow you to save your settings for scan types that you may want to keep and use again.

D1.2 Rasters as Geo-reference files

Files that are to be used as reference files will need to be Geo-Referenced to fit the basemap or format
area on your workstation. The USGS Topo and Digital Ortho-photo Quarter Quads in IRAS-C have
been stored in their proper geo-referenced coordinates in accordance with the standard mapping
coordinates.

Check the referenced drawing to the design file and be sure it is what you need before saving. Attach
it to the drawing at this time so that it will be loaded onto your work space when opening the
drawing,

APPENDIX E County & City Levels and Symbology
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COUNTY MAPPING MENU
Line Style

Trim Line
Title Block & Text (CELL) 2
Concrete Roads 3 3 300 Sol 3
Paved Roads 4 4 300 Sol 3
Gravel Roads 5 5 Gravel 3
Graded & Drained Roads 6 6 Grade & Drain 3
Unimproved Roads 7 7 300 Div 3
Brick Roads 8 8 300 Sol 3
Interstate Highways 9 9 360 Div S
Interstate Toll Roads 10 10 360 Div 5
Other Turnpikes 11 11 360 Div S
Other Divided Highways 12 12 360 Div 5
U.S. Highway Symbols & 13
Numbers(CELL)
State Highway Symbols & Numbers 14
(CELL)
Interstate Highway Sym. & 15
Numbers(CELL)
Highway Ramps 16 16 0 4
Railroads 17 17 Railroad 3
Drainage, Intermittent Stream 18 18 Creek 2
Lakes & Narrow Streams 18 18 0 3
Dams & Locks 19 19 300 Sol 3
Fords & Bridges(CELL) 19
Culture & Features(CELL) 20
Projected Roads 21 21 Projected 3
Primitive Road 21 21 Primitive 3
State Lines 22 22 State Line 3
County Lines 22 22 County Line 9




COUNTY MAPPING MENU

NAME , | Level | Color [ Line Style Weight

Section Lines 24 24 0 2

County Seat & Town Center(CELL) 25 'E

Corporate Limits 26 26 corplimit 2

City Limit Strips 26 26 cstrip 5

Government Property Lines 27 27 0 4

Inset Border (Inside) 28 28 Large Inset 5

Inset Border (Outside) 29 29 Small Inset 4

Map Text (Inside) 30 30 Large Inset 3

Map Text (Outside) 31 Large Inset 5

Destination Arrow(CELL) 32

Airports 33 33 0 5

Matchline 34 34 Matchline 2
| Indian Treaty Line 34 34 Indian Treaty | R

Marsh or Swamp (CELL) 35 |

Grid Lines & Lat/Long Lines 36 36 0 3

Available 37

Available 38

Available 39

Available 40

Available 41

Reserved for Large City 42

Reserved for Large City 43

Reserved for Large City 44

Reserved for Large City 45
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COUNTY MAPPING MENU

Line Style

Reserved for Large City
Available 47

| Available 48
Availabie 49
Availabie 50
Available 51
Available 52
Rural Development Concrete Road 53 53 0 9
Rural Development Paved Road 54 54 0 9
Rural Development Gravel Road 55 55 0 9
Rural Development Grade & Drain Road 56 56 0 9
Rural Development Unimproved Road 57 57 0 9
Rural Development Brick Road 58 58 0 9
Available 59
New Roads in question 60 24 0 9
Private Roads 61 97 0 9
Driveway 62 98 0 9
Gated Community 63 99 0 9




SMALL CITY MAPPING MENU

NAME Level Color Line Style Weight
Trim Line 1 1 0

Title Block & Text (CELL) 2

Concrete Roads 3 3 300 Sol 3
Paved Roads 4 4 300 Sol 3
Gravel Roads 5 5 300 Sol 3
Graded & Drained Roads 6 6 300 Sol 3
Unimproved Roads 7 7 300 Sol 3
Brick Roads 8 8 300 Sol 3
Interstate Highways 9 9 360 Div 5
Interstate Toll Roads 10 10 360 Div 5
Other Turnpikes 11 11 360 Div 5
Other Divided Highways 12 12 360 Div 5
U.S. Highway symbols & 13

Numbers(CELL)

State Highway Symbols & 14

Numbers(CELL)

Interstate Highway Sym & 15

Numbers(CELL)

Highway Ramps 16 16 0 4
Railroads 17 17 Railroads 3
Drainage, Intermittent Stream 18 18 Creek 2
Lakes & Narrow Streams 18 18 0 3
Fords & Bridges(CELL) 19

State Lines 22 22 state line

County Lines 23 23 county line

Section Lines 24 24 0

County Seat & Town Center(CELL) 25

City Limits 26 26 ctylimit 23
Government Property Line 27 27 0 4
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Airports 33 33 0 5
LARGE CITY MAPPING MENU

NAME Level | Color Line Style Weight

Trim Line 1 1 Trim Line 2

Title Block & Text 2

Concrete Roads 3 3 300 Sol 3

Paved Roads 4 4 300 Sol 3

Gravel Roads 5 5 300 Sol 3

Graded & Drained roads 6 6 300 Sol 3

Unimproved Roads 7 7 300 Sol 3

Brick Roads 8 8 300 Sol 3

Interstate Highways 9 9 549 Div 13

Interstate Toll Roads 10 10 549 Div 13

Other Turnpikes 11 11 549 Div 13

Other Divided Highways 12 12 549 Div 13

-‘U.S. Highway Symbols & 13

Numbers(CELL)

State Highway Symbols & 14

Numbers(CELL)

Interstate Highway Sym & 15

numbers(CELL)

Highway Ramps 16 16 0 13

Railroads 17 17 railroad 3

Drainage, Intermittent Streams 18 18 Creek 3

Lakes & Narrow Streams 18 18 0 4

Dams & Locks 19 19 300 Sol 3

Fords & Bridges(CELL) 19

Primitive Roads 20 20 Primitive 3

State Lines 22 22 STATE LINE 3

County Lines 22 22 County Line 9

Section Lines 24 24 0 3




County Seat & Town Center(CELL) 25

City Limit Strips 26 26 cstrip 13
LARGE CITY MAPPING MENU

NAME Level | Color Line Style |  Weight |

Corporate Limits 26 26 ctylimit 23

Government Property Lines 27 27 0 4

Map Text(Inside) 30 30

Map Text(Outside) 31 31

Destination Arrow(CELL) 33

Airports 33 33 0 13

Custom Concrete Roads 42 42 100 Sol 3

Custom Paved Roads 43 43 100 Sol 3

Custom Gravel Roads 44 44 100 Sol 3

Custom Grade & Drain Roads 45 45 100 Sol 3

Custom Brick Roads 46 46 100 Soi 3

New Roads in Question 60 24 0 3

Private Roads 61 97 0 3

Driveway 62 98 0 3

Gated Community 63 99 0 3
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Code Name Num. Pop. Node# Code

ADAIR 01

(18421) 2305 STILWELL 05 2663 3002 1
2585 WATTS 10 303 4272 0
2640 WESTVILLE 15 1374 4273 0

ALFALFA 02

(6416) 0050 ALINE 05 295 3016 0
0075 AMORITA 10 56 4275 0
0320 BURLINGTON 15 169 4276 0
0340 BYRON 20 57 4274 0
0405 CARMEN 25 59 4278 0
0475 CHEROKEE 30 1787 3007 0
0960 GOLTRY 35 297 4279 0
1100 HELENA 40 1043 4280 0
1250 JET 50 272 3010 0
1380 LAMBERT &5 11 0000 0

ATOKA 03

(12778) 0125 ATOKA 05 3298 3021

’ 0385 CANEY 10 184 0000 0

2325 STRINGTOWN 15 366 4282 0
2473 TUSHKA 25 256 4283 0

BEAVER 04

(6023) 0150 BEAVER 05 1584 4229 0
0855 FORGAN 10 489 4284 0
0925 GATE 15 159 4285 0
1345 KNOWLES 20 18 4286 0

BECKHAM 05

(18812) 0420 CARTER 05 286 3052 0
0770 ELK CITY 10 10428 3046 4
0795 ERICK 15 1083 3040 0
2150 SAYRE 20 2881 4231 1
2420 TEXOLA 25 45 0000 0

BLAINE 06

(11470) 0390 CANTON 05 632 3068 0
1010 GREENFIELD 15 200 3216 0
1140 HITCHCOCK 20 139 0000 0
1460 LONGDALE 25 281 3227 0
1805 OKEENE 30 1343 4068 0
2580 WATONGA 35 3408 4232 2



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.
(1990 POP.) Num. Code Name Num. Pop. Node # Code
0930 GEARY 40 1347 3247 0
1200 HYDRO 60 977 5012 0
BRYAN 07
(32089) 0005 ACHILLE 05 490 3088 0
0160 BENNINGTON 10 251 4008 0
0230 BOKCHITO 15 576 3081 0
0350 CADDO 20 918 3248 0
0355 CALERA 25 1536 4110 0
0530 COLBERT 30 1043 4126 0
0730 DURANT 35 12823 4194 4
1103 HENDRIX 37 108 0000 0
1275 KEMP 40 138 0000 0
1290 KENEFIC 45 147 3815 0
1597 MEAD 50 109 0000 0
2123 SAND POINT 55 179 0000 0
2203 SILO 60 249 0000 0
CADDO 08
(29550) 0080 ANADARKO 05 6586 3092 3
0090 APACHE 10 1591 4069 0
0190 BINGER 15 724 3097 0
0275 BRIDGEPORT 20 137 0000 0
0410 CARNEGIE 25 1593 5008 0
0440 CEMENT 30 642 5009 0
0625 CYRIL 35 1072 3094 0
0740 EAKLY 40 277 0000 0
0860 FT.COBB 45 663 5010 0
0985 GRACEMONT 50 339 5011 0
1135 HINTON 55 1233 3098 0
1200 HYDRO 60 977 5012 0
1465 LOOKEBA 65 141 0000 0
CANADIAN 09
(74409) 0360 CALUMET 05 560 5013 0
CANADIAN CLUB CITY 07 1 2393 0
0785 EL RENO 10 15414 3113 4
1705 MUSTANG 15 10434 4296 4
2485 UNION CITY 25 1000 3120 0
2720 YUKON 30 20935 5014 4
1795 OKARCHE 35 1160 2322 0
0930 GEARY 40 1347 3247 0
1925 PIEDMONT 45 2522 3125 1
1815 OKLA. CITY 70 444719 3828 7
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node # Code

CARTER 10 7

(42919) 0100 ARDMORE 05 23079 3151 4
0935 GENE AUTRY 10 97 5015 0
1090 HEALDTON 15 2872 5016 1
2275 SPRINGER 20 485 5019 0
2670 WILSON 25 1639 3134 0
1452 LONE GROVE 30 4114 5017 2
2393 TATUMS 40 176 0000 0
0687 DICKSON 45 942 3146 0
2017 RATLIFF CITY 60 157 5018 0

CHEROKEE 11 1

(34049) 2370 TAHLEQUAH 15 10398 4533 4
1192 HULBERT 25 499 3159 0

CHOCTAW 12 2

(15302) 0245 BOSWELL 05 643 3162 0
0875 FT. TOWSON 10 568 5021 0
1190 HUGO 15 5978 3166 3
2148* SAWYER 17 209 0000 0
2235 SOPER 20 305 5022 0

CIMARRON 13 6

(3301) 0225 BOISE CITY 05 1509 3180 0
1305 KEYES 10 454 5023 0

CLEVELAND 14 3

(174253) 1037 HALL PARK 02 1090 0000 0
1430 LEXINGTON 05 1776 3150 0
1655 MOORE 10 40318 3197 5
1750 NOBLE 15 4710 3225 2
1755 NORMAN 20 80071 4222 6
2212 SLAUGHTERVILLE 30 1843 0000 0
0799 ETOWAH 35 33 0000 0
1815 OKLA. CITY 70 444719 3828 7

COAL 15 3

(5780) 0300 BROMIDE 02 162 4355 0
0445 CENTRAHOMA 05 106 0000 0
0525 COALGATE 10 1895 3198 0



CORPORATE CITIES BY COUNTY

County Name  County Main Census City City 1990 City Pop.
(1990 POP)) Num. Div. Code Name Num. Pop. Node# Code
1415 LEHIGH 15 303 3226 0
1915 PHILLIPS 20 161 3507 0
2470 TUPELO 25 323 3661 0
COMANCHE 16 7
(111486) 0345 CACHE 05 2251 3206 0
0460 CHATTANOOGA 10 437 3669 0
0765 ELGIN 15 975 3812 0
0835 FAXON 20 127 3817 0
0840 FLETCHER 25 1002 3824 0
0940 GERONIMO 30 990 3222 0
1210 INDIAHOMA 35 337 0000 0
1405 LAWTON 40 80561 3217 6
2285 STERLING 45 684 3838 0
1603 MEDICINE PARK 50 285 3232 0
COTTON 17 7
(6651) 0670 DEVOL 05 165 3256 0
2015 RANDLETT 10 458 3239 0
2400 TEMPLE 15 1223 3252 0
2540 WALTERS 20 2519 4195 1
CRAIG 18 8
(14104) 0180 BIG CABIN 05 271 3873 0
0220 BLUE JACKET 10 175 4252 0
1300 KETCHUM 15 263 3941 0
2520 VINITA 20 5804 3260 3
2625 WELCH 25 499 3963 0
CREEK 19 8
(60915) 0285 BRISTOW 05 4062 4212 2
0665 DEPEW 10 502 0000 0
0720 DRUMRIGHT 15 2799 4196 1
1270 KELLYVILLE 20 984 3966 0
1315 KIEFER 25 962 4108 0
1540 MANNFORD 30 1826 4140 0
1675 MOUNDS 35 980 4122 0
1790 OILTON 40 1060 4133 0
2135 SAPULPA 45 18074 4233 4
2465 TULSA 50 367302 4088 7
2215 SLICK 55 124 4134 0
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.
(1990 POP.) Num. Div. Code . Name L Num. Pop. Node# Code
2180 SHAMROCK 60 95 4005 0
1403 LAWRENCE CREEK 65 97 0000 0
CUSTER 20 5
(26897) 0095 ARAPAHO 05 802 4189 0
0330 BUTLER 10 341 4135 0
0520 CLINTON 15 9298 3294 3
0620 CUSTER CITY 20 443 4136 0
2435 THOMAS 25 1246 4137 0
2610 WEATHERFORD 30 10124 4137 4
1040 HAMMON 35 611 2016 0
DELAWARE 21 8
(28070) 0165 BERNICE 05 330 4193 0
0535 COLCORD 10 628 4253 0
1015 GROVE 15 4020 3313 2
1230 JAY 20 2220 3310 0
1777 OAKS 25 431 4268 0
2638 W. SILOAM SPRINGS 30 539 3306 0
1257 KANSAS 35 556 4304 0
DEWEY 22 5 »
(6551) 0370 CAMARGO 05 185 4305 0
1410 LEEDY 10 468 4306 0
1780 OAKWOQOOD 15 107 0000 0
1980 PUTNAM 20 44 4307 0
2160 SEILING 25 1031 4308 0
2385 TALOGA 30 415 3327 0
2515 ViCl 35 751 4309 0
ELLIS 23 6
(4497) 0110 ARNETT 05 547 3336 0
0830 FARGO 10 299 4310 0
0905 GAGE 15 473 3338 0
2190 SHATTUCK 20 1454 4311 0
GARFIELD 24 4
(56735) 0270 BRECKENRIDGE 05 251 0000 0
0580 COVINGTON 10 590 4312 0
0705 DOUGLAS 15 55 0000 0
0715 DRUMMOND 20 408 4313 0
0790 ENID 25 45309 4197 5
0820 FAIRMONT 30 129 0000 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node# Code
0915 GARBER 35 959 4314 0
1130 HILLSDALE 40 96 0000 0
1195 HUNTER 45 218 0000 0
1360 KREMLIN 50 243 0000 0
1365 LAHOMA 55 645 4315 0
1760 N. ENID 60 874 4316 0
2590 WAUKOMIS 65 1322 4317 0
0417 CARRIER 70 171 4318 0

GARVIN 25 3

(26605) 0780 ELMORE CITY 05 493 4319 0
1435 LINDSAY 10 2947 4320 1
1595 MAYSVILLE 15 1203 4321 0
1870 PAOLI 20 574 3357 0
1875 PAULS VALLEY 25 6150 3356 3
2320 STRATFORD 30 1404 4322 0
2700 WYNNEWOOD 35 2451 4323 0

GRADY 26 7

41747) 0045 ALEX 07 639 3389 0
0255 BRADLEY 10 166 4324 0
0485 CHICKASHA 15 14988 3373 4
1645 MINCO 20 1411 3384 0
2100 RUSH SPRINGS 25 1229 3386 0
2475 TUTTLE 30 2807 3391 1
2505 VERDEN 35 546 4325 0
1752 NORGE 40 97 4326 0
0067 AMBER 45 418 4327 0
0748 NINNEKAH 50 1016 3380 0

GRANT 27 4

(5689) 0650 DEER CREEK 05 124 4328 0
1235 JEFFERSON 10 36 4329 0
1385 LAMONT 15 454 4330 0
1525 MANCHESTER 20 106 4331 0
1600 MEDFORD 25 1172 3399 0
1720 NASH 30 281 4332 0
1940 POND CREEK 35 982 4333 0
2040 RENFROW 40 19 4334 0
2535 WAKITA 45 453 3404 0

GREER 28 5

(6559) 1000 GRANITE 10 1844 3414 0
1530 MANGUM 15 3344 3407 2
2665 WILLOW 20 142 4336 0
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.
(1990 POP.) Num. Code Name Num. Pop. Node# Code
HARMON 29
(3793) 0980 GOULD 05 237 4337 0
o 1165 HOLLIS 10 2584 4198 1
HARPER 30
(4063) 0310 BUFFALO 05 1312 4199 0
1400 LAVERNE 10 1269 3434 0
1590 MAY 15 42 4338 0
2095 ROSSTON 20 54 4339 0
HASKELL 31
(10940) 1295 KEOTA 05 625 4340 0
1335 KINTA 10 233 4341 0
1500 MCCURTAIN 15 465 4342 0
2295 STIGLER 20 2574 4200 1
2390 TAMAHA 25 188 0000 0
2653 WHITEFIELD 30 253 3437 0
HUGHES 32
{(13023) ATWOQOOQOD 02 0000 0
0365 CALVIN 05 251 4343 0
0735 DUSTIN 10 429 4344 0
0945 GERTY 15 95 0000 0
1160 HOLDENVILLE 20 4792 3455 2
*HORNTOWN 22 0000 0
1375 LAMAR 25 97 0000 0
SPAULDING 27 85 0000 O
2340 STUART 30 228 4345 0
2645 WETUMKA 35 1427 3447 0
0055 ALLEN 40 g72 4489 0
2715 YEAGER 50 40 0000 0
JACKSON 33
(28764) 0060 ALTUS 05 21910 - 4228 4
0210 BLAIR 10 922 4351 0
0723 DUKE 15 360 4352 0
0760 ELDORADO 20 573 4353 0
0775 ELMER 25 132 0000 0
1085 HEADRICK 30 183 0000 0
1580 MARTHA 35 217 0000 0
1830 OLUSTEE 40 701 4354 0
JEFFERSON 34
(7010) 0020 ADDINGTON 05 100 4347 0
1075 HASTINGS | 10 164 4348 0
2055 RINGLING 15 1250 4349 0
2105 RYAN 20 945 3467 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node # Code
2345 SUGDEN 25 65 0000 0
2410 TERRAL 30 469 4350 0
2595 WAURIKA 35 2088 3468 0
0570 CORNISH 40 164 3566 0

JOHNSTON 35 3

(10032) 0300 BROMIDE 05 162 4355 0
1545 MANNSVILLE 10 396 4356 0
1635 MILBURN 15 264 4357 0
1640 MILL CREEK 20 336 4358 0
2020 RAVIA 25 404 3477 0
2445 TISHOMINGO 30 3116 3480 2
2555 WAPANUCKA 35 402 4359 0

KAY 36 4

(48056) 0205 BLACKWELL 05 7538 3499 3
0265 BRAMAN 10 251 4360 0
1265 KAW CITY 15 314 4361 0
1320 KILDARE 20 94 0000 0
1715 NARDIN 25 75 0000 0
1735 NEWKIRK 30 2168 3497 0
1935 PONCA CITY 35 26359 3505 5
2450 TONKAWA 40 3127 3498 2

KINGFISHER 37 4

(13212) 0425 CASHION 05 430 0000 0
1105 HENNESSEY 10 1902 4528 0
1325 KINGFISHER 15 4095 4201 2
1480 LOYAL 20 76 0000 0
1795 OKARCHE 35 1160 2322 0
0707 DOVER 40 376 4529 0
1925 PIEDMONT 45 2522 3125 1

KIOWA 38 5

(11347) 0555 COOPERTON 05 15 4362 0
0975 GOTEBO 10 370 4363 0
1150 HOBART 15 4305 3532 2
1455 LONE WOLF 20 576 4364 0
1680 MT. PARK 25 473 4365 0
1685 MT. VIEW 30 1086 3525 0
2085 ROOSEVELT 35 323 4366 0
2230 SNYDER 40 1619 4367 0

LATIMER 39 2
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POPR.) Num. Div. Code ~ Name Num. Pop. Node# Code

(10333) 2030 RED OAK 05 602 4260 0
2655 WILBURTON 10 3092 3537 2
2380 TALIHINA 50 1297 3564 0

LEFLORE 40 2

(43270) 0105 ARKOMA 05 2393 4265 0
0235 BOKOSHE 10 403 4368 0
0375 CAMERON 15 327 4530 0
0590 COWLINGTON 20 756 0000 0
0827 FANSHAWE 23 331 4369 0
1095 HEAVENER 25 2601 3547 1
1185 HOWE 30 510 4370 0
1413 LE FLORE 32 119 0000 0
1865 PANAMA 35 1528 4371 0
1933 POCOLA 38 3664 0000 2
1955 POTEAU 40 7210 3565 3
2175 SHADY POINT 43 597 0000 0
2270 SPIRO 45 2146 4372 0
2380 TALIHINA 50 1297 3564 0
2675 WISTER 55 956 4373 0

LINCOLN 41 3

(29216) 0030 AGRA 05 334 4374 0
0415 CARNEY 10 558 4375 0
0455 CHANDLER 15 2596 3574 1
0635 DAVENPORT 20 979 4376 0
0825 FALLIS 25 49 0000 0
1285 KENDRICK 30 171 0000 0
1605 MEEKER 35 1003 4377 0
1960 PRAGUE 40 2308 3779 0
2250 SPARKS 45 202 4378 0
2335 STROUD 50 2666 4379 1
2455 TRYON 55 514 4380 0
2567 WARWICK 57 160 4381 0
2635 WELLSTON 60 912 4382 0

LOGAN 42 4 _

(29011) 0425 CASHION 05 430 0000 0
0439 CEDAR VALLEY 07 61 0000 0
0600 CRESCENT 10 1236 4384 0
1020 GUTHRIE 15 10518 3586 4
1395 LANGSTON 20 1471 4250 0
1575 MARSHALL 30 288 4297 0
1615 MERIDIAN 35 45 0000 0
1695 MULHALL 40 199 4385 0
1845 ORLANDO 45 198 4386 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node# Code
0497 CIMARRON CITY 50 71 0000 0
0595 COYLE 55 289 4383 0
1815 OKLA. CITY 70 444719 3828 7

LOVE 43 7

(8157) 1425 LEON 05 101 4387 0
1560 MARIETTA 10 2306 3607 0
2425 THACKERVILLE 15 290 3598 0

MCCLAIN 44 3

(22795) 0215 BLANCHARD 05 1922 3611 0
0335 BYARS 10 263 4388 0
0537 COLE 11 355 4389 0
0685 DIBBLE 12 181 4390 0
1975 PURCELL 15 4784 3619 2
2090 ROSEDALE 20 48 4391 0
2570 WASHINGTON 25 279 4392 0
2600 WAYNE 30 519 3616 0
1728 NEW CASTLE 35 4214 4289 2
0958 GOLDSBY 40 816 3625 0
1815 OKLA. CITY 70 444719 3828 7

MCCURTAIN 45 2

(33433) 0295 BROKEN BOW 05 3961 4393 2
0920 GARVIN 10 128 4394 0
1062 HARRIS 13 192 0000 0
1080 HAWORTH 15 293 4395 0
1205 IDABEL 20 6957 3647 3
2225 SMITHVILLE 22 111 4396 0
2495 VALLIANT 25 873 3642 0
2689 WRIGHT CITY 50 836 4397 0
1642 MILLERTON 55 234 0000 0

MCINTOSH 46 1

(16779) 0465 CHECOTAH 05 3290 4398 2
0800 EUFAULA 10 2652 3665 1
1045 HANNA 15 99 4399 0
1145 HITCHITA 20 118 0000 0
2045 RENTIESVILLE 25 66 0000 0
2290 STIDHAM 30 48 0000 0

MAJOR 47 6

(8055) 0070 AMES 05 268 0000 0
0510 CLEO SPRINGS 10 359 4400 0
0820 FAIRVIEW 15 2936 3689 1
1610 MENO 20 155 4401 0

e
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code _ Name Num. Pop. Node# Code
2060 RINGWOOD 25 394 4402 0

MARSHALL 48 2

(10829) 1330 KINGSTON 05 1237 4403 0
1495 MCBRIDE 08 80 3701 0
1520 MADILL 10 3069 3692 2
1775 OAKLAND 15 602 4405 0
2683 WOODVILLE 20 31 4406 0

MAYES 49 8

(33366) 0015 ADAIR 05 685 4271 0
0495 CHOUTEAU 10 1771 3706 0
0695 DISNEY 15 257 4408 0
0997 GRAND LAKE TOWNE 16 58 0000 0
1390 LANGLEY 20 526 3718 0
1450 LOCUST GROVE 25 1326 4409 0
1895 PENSACOLA 30 69 4410 0
1970 PRYOR 35 8327 3708 3
2115 SALINA 40 1153 4411 0
2255 SPAVINAW 45 432 4412 0
2273 SPORTSMAN ACRES 48 181 0000 0
2315 STRANG 50 141 0000 0

MURRAY 50 7

(12042) 0645 DAVIS 05 2543 4413 1
0700 DOUGHERTY 10 138 4414 0
1120 HICKORY 11 77 4415 0
2155 SCULLIN 12 9 4416 0
2350 SULPHUR 15 4824 3727 2

MUSKOGEE 51 1 :

(68078) 0250 BOYNTON 05 391 4417 0
0260 BRAGGS 10 308 4418 0
0575 COUNCIL HILL 15 139 4419 0
0865 FT. GIBSON 20 3359 3738 2
1070 HASKELL 25 2143 3743 0
1700 MUSKOGEE 30 37708 4237 5
1825 OKTAHA 35 266 0000 0
1950 PORUM 40 851 - 4420 0
2365 TAFT 45 400 4421 0
2530 WAINWRIGHT 50 223 0000 0

. 2560 WARNER 55 1479 4422 0

2620 WEBBERS FALLS 60 722 4423 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. . P.op.. Node # Code

NOBLE 52 4

(11045) 0185 BILLINGS 05 555 4424 0
1565 MARLAND 10 280 4425 0
1670 MORRISON 15 640 4426 0
1910 PERRY 20 4978 3768 2
2035 RED ROCK 25 321 4427 0

NOWATA 53 8

(9992) 0655 DELAWARE 05 434 0000 0
1420 LENAPAH 10 253 3786 0
1727 NEW ALLUWE 12 83 4428 0
1770 NOWATA 15 3896 4238 2
2245 S. COFFEYVILLE 20 791 4429 0
2550 WANN 25 126 4615 0

OKFUSKEE 54 3

(11551) 0148* BEARDEN 03 142 0000 0
0240 BOLEY 05 908 4263 0
0430 CASTLE 10 94 4404 0
0508*CLEARVIEW 12 47 0000 0
1810 OKEMAH 15 3085 3795 2
1860 PADEN 20 400 4430 0
2630 WELEETKA 25 1112 4431 0

OKLAHOMA 55 4

(599611) 0097 ARCADIA 02 220 0000 0
0175 BETHANY 05 20075 4532 4
0490 CHOCTAW 10 8545 4538 3
0660 DEL CITY 15 23928 4533 4
0755 EDMOND 20 52315 4293 6
0850 FOREST PARK 25 1249 0000 0
1060 HARRAH 30 4206 3797 2
1255 JONES 35 2424 0000 0
1370 LAKE ALUMA 37 96 0000 0
1485 LUTHER 40 1560 4534 0
1630 MIDWEST CITY 55 52267 4535 6
1745 NICHOLS HILLS 60 4020 0000 2
1746 NICOMA PARK 65 2353 4266 0
1815 OKLA. CITY 70 444719 3828 7
2220 SMITH VILLAGE 75 34 0000 0
2260 SPENCER 80 3972 0000 2
2280 SPRINGLAKE PARK 81 11 0000 0
2490 VALLEY BROOK 85 744 0000 0
2430 THE VILLAGE 90 10353 4536 4
2565 WARR ACRES 95 9288 4537 3
2680 WOODLAWN PARK 98 170 0000 0

/
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code . Name Num. Pop. Node# Code.

OKMULGEE 56 1

(36490) 0155 BEGGS 05 1150 4432 0
0305 BRYANT 10 74 0000 0
0675 DEWAR 15 921 4433 0
1007 GRAYSON 20 66 4434 0
1110 HENRYETTA 25 5872 3834 3
1155 HOFFMAN 30 175 0000 0
1362 KUSA 32 0000 0
1665 MORRIS 35 1216 4435 0
1820 OKMULGEE 40 13441 3847 4
2672 WINCHESTER 45 301 4437 0

OSAGE 57 8

(41645) 0145 BARTLESVILLE 05 34256 4202 5
0130 AVANT 10 369 4436 0
0140 BARNSDALL 12 1316 4437 0
0315 BURBANK 15 165 4438 0
0805 FAIRFAX 20 1749 4439 0
0845 FORAKER 25 25 0000 0
0990 GRAINOLA 30 58 4440 0
2125 SAND SPRINGS 35 15348 5003 4
1175 HOMINY 36 2342 4441 0
1966 PRUE 37 346 0000 0
1850 OSAGE 40 163 0000 0
1880 PAWHUSKA 45 3825 3849 2
2465 TULSA 50 367302 4088 7
2615 WEBB CITY 55 99 0000 0
2705 WYNONA 60 531 4442 0
2200 SHIDLER 65 487 3856 0
2210 SKIATOOK 70 4910 4443 2

OTTAWA 58 8

(30561) 0025 AFTON 05 915 4444 0
0403*CARDIN 07 165 0000 0
0550 COMMERCE 10 2426 4445 0
0810 FAIRLAND 15 916 4446 0
1620 MIAMI 20 13142 3878 4
1765 N. MIAMI 25 450 4447 0
1900 PEORIA 30 136 0000 0
1920 PICHER 35 1714 4448 0
1985 QUAPAW 40 928 4449 0
2695 WYANDOTTE 45 366 0000 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

{1990 POP.) Num. . Div. Code Name Num. Pop. Node# Code

PAWNEE 59 8

(15575) 0147 BAUGH 01 5 0000 0
0200 BLACKBURN 05 110 0000 0
0357 CALIDA 07 19 0000 0
0438 CEDAR RIDGE 08 0000 0
0515 CLEVELAND 10 3156 3889 2
0613 CURCHECE 12 7 0000 0
0788 EMPY 13 2 0000 0
1035 HALLETT 15 159 4450 0
1245 JENNINGS 20 381 4451 0
1256 JUBY 25 0000 0
1451 LONE CHIMNEY 26 47 0000 0
1408 LEANDER 27 8 0000 0
1428 LEROY 29 9 0000 0
1550 MARAMEC 30 110 0000 0
1692 MULE BARN 32 0000 0
1773 OAK GROVE 34 660 0000 0
1885 PAWNEE 35 2197 3884 0
1912 PETERMAN RIDGE 37 14 0000 0
2003 BABORNVILLE 39 12 0000 0
2005 RALSTON 40 405 4452 0.
2053 RIGSBY 42 21 0000 0
2189 SHA-TO-SHE 44 4 0000 0
2174 SHADY GROVE 46 23 0000 0
2205 SKEEDEE 48 96 0000 0
2405 TERLTON 50 121 0000 0
2438 TIMBERLANE 52 21 0000 0
2636 WES 54 31 0000 0
1990 QUAY 55 59 0000 0
2637 WESTPORT 56 326 0000 0

PAYNE 60 4

(61507) 0615 CUSHING 05 7218 3898 3
0950 GLENCOE 10 473 4453 0
0720 DRUMRIGHT 15 2799 4196 1
1905 PERKINS 14 1925 4454 0
2065 RIPLEY 20 376 4455 0
2300 STILLWATER 25 36676 3904 5
2710 YALE 30 1392 4456 0
1990 QUAY 55 59 0000 0

PITTSBURG 61 2

(40581) 0040 ALDERSON 05 395 4457 0
0120 ASHLAND 10 56 4458 0
0380 CANADIAN 15 261 4459 0
0610 CROWDER 20 339 4460 0
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node# Code
1030 HAILEYVILLE 25 918 3925 0
1065 HARTSHORNE 30 2120 4461 0
1215 INDIANOLA 35 171 4462 0
1340 KIOWA 40 718 3914 0
1355 KREBS 45 1955 4463 0
1490 MCALESTER 50 16370 4239 4
1930 PITTSBURG 55 249 4464 0
2000 QUINTON 60 1133 3928 0
2145 SAVANNA 65 869 4465 0

PONTOTOC 62 3

(34119) 0010 ADA 05 15820 4223 4
0837*FITZHUGH 13 196 0000 0
0890 FRANCIS 15 346 0000 0
2075 ROFF 20 717 4466 0
2310 STONEWALL 25 519 4467 0
0337 BYNG 30 755 4468 0
0055 ALLEN 40 972 4469 0

POTTOWATOMIE 63 3

(58760) 0115 ASHER 05 449 4470 0
0177 BETHEL ACRES 07 2505 4471 1
0745 EARLSBORO 10 535 4472 0
1253 JOHNSON 13 196 0000 0
1510 MCLOUD 15 2493 4473 0
1515 MACOMB 20 64 0000 0
2110 ST.LOUIS 30 181 4474 0
2195 SHAWNEE 35 26017 4240 5
2395 TECUMSEH 40 5750 4299 3
2545 WANETTE 45 346 4475 0
2453 TRIBBEY 52 288 0000 0
1585 MAUD 55 1204 4476 0
1927 PINK 65 1020 4477 0
1815 OKLA. CITY 70 44471 3828 7
0302 BROOKSVILLE 75 69 0000 0

PUSHMATAHA 64 2

(10997) 0035 ALBION 05 88 4478 0
0085 ANTLERS 10 2524 3972 1
0505 CLAYTON 15 636 4479 0
2018 RATTAN 20 257 3977 0

ROGER MILLS 65 5 ‘

(4147) 0480 CHEYENNE 05 948 3979 0
2050 REYDON 15 200 4481 0
2330 STRONG CITY 20 49 4482 0
1040 HAMMON 35 611 4480 0



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.
(1990 POP.) Num. Div.. Code Name : Num. Pop. Node# Code
ROGERS 66
(65170) 0435 CATOOSA 05 2954 4483 1
0470 CHELSEA 10 1620 3995 0
0500 CLAREMORE 15 13280 3992 4
0818 FAIR OAKS 06 1133 0000 0
0885 FOYIL 17 86 4484 0
1225 INOLA 20 1444 0000 0
1228 JAMESTOWN 23 4 0000 0
1835 OOLOGAH 25 828 3996 0
1855 OWASSO 32 11151 4114 4
2375 TALALA 30 206 4485 0
2492 VALLEY PARK - 35 1 0000 0
0300 COLLINSVILLE 40 3612 4505 2
2465 TULSA 50 367302 4088 7
SEMINOLE 67
(25412) 0605 CROMWELL 05 268 4486 0
1350 KONAWA 10 1508 4487 0
1432 LIMA 12 133 0000 0
- 2140 SASAKWA 15 169 4488 0
2165 SEMINOLE 20 7071 4241 3
2650 WEWOKA 25 4050 4015 2
0249 BOWLEGS 30 398 4494 0
1585 MAUD 55 1204 4476 0
SEQUOYAH 68
(33828) 0910 GANS 05 218 4490 0
0970 GORE 10 690 4491 0
1555 MARBLE CITY 15 232 0000 0
1650 MOFFETT 20 219 0000 0
1690 MULDROW 25 2889 4492 1
1872 PARADISE HILLS 28 88 4493 0
2080 ROLAND 30 2481 4977 0
2120 SALLISAW 35 7122 4025 3
2510 VIAN 40 1414 4030 0
AQUA PARK 45 50 4489 0
STEPHENS 69
(42299) 0447 CENTRAL HIGH 04 781 0000 0
0545 COMANCHE 05 1695 4531 0
0725 DUNCAN 10 21732 4054 4
0787 EMPIRE CITY 12 219 0000 0
1445 LOCO 15 160 4495 0
1570 MARLOW 20 4416 4047 2
2497 VELMA 25 661 4496 0
0267 BRAY 36 925 0000 0
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CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code . - Name Num. Pop. Node# Code

TEXAS 70 6

(16419) 0965 GOODWELL 05 1065 4300 0
1025 GUYMON 10 7803 4224 3
1050 HARDESTY 15 228 4497 0
1180 HOOKER 20 1551 4061 0
1840 OPTIMA 25 92 4498 0
2415 TEXHOMA 30 746 4499 0
2480 TYRONE 35 880 4500 0

TILLMAN 71 5

(10384) 0640 DAVIDSON 05 473 4501 0
0895 FREDERICK 10 5221 4251 3
0995 GRANDFIELD 15 1224 4502 0
1170 HOLLISTER 20 59 4503 0
1470 LOVELAND 25 13 0000 0
1535 MANITOU 30 244 4075 0
2440 TIPTON 35 1043 4504 0

TULSA 72 8

(503341) 0195 BIXBY 05 9502 4085 3
0955 GLENPOOL 20 6688 4506 3
1240 JENKS 25 7493 0000 3
1431 LIBERTY 26 - 155 0000 0
1468 LOTSEE 27 7 4507 0
1855 OWASSO 30 11151 4114 4
2125 SAND SPRINGS 35 15346 5003 4
0540 COLLINSVILLE 40 3612 4505 2
2265 SPERRY 45 937 4508 0
2465 TULSA 50 367302 4088 7
0290 BROKEN ARROW 60 58043 4301 6
2210 SKIATOOK 70 4910 4443 2

WAGONER 73 1

- (47883) 0585 COWETA 04 6159 4509 3
0195 BIXBY 05 9502 4085 3
0818 FAIR OAKS 06 1133 0000 0
1738 NEW TULSA 07 272 0000 0
1800 OKAY 10 52 4131 0
1945 PORTER 15 588 4510 0
2025 REDBIRD 20 166 0000 0
2460 TULLAHASSEE 25 92 4511 0
2525 WAGONER 30 6894 4128 3
2465 TULSA 50 367302 4088 7
0290 BROKEN ARROW 60 58043 4301 6



CORPORATE CITIES BY COUNTY

County Name County Main Census City City 1990 City Pop.

(1990 POP.) Num. Div. Code Name Num. Pop. Node# Code

WASHINGTON 74 8 v .

(48066) 0145 BARTLESVILLE 05 34256 4202 5
0560 COPAN 10 809 4512 0
0680 DEWEY 15 3326 4513 2
1785 OCHELATA 20 441 0000 0
2010 RAMONA 25 508 4514 0
2500 VERA 30 167 0000 0

WASHITA 75 5

(11441) 0170 BESSIE 05 248 4515 0
0325 BURNS FLAT 10 1027 4516 0
0395 CANUTE 15 538 0000 0
0520 CLINTON 16 9298 3294 3
1730 CORDELL 20 2903 4242 1
0565 CORN 25 548 4518 0
0690 DILL CITY 30 622 4519 0
0880 FOSS 35 148 4520 0
2070 ROCKY 40 181 4521 0
2170 SENTINEL 45 960 4156 0
0543 COLONY 50 163 4517 0

WOODS 76 6

(9103) 0065 ALVA 05 5495 4167 3
0135 AVARD 10 37 0000 0
0400 CAPRON 15 38 4522 0
0630 DACOMA 20 182 0000 0
0900 FREEDOM 25 264 4523 0
2605 WAYNOKA 30 947 4524 0

WOODWARD 77 6

(18976) 1660 MOORELAND 05 1157 4525 0
1710 MUTUAL 10 68 0000 0
1995 QUINLAN 15 23 0000 0
2185 SHARON 20 108 4526 0
0870 FT. SUPPLY 25 369 4527 0
2685 WOODWARD 30 12340 4243 4
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OKLAHOMA DEPARTMENT
OF TRANSPORTATION
CADD POLICY AND PROCEDURES MANUAL

PREFACE
The ODOT CADD Policy & Procedures Manual is to be used to develop Computer Aided
Drafting and Design (CADD) transportation plans for the Oklahoma Department of
Transportation. This document is written for CADD users in a transportation désign environment
and is to present the direction of plan preparation in conjunction with CADD software operating
in a P.C. (DOS), Windows NT, or Clix operating system. The Oklahoma Department of
Transportation makes no warranty, expressed or implied, as to the documentation, function,

compatibility, or performance of the programs described within this document.



OKLAHOMA DEPARTMENT
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CADD POLICY AND PROCEDURES MANUAL

INTRODUCTION

Purpose

This manual of CADD policy & procedures sets forth computer aided drafting and design
(CADD) policies for Oklahoma Department of Transportation projects.

Authority
The ODOT CADD policy & procedures manual was written by the Engineering Support Group
as directed by the Office of the Assistant Director for Preconstruction.

General

This document is intended to be used as a basis for uniform CADD application for transportation
design. It is not intended to replace or supersede engineering documents or publications.

Requests for revisions or additions to this manual should be forwarded to the Engineering
Support Group in accordance with Policy No. 100-6 of this manual.
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OKLAHOMA DEPARTMENT
OF TRANSPORTATION
CADD POLICY AND PROCEDURES MANUAL

Subject: Working Units Policy No. 100-1
Page 1 of 1
Effective Date: 1 Aug. 2000

Standard Working Units are essential for file compatibility between divisions. The following
working units will be considered standard.

English

Master Units = Ft

Sub Units/Master Units = 10™

Positional Units/Sub Units = 120 PU
Metric

Master Units = M

Sub Units/Master Units = 100 CM

Positional Units/Sub Units = 40 PU
G.LS.

Master Units = OF

Sub Units/Master Units = 12 IN

Positional Units/Sub Units = 1000 PU
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Subject: Use of Files Generated by Other Divisions Policy No. 100-2
Page 1 of 1
Effective Date: 1 Aug. 2000

When using a file generated by another division, it should be attached as a reference file only.
The file may be copied as deemed necessary, but the original shall not be modified unless
authorized by the originator of the file.
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Subject: New Applications, Programs and Cells Policy No. 100-3
Page 1 of 1
Effective Date: 1 Aug. 2000

When a new application, library, or resource file is created, a copy shall be forwarded to the
Engineering Support Group to prevent duplication and enhance efficiency through sharing
information.

See ODOT Policy B-1201-1, B-1202-1 and B-1203-1 for information regarding the reproduction
of copyrighted material.



OKLAHOMA DEPARTMENT
OF TRANSPORTATION
CADD POLICY AND PROCEDURES MANUAL

Subject: Three Year CADD Plan Policy No. 100-4
Page 1 of 1
Effective Date: 1 Aug. 2000

Each division operating the CADD system will be responsible for developing a three-year CADD
implementation/integration plan.

The plan should contain, as a minimum:

¢)) Prioritized hardware/software requirements for each division for the next three
years.

2) Training requirements for each division and recommendations on the most
effective and efficient methods to provide this training.

3) Anticipated short and long term benefits from the proposal implementation.

This plan should be reviewed and updated annually to reflect the changing needs of each division
and the computer industry.

At the end of each fiscal year, a copy of the plan will be forwarded to the Engineering Support
Group for consolidation into the overall three year plan for the Department, to ensure
compatibility and standardization between the divisions.
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Subject: Training Policy No. 100-5
Pagelofl
Effective Date: 1 Aug. 2000

The Engineering Support Group will be the focal point for CADD training. Requests for training
shall be forwarded through the Division Manager to the Chairman of the ESG.

The ESG will then determine if qualified instructors exist within the Department to conduct ‘in-
house’ training. If no qualified personnel exists, the ESG will determine the best possible
purchased training option. ‘

Those individuals identified as qualified instructors will maintain proficiency with current
versions of department software.

Training for individuals identified as instructors will be determined by the ESG and included in
the annual review of the Department’s three-year CADD plan.
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Subject: CADD Policy Manual Revisions Policy No. 100-6
Page 1 of 1
Effective Date: 1 Aug. 2000

Requests for additions or revisions to the CADD policy & procedures manual shall be forwarded
to the Chairman of the Engineering Support Group.

Each request should contain the following information:

- Requestor’s name and phone number
- Date of request

- Proposed addition/revision

- Reason(s) for proposed changes

Requests will be reviewed by the ESG and revised policy/procedure sheets distributed on a
semi-annual basis.

e
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Subject: Engineering Support Group (ESG) Policy No. 100-7
Page 1 of 1
Effective Date: 1 Aug. 2000

The mission of the Engineering Support Group is to provide guidance and leadership to the
Department of Transportation in the area of CADD implementation and utilization. The ESG is
comprised of one representative and alternate from each of the Pre-Construction divisions, and at
least one representative from the Information Services Division (ISD). The members are
nominated by their respective division managers and approved by the current ESG membership.
This group, in conjunction with the ISD, will provide guidance for the department’s CADD
system. The ESG shall operate as an advisory unit responsible to the Assistant Director for Pre-
Construction. Questions/comments concerning the department’s CADD system should be
directed to the appropriate division representatives.

Mike Maupin, Bridge Division, ESG Chairman ........ccccecvvveenrernnirensesscssecnscssnenns 1-4241
Janet Griffin, Roadway Design Division, ESG Vice-Chairperson .........cceeceseisecsneees 1-2603
Jay Adams, Planning DiVISION ...ccceceviremssceresseeemencetienieseniismeessssenessnnessssisssesssesans 1-2728
Craig Moody, Planning AItEINAte ......c..cceeceeririrsrmmerreinninunnensnnecsessesssseessesssnnens 1-2728
Stanley Greene, Traffic DIVISION ceccceicrcciciiiensstieiniiiinisnirssne st ssaesssasssessnsnns 1-4376
Tony Ellis, SUTVEY DIVISION ...ceccierceessersenricesinesssrcenstssesisnessssnsssassississssessssnsssesns 1-2741
Robert Blackwell, Right-of-Way DiViSiOn ...c.cccceevervueinreivininiricinnnneneesssnesnesssnnenns 1-2655
Trent Hurst, Intermodal/Rail Safety.....ccccceveerverremmmcmmeemriecieniiirncennncnecesscnseniennens 2-3940
Jerry Beasley, Information Services DiVISION... ....eceirererecrccrinrcrecrnsssesseessscesesnenses 1-2664

Don Legrand, Construction DiVISION ......cccevesecerseriecirensrisctesscseneersmnessesseseensanes ...1-4159
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Subject: CADD Plan Preparation Policy No. 200-1
Page1of 1
Effective Date: 1 Aug. 2000

Each set of CADD plans for a construction project shall be accurate, legible, complete in design,
and suitable for bidding purposes. The completed plans shall be furnished in reproducible form.
For plans preparation requirements, it shall be necessary to refer to the latest edition of the
ODOT Roadway Design Manual, Standard Specifications for Highway Construction, or other
applicable ODOT publications.

The professional engineer in charge of the construction project plans shall supply to the
Department, for final plans submital, one reproducible set of plan drawings with original
signatures sealed by himself. Also, one set of plans archived electronically in accordance with
procedure No. 800-1 & 800-3, with the complete CADD design files in Intergraph/MicroStation
file format with accompanying COGO files in Ascii format. All files used to create final cross-
section and earthwork volumes will also be archived. These include all available digital terrain
model (.dtm), alignment (.alg), template (.tml), roadway modeler (.rwl) files used by InRoads and
any reports generated to compute final pay quantities.

Consultants are responsible for any translation required to convert non-MicroStation design files
to MicroStation format and the translation process. All translated design files shall conform to
the applicable standards adopted by the Department of Transportation plans.

ODOT will provide CADD related files in MicroStation (.dgn) format to consultants and
agencies outside of ODOT. Any translation to a format other than MicroStation (.dgn) format
will be the responsibility of the consultant or the outside agency

ODOT specific seed files are located on the Department Web Site:

“www.okladot.state.ok.us”.
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Subject: Standard Cell Libraries/Resource Files Policy No. 200-2
Page 1 of 1
Effective Date: 1 Aug. 2000

The Engineering Support Group will be responsible for developing and maintaining CADD
standard cell libraries/resource files. Copies of standard cell libraries/resource files will be stored
in a shared directory on a central server which is available to all users. Copies will also be
maintained on the Department’s Web server for consultants, contractors or other agencies doing
business with ODOT..

Requests for additions, deletions, or revisions to standard cell libraries/resource files shall be
forwarded to the Engineering Support Group for review and approval, as per CADD policy
100-6.

Survey Division:

Color Table: surct.tbl
Font Library: surftl.flb.......... MicroStation Version 4.0 Only

' font.rsc............. MicroStation Version 5.0 and above
Cell Library: sur4.cel

Linestyle Library: Istyle.rsc

Bridge, Right-of-Way, Roadway & Traffic Divisions:

Color Table: color.tbl
Font Library: newfont.rsc
Cell Library: 1.cel

Linestyle Library: newline.rsc
traffic.rsc (linestyles specific to Traffic Engr. Plans)
Planning Division:

Color Table: color.tbl
Font Library: newfont.rsc

planfont.rsc (used for special maps only, includes true type fonts)
Cell Library: planning.cel (2D)

Linestyle Library: comap.rsc
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At the time a project is awarded, all relevant files shall be archived to the IBM, using the archival
routine. See Procedure No. 800-1 and 800-3.
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Incremental and Disaster Back-ups are the responsibility of the Information Services Division.
Backups are run automatically each day. See Procedure No. 800-4.

Additional back-up is recommended, at the discretion of the individual division.
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The Network File Catalog system, or NFC, is a UNIX based utility designed to archive files
developed on Intergraph workstations to the mass storage on the IBM mainframe.

Each division has an archive catalog on the IBM mainframe, and in those various catalogs is the
NFC catalog, and the archived files as named by the NFC software.

Division IBM Catalog NFC Catalog

Bridge BRGARCH ‘BRGARCH.BRGFILES.CATLG’
Right-of-Way ROWARCH ‘ROWARCH.ROWFILES.CATLG’
Roadway Design RDYARCH ‘RDYARCH.RDYFILES.CATLG’
Survey SRVARCH ‘SRVARCH.ASBFILES.CATLG’
Traffic TRFARCH ‘TRFARCH.TRFFILES.CAT
Planning PLNARCH ‘PLNARCH.PLNFILES.CATLG’
Rail Safety and Programs =~ RRSARCH ‘RRSARCH.RRSFILES.CATALG’

The nameing conventions for archived files is:

HIGHLVL.INT.SWO#### DSNAME.DATE

For example; if a file was named ‘prj1234.dgn’ on the Interfraph workstation, was archived on
September 22, 1993, by Roadway Design, and the SWO number is 4321, then the IBM archive
file will be named:

‘RDYARCH.INT.SW04321.PRJ1234.DGN.SEP2293'

Before running NFC, you will need the following information:

The name(s) of the file(s) to be archived.

The password of the Logon I.D. you are using on the workstation.
A valid logon 1.D. on the IBM

The password for the logon 1.D. on the IBM

A job piece number for the project being archived.

The name of the primary county that the project is in.

A description of the project.

Nk RN
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8. The name of the project engineer (optional).

9. The name of the project draftsperson (optional).
10.  The project SWO number.

A copy of the latest version of NFC is stored on each division’s server in the ‘user’ login. It
should be copied to each workstation and stored in the ‘/usr/bin’ directory.

To run NFC: (Workstation responses will be in bold type)
- Type in NFC

Enter the file name(s) to transfer to the IBM (wildcards ok)
Note: You may enter multiple names delimited by blanks. Any combination of legal wildcards
may be used.

(Enter the file name(s) or wildcarded filename(s). Wildcards are standard wildcard characters, i.e.
* any characters or $ any one character)

Enter you PASSWORD for user on this node.
(This will be the user id you logged on to the workstation with)
Enter your logon ID for the IBM [USER]

(If USER is the same on the IBM as on your workstation, then hit enter. Otherwise, enter you
USERID that you use to logon to the IBM)

Enter you PASSWORD for [] on the IBM

(Enter your password)

Note: The workstation password must be the valid password for the workstation login L.D. that
you are presently using. Also the IBM logon LD. and password must be valid or NFC
WILL FAIL!
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Compiling list of file names.

(If no matching file names were found in the present directory, the following prompt will be
displayed.)

No files were found as specified. 1 - Exit [*] Retry
(The * means any response other than 1 requests a retry.)

Enter the Job Piece number in the form JPiHHEHI(HE)
(The Job Piece number is one of the PRIMARY search fields for NFCINQ and is required.)

Enter the county containing the project.
(The county must be one of the 77 valid county names spelled correctly. This field is also
required.) If no match is found for the county name, the following will be displayed:

We are talking about Oklahoma, aren’t we?
I couldn’t find ¢?’ in my list of county names.
- (You will be prompted for the county name again)

Enter the project description as it should appear in the catalog.

44 characters maximum

1 44

(This is a free form field that should contain as meaningful a description as is possible in 44
characters or less.)

Enter the name of the project engineer. (Optional but recommended.)
Enter the name of the project draftsperson. (Optional but recommended.)
No SWO number was found in the file name(s)
Please enter the SWO number in the form SWO#HHHE.
(This prompt will appear if no SWO field was found in the workstation file names in the form
#### name.type. Enter the project’s SWO number as #### or SWO####.)
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Confirm IBM filename DIVARCH.INT.SWO##H.FILE.NAME.DATE options are:
<RETURN->filename DIVARCH.INT.SWO##HH. FILENAME.DATE
- P purge filename from archive list

<KEYIN> filename = DIVARCH.INT.SWO##HH .<KEYIN>.DATE

(You will be prompted for each file name in turn for you to accept <KRETURN>, purge -P, or
rename <KEYIN>.)

At the end of the list of IBM fiie names
Total: #HHE blocks on ##(1.44m) floppie(s)
Press RETURN to continue.

This is an estimate of the number of floppies to format if you backup projects to floppy disks.
(Recommended)

This is the end of operator input to NFC. The screen will then display a series of ‘processing...’
messages, ending with:

Done...
If any messages other than the ones listed above are displayed, something has gone wrong.

DO NOT delete the files on the workstation until you have verified that they have been
successfully archived to the IBM.
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NFCINQ is UNIX based utility designed to retrieve archived files from archive catalogs on the
IBM to UNIX workstations.

Each division has an archive catalog on the IBM mainframe. In these various IBM catalogs is the
NFC catalog, and the archived files as named by the NFC software.

Division IBM Catalog NFC Catalog

Bridge BRGARCH ‘BRGARCH.BRGFILES.CATLG’
Right-of-Way TOWARCH ‘ROWARCH.ROWFILES.CATLG’
Roadway Design RDYARCH ‘RDYARCH.RDYFILES.CATLG’
Survey SRVARCH ‘SRVARCH.ASBFILES.CATLG’
Traffic TRFARCH ‘TRFARCH.TRFFILES.CATLG’
Planning PLNARCH ‘PLNARCH.PLNFILES.CATLG’
Rail Safety and Programs = RRSARCH ‘RRSARCH.RRSFILES.CATALG’

The naming convention for archived files is:
HIGHLVL.INT.SWO#### DSNAME.DATE

For example:
‘RDSARCH.INT.SWO04321.PRJ1234.DGN.SEP2293'

Remember the files are being sent by the IBM, and there may be a delay before the files appear in
your directory.

When the files appear in your directory, they will be named as:
#### . name.type

#itit# is the four SWO digits.
name is the same as on the IBM between the SWO and the type.
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The type is the last field before the date field.
So if the file is named SRVARCH.INT.SWO01234.S3.TOPO.SEP1092 on the IBM, it will be
named 1234.s3.topo on the workstation.

Before running NFCINQ, you will need the following information:

The PASSWORD of the LOGIN ID you are using on the WORKSTATION.
A valid LOGON ID on the IBM.

The password for the LOGON ID on the IBM.

Which division’s archives to search.

The Project SWO number, or

A Job Piece Number for the project to be archived, or

The NAME of the primary COUNTY that the project is in, or .
A DESCRIPTION of the project.

To run NFCINQ:

Login to the workstation where the retrieved files will be stored. Enter ‘NFCINQ’
Read and follow the prompts. Text shown in bold print is what will appear on the screen.

Enter your PASSWORD for wkstuid on this node.
(This will be the user id you logged on to the workstation with)
Enter your user ID for the IBM [WKSTUID]

(If WKSTUID is the same on the IBM as on your workstation, then hit enter. Otherwise, enter
your USERID that you use to logon to the IBM.)
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Enter you PASSWORD for (IBMLOGID) on the IBM.

Note: The workstation password, the IBM LOGON ID, and IBM LOGON PASSWORD must be
valid or NFC WILL FAIL.

At this point the following message will be displayed:
Enter the catalog to be searched. (Number to left of Division name)

- BRIDGE

- RIGHT-OF-WAY

- ROADWAY DESIGN

SURVEY

- TRAFFIC

- PLANNING

- RAIL SAFETY AND PROGRAMS

NAU R W -
[

Enter the division’s index number of the archives to search.

Select the Contents of the REPORT by:

1 - SWO Number

2 - JOB Number

3 - COUNTY

4 - CHARACTER String
5 - EXIT

Enter the index of catalog header record field to search for, or EXIT.
If you select option 1, the following prompt will be displayed:

Enter the SWO number in the form SWO#itHt.
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The SWO may be entered as swol#i##, SWO##HHE, or #it#i. If you select option 2, the following
prompt will be displayed:

Enter the Job Piece Number in the form jpiHHHHHI(H)
The job piece number may be entered as jp#it#it#i (i), JPH##H##H#FHE), or H#HHHH(H).

If you select option 3, the following prompt will be displayed:
Enter the COUNTY name in upper or lower case and spelled correctly.

If you seiect option 4 the following prompt will be displayed:

Enter the CHARACTER string (or case or help).

Enter the character string as it is stored in the header (spaces count), or case to toggle case
sensitive searches or help for an explanation of legal wildcard.

This will result in a series of ‘processing...” messages ending with: Trying pass # to retrieve
list.

Up to five passes will be attempted. If the reply has not been achieved by then, the following text
will be displayed:

The IBM must be having a bad day. Do you wish to continue?

If a reply has not been achieved in five passes, it is recommended to try at a later time.

If no matching entries were found in the selected catalog, the following message will be
displayed:
NO ENTRIES FOUND IN ‘catalog name’
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If one or more matches were found in the catalog, the following will be displayed:
ENTRIES FOUND IN SRVARCH.ASBFILES.CATLG

1>swo01234 jp07378(01) blaine sh51a watonga to sh8a

2>swo 1234 jp07378(01) blaine sh51a south + Int. sh51

To select a group of files for retrieval from the archives to this workstation, enter the
number to the left of the record or RETURN for none.

o

Enter one of the index numbers, or RETURN to exit the program.

If one of the indexes was chosen, a typical response would be:
1>All
2>SRVARCH.INT.SW01234.CL.S3.CMD.SEP1092
3>SRVARCH.INT.SW01234.CL.S3.DGN.SEP1092
4>SRVARCH.INT.SW01234.CL.S3.REF.SEP1092
5>SRVARCH.INT.SW01234.CL.S3.RPT.SEP1092
6>SRVARCH.INT.SW01234.S3.DAT.SEP1092
7>SRVARCH.INT.SW01234.S3.SFF.SEP1092
8>SRVARCH.INT.SW01234.S3.TIM.SEP1092
9>SRVARCH.INT.SW01234.S3.TOPO.SEP1092

To select files for retrieval from the archives to this workstation, enter the number to the
left of the record or RETURN for none.

A 1 will retrieve all of the files, or select the files you want by entering their indexes separated by
spaces (1.€., 2 8) to retriecve SRVARCH.INT.SW01234.CL.S3.CMD.SEP1092 and
SRVARCH.INT.SWO01234.S3.TIM.SEP1092.

Entering a RETURN will bypass retrieving any files, and a list of the files will be saved in
nfcing.lis.

e’
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1. Make sure that all files to be archived have names of 8 characters or less and start with a

letter and do not contain any special characters (underscore, question marks, etc.).

2. Place all files of a job to be archived in to a single directory. (The main directory may
contain sub directories if needed.)

3. Complete an archive Request form and submit the form to the person responsible for
archiving.

4. Map network Drive to the computer containing the files to be archived.

3. Start the MSDOS Command Prompt and change directory to the network cirectory

containing the files to be archived.
6. Key in fip dsibm and enter ibm user id and password.

7. Change directory to the appropriate archive directory. (Example: For a job with the job
piece number 12345(04) type: cd rdsarch.int.j1234504.

8. Change directory to the sub directory to which the files are to be archived.
9. Key in bin

10.  Key in prompt (optional - the prompt command turns off the option to confirm that the
file is to be transferred).

11.  Key in mput *.*. This archives all the files in the current directory.
12. When finished, key in bye to exit ftp.
13.  If there are sub directories to be archived, change directory to the sub directory then

repeat steps 6 through 12, incorporating the sub directory name in step 7. (Example: type:
cd rdsarch.int.jl1234504.inroads).
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14.  When finished with all subdirectories key in bye to exit ftp.
15.  Key in exit to close the MSDOS window.

16. Disconnect the Network Drive.

To retrieve archived files follow the directions above replacing get or mget with put or mput

—r
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Electronic file transfer via ftp (file transfer protocol).
Ftp is to be used by authorized personnel to transfer files outside of the department

Syntax for common file transfers:
To initiate a connection to a remote node:
$ ftp [nodename]

Name (remote node name:current local directory): specify remote login directory and
answer the password prompt.
* Note: You cannot access an un-passworded login (such as user) using ftp.

To set the file transfer type to binary for Intergraph file transfers (the default is ascii):
ftp>binary

To receive a single file from a remote node:
ftp>get [remotefile] [localfile]
*Note: If you do not specify a name for the local file, it is named as the remote file name.

To receive multiple files from a remote node:
ftp>mget [remotefiles] (wildcards are acceptable with glob toggled to on. The default for
glob is on).

Currently used ftp commands:

ascii
Sets the file transfer type to network ASCII, the default type.

binary
Sets the file transfer type to support binary image transfer. Use this type for most
Intergraph files.
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bye

Terminates the session with remote server and exits ftp. An end of file also terminates the
session and exits.

cd remote-directory _
Changes the working directory on the remote machine to [remote directory].

close
Terminates the session with the remote machine and returns to the ftp> prompt.

get remote-file [local-file]
Copies the remote-file and stores it on the local machine. If you do not specify a local
filename, the name stays the same as it is on the remote machine. A file transfer uses the
current settings for type, format, mode, and structure.

glob
Allows or disallows the use of wildcard characters in filenames. If wildcard characters are
enabled, you can use wildcard characters to specify multiple files with the mdelete, mdir,
,get, mls, and mput commands. The glob (“global”’) command is a toggle command.
Wildcard use defaults to enabled. You can also use the -g option on the ftp command line
to disable the use of wildcards.

Is remote-directory [local-file]
Prints as abbreviated list of remote directory’s contents. If yo do not specify a remote
directory, the current working directory is used. If no local file is specified or if local-file
is -, the output goes to the terminal.

N
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mget remote files
Expands the remote-files on the remote machine and executes get for each filename
produced. See glob for details on the filename expansion. Files are transferred to the local
working directory, which can be changed with the “lcd directory”. New local directories
can be created with the “! Mkdir directory”.

mkdir directory-name
Makes a directory on the remote machine.

mput local-files
Expands wildcard in the list of local files given as arguments and executes put for each
file in the resulting lists. See glob for details on filename expansion.

open host [PORT]
Establishes a connection to the specified host. The specified host can be a nodename or
an Internet address. You can also supply an optional port number. In this case, ftp
attempts to contact an ftp server at that port. If the auto-login option is on (default), ftp
will also attempt to automatically log the user in to the specified host.

put local-file [remote-file]
Copies a local file to remote system. If you do not specify remote-file, ftp uses the local
filename. File transfers use the current settings for type, format, mode, and structure.

pwd
Prints the name of the remote system’s current working directory.

quit
Same as the bye command, which exits you from ftp.

send local-file [remote]
Same as the put command.
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status

Shows the current status of ftp.

See the Commonly Used ftp Commands for a list of other file maintenance commands and
explanations or consult the CLIX TCP/IP User’s Guide for further information.

S
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Incremental backups are performed daily to an 8mm tape backup system in the Information
Services Division.

Notes:
Backup retrieval must be done by a user with administrator privileges.

Backup retrieval can be done remotely if the administrator’s computer has been added to
the users ADSM backup Authorization. This must be done on each user’s computer.

To recover backups:

Notify the system administrator in your division of the need for a backup recovery or call the ISD
Help Desk at 1-4195. The following information must be provided at the time the request is
made.

Nodename of the computer where the file resided. (As in RURPC14)

The filename(s) of the files to be retrieved

The full path, including drive, of the directory location of the file(s) at the time they were lost or
corrupted.

If files of the same name still reside at that location, they should be moved by the user prior to
making the request. Existing files of the same name will be overwritten at the time the backup
recovery is done.



\ S’



)

N’

CADD MANUAL TABLE OF CONTENTS

SECTION 1: FILE TRANSFER

Naming Conventions

Bridge Naming Conventions
File Transfer

Storing/Restoring Floppies
WinZip

PKZIP For Windows
Retrieving Back-ups From IBM

SECTION 2: JOB PRODUCTION

2-1
2-2
2-3
2-5
2-6
2-7
2-9
2-10

Seed Files

Working Units & Global Origin

Steps To Construct Plan and Profile Sheets
Using Reference Files To Construct P&P Sheets
Scale Factors

Mass Diagram

InRoads Mass Diagram

Pay Quantity Sheet

SECTION 3: TITLE SHEETS

3-1
3-3

Creating Title Sheets
Layout Maps For Title Sheets

SECTION 4: MICROSTATION COMMANDS

4-1
4-7
4-8
4-9
4-10
4-11
4-12

MicroStation Tips

Useful MicroStation Commands
Custom Line Styles

Key-in Palette Options

Locks & Attributes
MicroStation Key-ins

Newfont Character Symbols

SECTION 5: MICROSTATION CELLS AND LINE STYLES

5-1
5-18
5-21

Roadway Cell Library
Roadway Line Style Library
Pen Table



SECTION 6:

6-1
6-2
6-3
6-4

SECTION 7:
7-1
SECTION 8:

8-1
8-2
8-3

SECTION 9:

9-1
9-2
9-3
9-5
9-6
9-15

PLOTTING INFORMATION

Plotting Information

Plotting Plan and Profile Sheets
Plotting .set Files

Pen Table Files With Character String

SURVEY DIVISION
Inserts From Survey
MISCELLANEOUS NT COMMANDS

MSDOS Command Prompt
NT Tips and Hints
Lotus Notes Tips

LEVEL, WEIGHT, and COLOR GUIDE

Sheet Layout

Area Patterns

R/W Plans (Specific to R/W Division)
Survey (Specific to Survey Division)
Existing TOPO

New Construction

N’



SECTION 1

FILE TRANSFER
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1-1
NAMING CONVENTIONS

Following a standard filing system will allow all divisions access to files quickly and easily.
Specific naming conventions are also used for archiving. It is important they be followed.

NAMING DIRECTORIES - All jobs should be kept in a directory called /usr2/jobs/. All files
related to a specific job should be kept in a single subdirectory. The directory name should
be the J/P number.

example: /usr2/jobs/12345/

FILE NAMES - Each file in a directory must have a unique name. The IBM allows eight characters
between ".’s", the first one being a letter. Therefore, names can only be eight character
segments, separated by a ".", and starting with a letter. All drawing files should end
with a ".dgn" extension. The file name should relate to the files’ function. Example: a
typical section drawing for a job in Oklahoma County could be named: oklatyp.dgn
Including the county, Job Piece or Project number in the file name is not necessary since the

files will be stored, both on workstation and in the archive, under the job/piece number.

This allows other operators to know what is in a file without having to open it. In the case of multiple
sheets of the same name a numeric may be added to each file name as in : 2 typical section files
would be named: typicall.dgn and typical2.dgn

Suggestions for drawing file names: (# is a number added if multiple sheets of same name)
Roadway Design:

title.dgn - title sheet

typical#.dgn - typical section sheets

typsec#.dgn - typical section sheets

detail#.dgn - detail sheet

drnstr.dgn - detail of drainage structures

detmdop.dgn - detail of median opening

detdrv.dgn - detail of drives

detst.dgn - detail of street returns

detour.dgn - detour layout sheet

survdat#.dgn - survey data sheets

swp.dgn - storm water management sheet

hydraul.dgn - drainage layout sheet

layout.dgn - geometric layout

massdia.dgn - mass diagram sheet

massml#.dgn - mass diagram mainline

massdet.dgn - mass diagram detour

masslt.dgn - mass diagram left side of widen and resurf

massrt.dgn - mass diagram right side of widen and resurf

summary#.dgn - summary sheets

sumdrstr.dgn - summary of drainage structures

l\d/
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sumsurf.dgn - summary of surfacing quantities
sumew.dgn - summary of earthwork
pqrdwy.dgn - pay quantities - roadway
pgnotes.dgn - pay quantity notes
ppO#.dgn - plan and profile sheets
ppstub#.dgn - plan and profiles of stub connection
ppramp#.dgn - plan and profiles of entr. or exit ramp
topo.dgn - topography of existing survey
align.dgn - new construction alignment 3D file
const.dgn - new construction’s 3D file
prof.dgn - profiles 3D files
pattern.dgn - patterns used as reference for P & P sheet
xsec.dgn - cross section sheets

Traffic sheets:
sumtrf.dgn - summary of traffic quantities
pqtraf.dgn - pay quantities - traffic
sumsign.dgn - summary of signing
sumlgt.dgn - summary of lighting
sgnstp#.dgn - signing and striping
trfctrl#.dgn - traffic control sheet
light#.dgn - lighting sheet
signal#.dgn - signalization sheet
strpdet.dgn - striping detail sheet



BRIDGE NAMING CONVENTIONS

Standard Filing System for bridge division will allow all divisions access to files quickly and
easily.

/usr2/bridge/jp##Ht/a_filenamen. dgn
The r in bold italics in the file names are in place of the number for sheet n of n ie: a_abutl.dgn
and b_abut2.dgn.

It may be necessary to add a s and » at the end of the file name of some design sheets. This
would only be on sheets where there are multiple sheets with multiple components.

Component No.

Component
Sheet no. of
Structure Letter component series
\\\ [sheet | of 4 =sl1)

/usr2/bridge/jphEk#h/a_abutls?.dgn

ftitle.dgn
/sum.dgn
/pnpn.dgn
/a_gpe.dgn
/_gpe.dgn
/a_foundn.dgn
/a_substr.dgn
/a_abutn.dgn
/a_wingn.dgn
/a_under.dgn
/a_piern.dgn
/a_supern.dgn
/a_beamn.dgn
/sejn.dgn
/a_appslb.dgn
/a_trail.dgn
/a_drains.dgn
/piling.dgn
/a_slopewln.dgn
/a_retainn.dgn
/chnichgn.dgn
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1-4
FILE TRANSFER
ftp From MSDOS Command Prompt:

NOTE: Be sure to change directories to the correct directory on your workstation before
keying in the ftp command. Do not omit "bin" (binary) for all drawing files. For more
than one drawing at a time, key-in “prompt” before mget or mput to keep from hitting y
(yes) to accept each file.

get & mget

dsibm to PC.

Key-in: ftp dsibm

Your IBM Login: user id

user id IBM Password:

ftp> dir (list dir)

ftp> c¢d dirname (move to or create a directory)

ftp> bin (for all drawing files)

ftp> get filename (for one file) or mget (for multiple files)

put & mput

. PC to ibm.

. Key-in: ftp dsibm

. ftp> bin (for all drawing files)

. ftp> put filename (for one file from) or mput (for multiple files)

PC to PC
o Key-in: ftp nodename

o Name (computer id:user): user

o Password:

o Follow the steps above to get or put files.

Key-in bye to exit ftp command.

FILE MANAGER:
File Manager may not be available in future versions of NT. It would be beneficial to
learn to use the Network Neighborhood Explore.
o Under FILE MANAGER select DISK > CONNECT NETWORK DRIVE
. Double click on the computer to be connected to.
. Double click on the directory name and follow the path down to the file(s) needed.
. If an entire directory is needed, hold the left mouse button down on the directory

name and drag it to the directory on your computer.



NETWORK NEIGHBORHOOD/EXPLORE:
. Use the right mouse button to click the Network Neighborhood icon.
Click on Explore with the left mouse button.
Double click on the workstation you want to connect to.
Move to the directory where the file(s) you want are located.
On the right side of the window - right mouse click on the file you want. If there
is more than one file to be retrieved: highlight all the files to be copied with the
left mouse button then, click the right mouse button. Hold the Ctrl button down
to select random files then, click the right mouse button.
Select Copy with the left mouse button.
On the left side of the window double click on My Computer.
Double click on the drive where the file(s) will be placed.
Move to the directory where the file(s) will be placed.
Right mouse click on the directory name.
Select Paste.
The file(s) should be shown on the right side of the window.

NETWORK NEIGHBORHOOD/EXPLORE/MAP NETWORK DRIVE:
From the Network Neighborhood/Explore window select Tools =>Map Network Drive
Double click on the workstation you want to connect to.
Move down the left side of the window until you find the workstation
It will look something like this:usr2 on ‘Rdypc28' (E:) Double click on it.
Move to the directory where the file(s) are and follow the previous instructions for cut
and paste.

NOTE: A drawing file (*.dgn) may also be opened from another workstation by double clicking
on the file name. You are connected to the other computer and the file will NOT be transferred. If
the file opens as Read Only, there is a good chance someone else is already in it.

To disconnect, click Tools => Disconnect Network Drive.

Highlight the drive and click OK.

The message: There are currently files open on E: (connected to WRdypc28\wusr2). If you
do not close the files before disconnecting from the network device, data may be lost. Do
you want to disconnect the device anyway? Click YES.
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STORING TO FLOPPIES:

FILE MANAGER:
FORMAT DISK

Place a diskette in the drive.
Click File Manager => Disk => Format Disk => OK

1-6

“Formatting will erase ALL data from your disk. Are you sure you want to format

the disk in drive A?” Yes
Do you want to format another disk? Yes No

STORE TO DISK

From File Manager

Place a formatted diskette in the drive.

Move to the directory with the files to be stored in one window.

Change to the A drive in a second window.

Select the file(s) to be stored and drag to the A:\ window.

“Are you sure you want to copy the selected files or directory to A:\?" Yes

RESTORE FROM DISK

From File Manager

Place the diskette in the drive.

Move to the directory where the file(s) are to be placed.

Change to the A:\ drive in a second window.

Drag the file(s) from the A:\ window to the directory where the file(s) are to be
placed.

“Are you sure you want to copy the selected files or directory to C:\usr2?’Yes

NETWORK NEIGHBORHOOD/EXPLORE:

Double click on My Computer => 31/2 Floppy (A:)

Everything else will be the same as transferring files from one computer to
another.

Use the Cut and Paste commands to cut from either the floppy or the computer
and paste the file(s) to the other location.

If the files are too big to fit on one floppy, pkzip, or winzip will need to be used. Follow
the instructions in the following page’s (1-5) for pkzip, pkunzip, and winzip.
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WINZIP
There should be an icon on your desktop, if not:
Check under the top half of START or
Click START > PROGRAMS > WINZIP > WINZIP 6.3 32-BIT
The [I AGREE] evaluation window must be selected. This version of WinZip is for
evaluation purposes. If ISD decides to keep WinZip they will acquire a license
and this step will not be necessary.

TO ZIP FILES:
. Click NEW
Change to the directory the zip file is to be located (a\: for floppies)
Click in the FILE NAME box and key in a name for the zip file (no extension)
Click OK
Change ADD FROM: to the directory where the files are located
Select the file(s) to be zipped
Click ADD
This will create a file with the name given in step three with a .zip extension, in
the directory specified in step two

TO UNZIP FILES (EXTRACT):
. Click OPEN
. Change to the directory with the name.zip file in it
. Click on the file name
. Click OPEN

TO EXTRACT A SPECIFIC FILE:
To extract a specific file(s)

. Click on the file(s) to be extracted
. Click EXTRACT
. Move to the directory the files are to be placed in
J Make sure the FILES is clicked to SELECTED FILES
. Click EXTRACT
TO EXTRACT ALL FILES:
To extract the entire zip file
. Follow the first three steps from above

* Make sure FILES is clicked to ALL FILES
. Click EXTRACT

When finished EXIT out of WinZip

WinZip and PKZIP can be used for any zip file. WinZip files can be unzipped in PKZIP and
vice versa.

\\— /,,
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PKZIP FOR WINDOWS
This software is shareware and can be obtained from any computer that already has it.

PKUNZIP

Double click the PKZIP icon.

Place a formatted diskette in the drive.

Click File => New

File Name: file.zip (DO NOT hit enter unless it is to be zipped on the
workstations C:\ drive.)

Change Drives: to A:

Then click OK.

Change Drives: in this palette to the C:\ drive.

Under Directory change to the directory to be zipped and stored.
Select file(s) to be zipped and stored then, click Add Files and OK.
Click done when finished and a table will appear showing information pertaining
to the stored files.

Click File => Exit => OK

Double click the PKZIP icon.

Place the diskette in the drive.

Click File => Open

Change the drive to A:\

Select the filename.zip to be restored then, click OK.

A table will appear with information pertaining to each file stored.
Select the file(s) to be unzipped and restored to the C:\ drive.
Or click Select => All

Click Unzip => Extract files

Change to the directory where files(s) are to be placed.

Click Extract.

Click done when finished.

Click File => Exit => OK



BACKUP
(ADMINISTRATOR’S ONLY)

To retrieve backups from the IBM it is necessary to have an administrator log into the
workstation. Once logged in as administrator:

Click START > PROGRAMS > ADSM NT CLIENT > ADSM BACKUP

Once adsm backup is started, select the drive the backup file(s) is on and wait for the directory
structure to come up. Move through the directory structure until the file(s) is found then, select
and retrieve all files needed. Available options allow files to be replaced in the same location as
they were stored from or renamed and moved to another location.



SECTION 2

JOB
PRODUCTION



SEED FILES

Seed files are located on DSDPS04 in the Seeds directory with sub-directories for each division.

If there is a copy of these files on other workstations, they will need to be updated any time

changes have been made to the originals.

The /Seeds/date.txt text file will show which files were changed, when and what the changes

were.

Example Directory structure:

/Roadway/dgn/english: /Roadway/dgn/metric:
blank2d.dgn m100pnp.dgn
blank3d.dgn m50pnp.dgn
sht100.dgn mdetail.dgn
summary.dgn metric2d.dgn
title.dgn metric3d.dgn
typical.dgn metricpp.dgn

mtitle.dgn
typicalm.dgn

[Traffic/dgn/seeds: [Traffic/dgn/seeds/LIGHTING/detail:

e100blk.dgn m500blk.dgn elight.dgn

el0blk.dgn mblk.dgn litsch.dgn

e20blk.dgn pgsheet.dgn mlight.dgn

e50blk.dgn pqsum.dgn pgsum.dgn

eblk.dgn setup.bat title.dgn

m1000blk.dgn stdblk.dgn

m100blk.dgn title.dgn

m200blk.dgn

[MTraffic/dgn/seeds/SIGNALS/detail:
esignal.dgn
flash2pl.dgn
flash4pl.dgn
loops.dgn
msignal.dgn
phase02.dgn
phase04.dgn
phase05.dgn
phase08.dgn
pqsum.dgn
psdimn].dgn
psdimn2.dgn
title.dgn

[Traffic/dgn/seeds/SIGNING/detail:

ENGLISH.FMT
ENGLISH.WK1
eohssd.dgn
esign.dgn
METRIC.FMT
METRIC.WK1
mohssd.dgn
msign.dgn
Pgsum.dgn
ra.dgn
signsum.dgn

ss.dgn
title.dgn

Retrieve the file(s) needed and rename them to match the naming conventions (1-1).

N



'STANDARD SHEET DIMENSIONS

i )‘mets shall be 36" x 23" with the working area 324" x 2014 plon & profile sheets shail be 36" x 237 with
@ working area 31%4" x 21", '

Al printing and/or titles shall be placed inside the working area. See detils below for proper dimensions.

There shall be no stick-ons or other surfoca adhesives on the final plans, except that on right~of-way plans o patterned
surface adhesive similar to “zip—c—tone” shall be used in accordance with the "specification for right-of-way plans”.
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STANDARD SHEET DIMENSIONS
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WORKING UNITS AND GLOBAL ORIGIN

Note: The working units and global origin have already been set in the seed files described on
the previous page (2-1). Using a preset seed file eliminates having to setup any drawing
files.

English (Imperial):
Unit Names
Master Units FT
Sub Units TH

Resolution
10 TH Per FT
120 POS UNITS Per TH

Working Area
3579139 SQ FT

Global Origin
Lower Left
2d => Go = 0.0000,0.0000
3d => Go = 0.0000,0.0000,1789569.7067

Metric:
Unit Names
Master Units M
Sub Units CM
Resolution
100 CMPerM
40 POS UNITS Per CM
Working Area
1073741 M Square
Global Origin

Lower Left
2d => Go = 0.0000,0.0000
3d => Go =0.0000,0.0000,536870.9120
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STEPS TO CONSTRUCT PLAN AND PROFILE SHEETS

1. Request job files - Fill out PROJECT REQUEST FORM with the following information:
SWO number, Job Piece Number, County, Highway, Workstation Node, and Directory
Pathname. Station Extents and Description are also helpful.

2. Submit the completed PROJECT REQUEST FORM to the person in charge of retrieving
Survey files in your division.

3. Convert 2d files to 3d - Enter the 2d drawing. From the Menu Bar select:
FILE=> EXPORT => 3d. Enter a unique name for the 3d file with a .dgn extension.

4. Copy a blank 3d drawing file - from the seed directory (2-1).

5. Display the Horizontal Alignment - Using the Inroads icon, enter the blank 3d drawing file
copied in step 4. From the Inroads Bar Menu select:
File => Geometry => Open => Filename. If there is no geometry file present, one will have
to be built. From the Inroads Bar Menu select View => Active => Horizontal Alignment.

6. Using two views WINDOW AREA around the beginning station in one view and the ending

station in the second view: of sheet one.
7. In the Key-in window, key-in active angle pt2. Snap to the beginning station of the sheet and
accept, then snap to the ending station of the sheet and accept to set the active angle.

8. Attach the Metric (metsht) or English (shtblk) sheet block cell from the 1.cel library.

9. Snap to the station at the beginning of the sheet and accept. Repeat steps 6 through 9 until all
sheet blocks are placed.

10. WINDOW AREA around the end of sheet block 1 and the beginning of sheet block 2.

11. Select the EXTEND ELEMENT TO INTERSECT command. Pick the station tick and
extend it to the top of the first sheet block. Next, extend the same tick to the bottom of the
first sheet block. This will be used with the clip boundary fence. Repeat steps 10 and 11 for
the remaining sheets.

12. Utilities - If a utility file is not provided by the Survey Division, they should be drawn at this
time. Working in the drawing file that contains the sheet blocks with Inroads, select:
File => Geometry => Open => Filename. Check the active alignment by selecting:
Utilities => Active Geometry from the InRoads Bar Menu. From the Active Geometry
pop-up pick the SELECT bar. Choose Horizontal Alignment. In the AVAILABLE box
select the centerline alignment.

13. Set the proper level, weight, color, and line style for the utility line to be drawn.



14.

15.

16.

17.

22.

23.

2-4

Select the Place Smartline command from the Main palette. The line string can be drawn
using the SO=<station>,<offset> command. When using the SO command, remember to the
left is negative, right is positive. Continue with the SO command until the end of the utility
line is reached.

If an incorrect entry is made, DO NOT RESET!. Instead, enter the correct data and continue
to the end. After the line is finished, Window Area around the error. Select the DELETE
VERTEX command from the MAIN palette. Pick the bad vertex and accept.

Label utility lines - In the Key-in window, key-in active angle pt2. Pick two points along
the utility line where the label will be placed. Using the PLACE TEXT command, enter the
label and place it. Repeat steps 13 - 16 for each utility line and R/W lines.

Reference Files - Follow directions in section 2-5 to attach reference files.

Using the MOVE ELEMENT command relocate overlapping text so that the plans are
readable. This may involve relocating text in the reference files also. If so, from the Key-in
window select FILE => OPEN. From the Open Design File pop-up, choose the file to be
edited. Attach the reference files needed and relocate the text as needed. Files from other
divisions should not be edited. For example: Roadway Design should not edit Survey files.

Construct other elements needed in the same manner as described above.



REFERENCE FILES

Using Reference Files To Construct Plan and Profile Sheets

1. Enter the P & P sheet drawing.
2. From the Menu Bar select FILE => REFERENCE.
3. In the Reference Files pop-up, select TOOLS => ATTACH.

4. In the Attach Reference Files pop-up select the file to be attached. Highlight the filename
then click on the OK button.

5. In the Logical Name pop-up, enter a name for the reference file that describes the function
of the file. (e.g. topo, profile, newconst...)

6. In the Reference Files pop-up, make sure DISPLAY, SNAP and LOCATE are on.

7. Repeat steps 1 through 6 for each reference file needed. Do not attach the P & P sheet
border at this time.

8. Window Area around the sheet block (reference file) for the P & P sheet. Make sure the

antira hlacl ic v;nﬂ-\ln
Ciiliiv ULIULUA 1D Violvlo.

9. Key-in Rotate View Element select the bottom line of the sheet block and data point in
the view window.

10. Select the Place Fence Shape command. Place a fence around the sheet block snapping
to each corner.

11. In the Reference Files pop-up, highlight the reference files to be clipped. Select
TOOLS => CLIP BOUNDARY.

12. Attach the P & P sheet border using the saved view in the reference file.
13. In the Reference Files pop-up, select TOOLS => MOVE. Snap to the center bottom of

the plan portion of the P & P sheet and accept. Next, Snap to the center bottom of the
sheet block and accept.

“b/'



SCALE FACTORS

Fonts: newfont.rsc Path: bentley > workspace > wsmod > system > symb
(SCALE - refers to the scale of a Leroy Guide)

ENGLISH METRIC

SCALE | 100’ | 50° | 20’ | 1000 | S00m | 250m
m

100 10.0 |50 [20 |25 1.25 |0.625
120 12.0 {60 [2.4 |3.0 1.5 0.75
140 140 170 |28 |35 1.75 | 0.875
175 175 | 875 |35 |45 2.25 | 1.063
200 20.0 | 10.0 {40 5.0 2.5 1.25
240 240 {120 |48 6.0 3.0 1.5
300 30.0 | 150 | 6.0 |73 3.67 | 1.835
350 350 | 175 |7.0 |9.0 4.5 2.25
500 50.0 {250 |12.5 | 125 6.25 |3.125

'Linestyles: roadway.rsc Path: bentley > workspace > system > symb

LINESTYLE SCALE FACTORS
ENGLISH METRIC
100 Scale | 1.00 | 1000 Scale | 0.25

50 Scale | 0.50 | 500 Scale |0.125

20 Scale | 0.20 | 250 Scale | 0.625

Cells: 1.cel Path: bentley > workspace > system > cell
CELL SCALE FACTORS
ENGLISH METRIC

100 Scale | 1.00 | 1000 Scale | 0.8333

50 Scale | 0.50 | 500 Scale |0.4167

20 Scale | 0.20 | 250 Scale | 0.2089
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HOW TO IMPORT A MASS DIAGRAM FROM AN ASCII FILE

1. Using a text editor, create a file containing the mass ordinate information. This file will need a
.se extension. Use the following format:

station ordinate pen-flag

The pen-flag should be set as follows:
1 - for the first entry.
6 - for the last entry or each entry in an
exception.
0 - for all other entries.

EXAMPLE:
38200 483818 1 Mirst entry
38200 479640 0
38400 475050 0
38455 472326 0
38456 472301 0
38456 472301 6 }begin exception

39105 472301 6 }end exception
30105 472301 0

fo ¥ RV vi v

39106 4722710
39200 466729 0
39300 4611520
39400 455729 0
39500 450802 0
39600 446640 0
39600 446640 6 }end entry

NOTE: The entries for the beginning and end of the exception are done twice. Once with
a 0 flag and once with a 6 flag. This format will leave a gap in the
mass line at the exception.

2. Create a 3d drawing file using the "'create” command.
3. Enter the drawing and load InRoads.(in the command window key-in "md] 1 inroads").

4. From the InRoads Menu Bar, select FILE = GEOMETRY => NEW in the CREATE
GEOMETRY pop-up make a new Geometry Project.

5. From the InRoads Menu Bar, select FILE => GEOMETRY => NEW in the CREATE
GEOMETRY pop-up make a new Horizontal Alignment.

6. From the MicroStation Main palette select the Place Line command. In the Tool Settings box
turn on LENGTH and set it to the length of the project (including exceptions) and turn on the
ANGLE and set it to 0. Place the line.



7. Zoom out until the whole line is visible. From the InRoads
Bar Menu select PALETTES => HORIZONTAL EDIT. From the HORI-
ZONTAL EDIT pop-up pick Add Horizontal PI (The upper left
corner button). Snap to the left end of the line and accept.
Next, snap to the right end of the line and accept.

8. From the InRoads Menu Bar, select PALETTES => EVENT POINTS.
From the Event Points pop-up pick the Station Equation button
(The upper left corner button). In the Station Equation pop-up
in the small box labeled "Station", key in the beginning
station for the alignment. Hit the down arrow on the key-board
3 times then click on the APPLY button in the Station Equation
pop-up with the mouse. This sets the beginning station.

9. From the InRoads Menu Bar, select PALETTES => PROFILE. From
the Profile pop-up pick the Import Profile button (fourth
from the left). In the Import Profile pop-up set the TOGGLES
and SYMBOLOGY for the mass diagram. In the toggles, start
with a spacing for major ticks of 10000 for both left and
right axis. Turn off the minor ticks. Set Major Tick spacing
for the bottom axis to 500.

10. Next select the directory that contailn the ASCII file from
the Directories box in the Import Profile pop-up. Select
the file from the Files box in the Import Profile pop-up.

11. In the Import Profile pop-up, in the Exaggeration box,
key-in .025.

12. In the Import Profile pop-up, click on the APPLY button.
When the Import Profile pop-up disappears put a data point
in the view to locate the bottom left corner of the mass
diagram.

NOTE: The numbers in the toggles, symbology, and exaggeration
will have to be modified to suit a particular diagram.
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INROADS MASS DIAGRAM
NOTE: End Area Volumes must be computed before a mass diagram can be displayed.

1. Click Palettes > Volumes

2. Click Mass Haul Diagram

3. Click Setup > Axes

4. Set Spacing for each Axis (click APPLY each time an entry is changed)
5. Click CANCEL

6. Set Vertical Exaggeration

7. Click APPLY

8. Data Point in the MicroStation window

9. Click CLOSE



Creating a Pay Quantity Sheet from Highest:

Highest Program:

After all Items are built and Notes (descriptions) added:

Go to File >> Export

List of File Type will automatically be set to .CSV

Change Export File Formats to: Lotus (Catogories) (use down arrow to find this)
Make sure x appears in box for: Assembly Items List

Enter File Name at top of Dialog Box

Select OK

Close or minimize Estimator

Start Lotus123 (Ver. 7 works best)

Go to File >> Open

Change Files of Type to .TXT (use down arrow to find this)

In top of Dialog box, find directory where .CSV file exported from Highest was saved and
double click on filename or keyin file name

Parsing Items Dialog box should appear

Make sure first option (Start a new column at each:) is selected and is set to read: semicolons

Character set will default to: Windows
Select QK

AN A A

First Row of spreadsheet will be the column titles

Select this row by moving cursor to button 1 at left of spreadsheet and click once on left button
of mouse.

Delete this row by going to Edit >> Cut or click once on right mouse button and select delete row
Select column A by clicking once on left mouse button. Then click once on Right mouse button
and Select Range Properties.

Under Basics Tab change Width to 14 (leave Range Properties Dialog box open)

Select column B change Width to 30

Select column C change Width to 12

Select column D change Width to 6 then select the second tab. Change horizontal alignment to
centered (middle icon)

Select column E. in the Range properties box select number tab (#). Change number category to
Number and Current Format to Fixed. Decimals should be set to two.

Select column F and click on Right Mouse Button. Select Delete Column

Select column G and click on Right Mouse Button. Select Delete Column

Now go back and review body of spreadsheet for column B. You will notice some of the text
overlaps into column C. This will be no problem unless there are entries for that particular row
in column C. If that is the case, you will have to do some abbreviation in the item description to
bring it within 30 character spaces (as in ASPHALT CONCRETE PAVEMENT changed to
ASPH. CONC. PAVT.) The spacing on column C allows for two F notes of maximum
character size, if more are needed they will have to be re-entered in column B.

Note: Column spacing in the preset table in the MicroStation file was set by ODOT’s committee
for Pay Quantities
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When all modifications are complete:

Go to File >> Save and save the lotus .123 file
Go to File >> Save As

Change Save as Type: to Text (TXT)

Enter filename and select OK. '

Exit Lotus123

Start MicroStation with the seed payquant.dgn sheet.

Go to File >> Save as and save sheet as pqrdwy.dgn

NOTE: Change directory path to project location as in \usr2\jobs\j0000104

Go to File >> Import >> Text

The text file will appear on the screen as a graphic group with the origin in the lower left corner.
As long as it is left as a graphic group it can be moved easily within the drawing file to fit it to
the preset table already built for it. Under Workgroup >> Preferences, Text has been preset for
Fixed Width Character Spacing. From the newfont.rsc file, Font 10 has already been selected
and the equivalent 120 leroy guide has been set for the text size. If the text does not file on the
table, when it is imported, check these areas to make sure the settings have not been changed.

N
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SECTION 3

TITLE SHEETS



3-1
Creating A Title Sheet

Copy a blank title sheet from the seed directory (2-1). It is suggested that levels 5 and 13 be

turned on and filled out first. These levels have squad information and the P.E. stamp. After they

are filled out, save a copy of the title sheet to be used for other projects. It will be necessary to
keep up with any changes made to the master title sheet.

Below is a list of what is on each level of the title sheet and where data is to be input:

Level 1: Title Sheet Borders-- In the Main Title Area (at the top center of the sheet) text edit the
following lines: STATE HIGHWAY, AID PROJECT, PLANS, U.S. HIGHWAY,
COUNTY, CONTROL SECTION NO., STATE JOB NO., and NBIS NO.

In the block at the lower right comer, text edit the ‘x’s next to: SWO, PROJECT
NO., and COUNTY.

Level 2: Survey Control Data-- If the 'Survey Control Data notes are to be used, the ‘Lambert
Projection Zone’ will have to be specified. Text Edit the Survey Control Data note.
(NORTH ZONE) or (SOUTH ZONE)

Level 3: Index Of Sheets-- The INDEX OF SHEETS header. Data for the index of sheets
should also be entered on this level.

Level 4: Traffic Design Data-- Replace the ‘x’s with data obtained from Planning Division.
Level 5: Squad Information Block-- Replace the ‘x’s with the squad information.

Level 6: Bridge Squad Information Block-- Replace the ‘x’s with the Bridge squad
information.

Level 7,8,9: Project Length Information-- Level 7 is for one project, 8 is for two, and 9 is for
three. Edit the ‘FT.” and ‘M1’ entries. Also edit EXCEPTIONS and EQUATIONS if
needed.

Level 10: Plan-In-Hand-- If the title sheet is for plan-in-hand turn this level on.

Level 11: Line String For Centering Text-- If text is missing in the main titles use this line
string to center the new text. The text justification should be top center.

Level 12: Traffic Squad Information-- Replace the ‘x’s with the squad information.
Level 13: P.E. Stamp-- If used, edit the DATE, OKLA. REG. NO., the ‘xxx’, and ‘#HHE.

Level 14: Bridge Data-- If needed, Edit the ‘x’s with data obtained from Bridge Division.
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Level 15: Layout Map-- Sec “How To Do A Layout Map” (page 3-3).
Level 32: North Arrow-- Move the north arrow if necessary.

Level 33: Location Map-- Moved to the desired location on the title sheet. The appropriate
county will need to be shaded.

Level 34: ODOT Seal-- Turn on this level if the ODOT Seal is to be displayed on the title sheet.
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LAYOUT MAPS FOR TITLE SHEETS

1. Get a paper copy of the map for the county needed.

2. Use the title sheet created in 3-1.

3. Copy the county map needed from rdypc28 D: /usr2/seed/county.

4. Using MicroStation, bring up the drawing of the county map.

5. Window Area around the area of the county map that is to be used for the layout map.

6. From the Menu Bar select View => Saved, then enter the name for the view.

7. Exit the county map drawing and bring up the title sheet.

8. From the Menu Bar select File => Reference.

9. In the Reference Files pop-up select Tools => Attach. Select the name of the county map.
10. In the next pop-up, select the name of the saved view. If a scale factor is needed: In the same
pop-up double click in the second box across from Scale (Master:Ref). Key-in .00025 for a
1"=4,000’ map or .000189394 for a 1"=5,280’ scale map. If it is a metric title sheet, use

0186407 scale factor. After the scale factor is keyed-in press enter.

11. A fence will now appear on the screen. Place the cursor on the title sheet for the center of the
map and click the data button. This attaches the county map to the title sheet as a reference.

12. Place a fence around the reference file. Select the copy command, with the Use Fence button
on, and data point in the view. Move the fence to the desired position and data point again.

This makes a copy of the map in the title sheet drawing.

13. In the Reference Files pop-up highlight the county map name. Select Tools => Detach and
in the warning box select OK. This detaches the reference file from the title sheet.

14. Using the paper copy as a guide, add the necessary text, symbols, etc. needed to finish the
map.

There are cells in 1.cel for various symbols used on the county maps.

N
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MicroStation Tips

1. TOOL SETTINGS - This allows the user to access the various options in every command
without having to "tear-off" the palette. It also allows the user access to locks associated
with the active command. The Tool Settings pop-up is accessed from the
Menu Bar => TOOLS => TOOL SETTINGS.

2. PRECISION INPUTS - There are several key-in commands that allow the user to put
elements in exact locations. The following are the most used:

di=distance, angle - Measured from the last data or tentative point given. The angle is
measured irrespective of view rotation (0 is always to the right, 90 is always up, etc.)

dx=x, y,(z) - Measured along the view axis from the last data or tentative point. Because the
distances are measured along the view axis x will always be the left/right axis, y will
always be the up/down axis, and z will always be the in/out axis.

dl=x, y,(z) - Measured along the x and y (and z) axis from the last data or tentative point.
Because the distances are measured along the axis, the result will look different in views
that are rotated differently.

Xy=X, ¥,(z) - Measured along the x and y (and z) axis from the Global Origin.

so=station, offset - INROADS ONLY - This key-in identifies a point perpendicular to the
active alignment at the given offset distance. A negative offset distance is left of the
alignment, a positive offset distance is right of the alignment.

se=station, elevation - INROADS ONLY - This key-in identifies a point in a profile by the
station and elevation. The station and elevation specified must be within the limits of the
profile window as displayed. If this command does not work, snap to an element within
the profile (like a grid line) then use the key-in.

NOTE: The "so=" and the "se=" command only work when InRoads is loaded along with the
.alg file. If there is no active alignment the commands have no point of reference.

NOTE: MicroStation control does not default back to the Key-in Window after a command is
picked. If a precision key-in is to be used, press the escape key before typing the key-in.

| y
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3. DISPLAY DEPTH - Sets the range in which elements are visible along the “z” axis For
example, if the display depth is set to 500,-500 elements that have an elevation greater
than 500 or less than -500 would not show up in the view. If an element starts within the
display range and ends outside the display range, only the part within the range is visible.
If elements are missing or only half there, it is possible that the display depth is set
incorrectly. To re-set the display depth, in the MicroStation Command Window key-in:
dp=100000,-100000

4. FIXRANGE.MA - Used if a drawing file has elements that show up on a print but not on the
screen. To access the FIXRANGE.MA enter the drawing file. In the MicroStation
Menu Bar, select Utilities => MDL Applications. From the MDL pop-up, select
FIXRANGE.MA from the Available Applications portion. Click the load button. The
application runs automatically and a prompt in the Status Bar will signal the end of the
operation. After the application has finished close the menu.

5. OTHER DOTS THAT DON’T BELONG - In some drawing files dots have appeared on
prints but not on the screen. These may be text or cells placed at a zero size or scale. The
only way to find out is to use the print to find the location of the dot in the design file. To
find out what it is, snap with a tentative button around the area until it grabs something.
The Status Bar will identify the element type. If it is to be deleted, use a fence but be
careful not to delete items that are needed.

6. DELETE PATTERN - This is now in the pattern palette on the Main menu. To un-pattern a
line, select the delete pattern command then, select the line to be un-patterned and accept.
If the lines disappear, turn the pattern display off. If the lines disappear with the pattern
display turned off, the lines will have to be redrawn. :

More MicroStation Tips and Tidbits:

This is a collection of Tips and Tidbits that have been proven effective by many MicroStation
users who attended the 1997 International IGUG. Although these tips are general in nature,
please thoroughly test them before using them at you organization in a production type
environment.

1. Change update sequence of overlapping elements:
* Use selection tool to select elements
* Key in Wset add
* Key in Wset drop
* Elements are now re-ordered in update sequence.
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. Copying elements to different level:
* Select Copy command
* Select element
*Key in desired level (example: lv=3)
* Place data point or key in for new location (DX= or other precision command)
* Works with Move command as well.

. Multiple scales in one drawing:
* Create Saved Views and attach as reference files within the drawing border rather than
stretching the border around the file.

Eliminate the need for a specific user workstation/PC:
* Use the delivered .cfg/.upf files to run core ustation files off the file server and keep the
- user configurations in the network home directory so that any location a user logs
on, they have the same profile and tools.

. To limit certain Dr. Watson error:
* Turn OFF the full drag command under the desktop in Windows.

To make an element display/print on top of other ones (equivalent to “Bring to top”):
* Group the elements designated to be on top with any other elements
* Drop group on the elements
* Refresh view.

Place a note using the Place Note command with a straight line:
* Use Add Vertex command to put leader in.

Checking for file corruption:

* Use the following at the beginning of each script:
edg [filename]
set sea/all
VW
top
exit

* If you log this to an output you can print a view of any occurrences of corrupt elements
before final archival of storage. '

* Wait to insure you have a backup.

N
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9. To set global origin so that the design plane center readout is 0,0,0:
* Key g0=0,0,0 '
* Key xy=0,0,0 | uor
* This instructs MicroStation to find the center of the design place as the reference
monument point.
* To check use the place line command by keying xy=0,0,0 | uor and you will see the line
start at the design plane center regardless of cur GO or WU settings.

10. Do not wait for the file to completely update:
* Reset when entering a large file to stop the update.
* You then can use any windowing command to begin work in the specific area you need.

11. Can’t access a piece of text without a fence:
* MDL load fixrange
or

* Place a fence around the entire drawing and rotate fence by AA=0, this will correct the
range on all elements in the file.

12. Merging files:
* Keyin mdi load merge
* Merge [filename]
* Need to make sure and enter the complete path of target file
* You may get an error message saying “Reference file not attached”, if so ignore it.

13. The @ command is useful for running script files for commands commonly used on

multiple files. From the command line you use @ and the path to the script, .scr,
file.

14. Offset snap:
* Snap to element but do not accept with a data point
* Type in distance of offset: example: dl=1:1

* This will offset the point by 1:1 from the snap point.
Or

* With AccuDraw keyin O

15. Use the MicroStation knowledge base at http://smart.intergraph.com



4-5

16. ?? Get rid of zoom/fit which are now on the window border while using a digitizer or
function keys:
* Key in set tpm locate
* Set tpm delta
* Ref locate toggle
* Lock Toggle??7?

17. Rotate a tag:
* Draw a line using two points
* Attach a tag to this line
* Select rotate 2 points and then you can rotate the tag dynamically
* Press accept if the tag is about 90 degrees and the tag will pop up at a different location
than the dynamics displayed.
* The only solution is to contact Bentley for an MDL applet that if loaded corrects the

problem. Currently they say rotate tag works as designed so general delivery has
not occurred.

18. Working with point cells in rotated views is a problem in that they are not view dependent:
* When placing arrowheads on leader lines, it is easier to use the place note command to
place the leader. Before doing this get into the eiement dimensions terminator
symbols. Change the toggle from default to cell and key in the appropriate name
of the arrow head cell. You will now be able to easily modify you leader locations
without having to place new line terminators.

19. If you have many lines of text such as a quantity table, it is more efficient to set the tables up
in Excel to look the way you cut sheet does in MicroStation. Once the Excel table is
completed, copy/paste each column one at a time into the clop board and then the
corresponding column in the MicroStation table. This does two things:

* You will end up with an intelligent sheet and you have eliminated any possible errors
between you spreadsheet and the MicroStation quantity sheet
* You have all you quantities in Excel so computing is easy.

20. To change cursor colors:
* Key in mdl load hilite
* This brings up a palette that allows you to change the cursor colors if you are using a
full screen cursor.

|
M
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24.

25.

28.

29.

30.

31.

32.

46

The following UCM speeds up display operations. It turns on or off hte updating of views
(toggle). Works well when attaching multiple reference files:
* SET OUTFLG = OUTFLG"16
* SET RO=OUTFLG & 16
* SET CO="on’
* TST RO EQ 0,END
* SET CO="off"*
* END: SET MSG="STDISPLAY="+C0
* MSG MSG
* END

Disks filling up on the exit command to insure all deleted elements are removed.
* Add the compress command into the exit command to insure all deleted elements are
removed.

. Configure/Customize you icons/palettes at Startup and screen menu - Ex.

MicroStationll/RAS B - bring them forward to save time for every start-up.
* Put application shortcuts on the desk top to speed entry.

Key in: ref locate on all/off all to turn on or off locate option for all reference files at once.
Key in: set hilite [color] to change you hilite color.
To keep operator’s workspaces autonomous:

* Set the _USTN_USERNAME variables to use the operator’s last name and also name
the workspace the same. This auto loads their particular workspace, overriding
whatever the default workspace setting is.

With a tentative snap any operation will be performed once a data point is given. .
Place reference file commands “ref dis on all” and “ref dis off all” and “ref lock off (or on)”
and “ref snap off (or on)” on function keys. Keep these function keys together. Example -

F1 =on, ALT F1 = off.

Develop a macro in exit.ucm that resets level displays, attaches correct color table, detaches
reference files, etc... to company defaults.

Develop a macro for different sizes and types of paper plots and place these macros on a
tools button.
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USEFUL MICROSTATION COMMANDS

MERGE
Enter the MicroStation Manager window
Click File => Merge
Under Files To Merge: Click Select and change to the directory location of the file(s) to
be merged.
Select the file(s) to be merged into a specific file one at a time clicking Add after each
file selection. \
Click Done when finished making selections.
Under Merge Into: Click Select and change to the directory location of the file the others
will be merged into.
Select the file and click OK
Click Merge. 4
Enter the drawing file. The merged files will still be in original form. After the merge the
originals may be deleted.

FILE FENCE

The file fence command is used to take all or part of a drawing out to another blank
drawing file.

In the original file place a fence around the portion to be copied then, in the Key-in
window key-in: ff = newname.dgn

Do Not overwrite an existing file. Always file fence into a blank drawing file. This
process can be used to move data from a corrupt drawing file to a new drawing file and
may eliminate possible problems.

e
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CUSTOM LINE STYLES
Custom line styles are found in the Change Element Attributes button on the MAIN palette, or
in the element button under Line Styles on the MicroStation Command Window.

Change Element attributes-
In the pop-up, on the left side, chck on the box next to Style => Custom. The Select
Line Style pop-up appears. Click on the line style name to be used, then click on OK.
Any elements drawn from this point will use the custom line selected.

Element => Line Style
In the MicroStation Command Window, select Element => Line Styles => Custom.
The Line Styles pop-up appears. Click on the line style name to be used.

Setting The Scale Factor-
Click the Show Details button. This pop-up expands to show an example of the line style
and other entries. Using the Scale Factor click on the box to the left then, double click in
the box to the right and Key-in the desired scale factor.

Notes On Using Custom Line Styles-
When drawing a line using a custom line style if drawn from left to right, the style will
be right side up. If drawn from right to left, it will be upside down. This is irregardless of
view rotation. This also holds true for continuous line strings. The part of a line string
drawn from left to right will be right side up and the part drawn from right to left will be
upside down. If a line is drawn upside down use the change element direction (cha dir)
keyin to correct it.

Linestyles: roadway.rsc Path: bentley > workspace > wsmod > system > symb

LINESTYLE SCALE FACTORS
ENGLISH METRIC
100 Scale | 1.00 | 1000 Scale | 0.25

50 Scale | 0.50 | 500 Scale | 0.125

20 Scale | 0.20 | 250 Scale | 0.625




KEY IN PALETTE OPTIONS

There are two options with MicroStation that allow key-in commands.
1. Command Window - this works the same as past versions of MicroStation.

2. Status Bar - When using this option, prompts that would normally appear in the MicroStation
command window are now displayed at the bottom of the screen. This window can be
docked allowing for more space in the design window for viewing the drawing file.

3. Utilities > Key-ins - Should be used in conjunction with the Status Bar option for key-ins.
When expanded it can be used to find various default key-in commands. The key-in bar
can be docked (drag to the side, top or bottom of the window).

4. Tools > Tools Settings -

Tools > Primary - Level
Weight
Color
Line Styles
Information
Accudraw

Tools > Standard - New File
Open File
Save Design
Print
Cut
Copy
Paste
Undo
Redo
Help

N’
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LOCKS & ATTRIBUTES

Settings => View Attributes => Constructions =>On
Dimensions => 0On
Dynamics => On (for drag & rubberbanding)
Fill => On (turn on when plotting)
Line Styles => On
Line Weights => On
Patterns => On
Text => On
Settings => Locks => Full => Boresite => On (if you can’t select anything)
Snap => Keypoint => On (if you can’t snap accurately)
Divisor => 1 (This will divide a line as many times as

you choose, 2 will allow you to snap
to the center of any line)
Depth Lock => On



ALTERNATE KEY-INS
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AA = set active angle

AC = set active cell; place absolute
AP = set active pattern cell

AR = set active cell; place relative
AS = set active scale factors

AZ = set active depth

CC = create cell

CD = delete cell from cell library
CM = place active cell matrix

CO = set active color

DA = set active displayable attribute type
DD = set display depth (relative)

DF = open fonts settings box

DI = data point-distance, direction
DL = data point-delta coordinates
DP = set display depth

DS = specify fence filter

DV =delete saved view

DX = Data point-delta view coordinates
DZ = set active depth (relative)

FT = set active font

GO = global origin

KY = set snap divisor

LC = set active line style

LD = set dimension level

LL = set active text line length

LS = set active text node line spacing
LT = set active terminator

LV = set active level

OF = set level display off

ON = set level display on

PA = set active pattern angle

PD = set active pattern delta (distance)
PS = set active pattern scale

PT = set active point

RC = open cell library

RD = open design file

RF = attach reference file

RS = name report table

RV =rotate view (relative)

SV = save view

TB = set tab spacing for importing text
TH = set active text height

TI = set copy and increment value

TS = set active terminator scale

TW = set active text width

TX = set active text size (height/width)
VI = attach named view

WT = set active line weight

XS = set active X scale

XY = data point-absolute coordinates
YS = set active Y scale

ZS = set active Z scale

act ang pt2 = set active angle by two points

cha dir = change element direction

\\'/
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PATTERNS
(Located in 1.cel) v
PATI PAT2 PAT3 PAT4 PATS
==L 7 IMME ==
=T // JME  |EE | =
N IR E—
PAT6 PATT PATS8 PAT9 PATI10
Ground X-Hatch Short Dash Offset Short Dot
X-Hatch Line
7= A e 5 S T It O e
L7 13533 SO 1 RO S 6
PATI14 PAT17 PATI8 PAT19 PAT20
Triangle Pattern | X-Hatch Pattern Rip Rap
PAT21 PAT25 PAT27 PAT29 PAT32
Single Weave Brick X-Hatch Wavy Long Dash
Line X-Hatch
AANSNAN byt ,
s i (
PIUIIINY i »
PAISIN i (

Patterns, in MicroStation, will have a smoother look.

CELL SCALE FACTORS
ENGLISH METRIC
100 Scale 1.00 | 1000 Scale 0.8333
50 Scale 0.50 | 500 Scale 0.4167
20 Scale 0.20 | 250 Scale 0.2089




ROADWAY LINE STYLES ’ 5-16

PAVEMENT
candg —_——eeeeee———————— | cur'b and gutter o
curb = semmmmmmm—m e m— - —— curb
exasph existing asphalr rd.
exconc existing concrete rd.
excugr eSS sSSsSsSSssss=sSES exist. curb & gutter
exgrdr exist. gravel drive
exgrdrl B B e B e e B e B e B e B e B e B - ‘exisfing guard ratl
ncurb new curb
ngrdr | A—fo-a 0.0o 2 o2 oo o 4—a new guard rail
sidewk - . sideWoIK
trail trail \}
DRAINAGE

T,
dam T TR | Gam
ditchflow B - > flow of ditch
dradiv ' D D- |drainage divide line
drainl e e drainage arrow
draind eeeTT—E —mree— > — exist. drainage arrow
draind e drcfncge arrow

T T T Y,
eagrdam T | ear th dam
exbank A A A existing bank
prbank A A A proposed bank )
swamp e et swamp
terrac Saaas SIS terrace




ROADWAY LINE STYLES

DRAINAGE CONTINUED

toebnk toe of bank
tphibk R L R L L AR R LN R LN R top high bank
Tplobk TR TAN TSN TR AR TARTIR TR TR T TR TN TN TR TIN T Top low bank
wir —_— - - - ---— |water edge

IMPROVEMENTS
fence % X % existing fence
hedgerow hedge row
tTmbrin timber |ine

UTILITIES

gaslin 6 gas line
nsnsew SS new sanitary sewer
oiline 0 oil line
powlin —Hy power |ine overhead
puglin PUG power underground
sansew me—mme=e= == ———==- sanitary sewer line
Telline T telephone |ine
tuglin TUG +e | ephone underground
tvug TVUG cable line
urbexsansew — 3 urban exist san sewer
urbsansew Ss urban snaitary sewer
watlin W water |ine




ROADWAY LINE STYLES

5+
RAIL ROAD ff
rail rogd =m I Sl rail road »-j
railway frailway
RIGHT OF WAY .
copbdy LLLLLLLLLLLLLLLLLLLLL AL PP LL L ILL LY coorporate boundry
coulin ——— 1 —— county Iine
présrw — present r/w
prolin -- property line
gseclin - '/4 section line
rwlf v r/w fence
rwlfa 7 — |r/w access )
rwlinf 7 v 7 r/w fence/access
seclin -= section line
stseln /ie section line
xrwla 4 . r/w access symbol
xrwinfa V//4 v V//4 r/w fence/access symb
xrwlf v r/w fence symbol
MISCELLANEOUS
cl center line
jg*]”* longitudinal joint
togrjt @ @————_———-— e tongue & groove jo\/>

~—




5-19

7 ~

O~NMITNW MO

PEN WIEGHT

[y

L

APPROVED PEN TABLES:
LEROYH
COLPEN. TBL
XPEN. TBL

LAZER PRINTERS
THERMAL PLOTTERS

| mrmnqzomd>q.nAvr0qdmm“ﬁr>zz_zo DIV.)

TN



SECTION 6

PLOTTING
INFORMATION



N’

PLOTTING INFORMATION
BUILDING A PLOT QUEUE:
1. Open My Computer > Printers > Add Printer
2. Click Network Printer Server > Next

3. Double click on the desired printer > Finish

DELETING A PLOT QUEUE:
1. Single click on the plotter icon
2. Click the X on the menu bar

3. Accept

DELETING A PLOT:
1. Bring up the plotter window
2. Select YOUR plot
3. Click the X on the menu bar

4. Accept

6-1



PLOTTING METRIC PLAN and PROFILE SHEETS

Full Size Sheets- Select the Place Fence Block command. Snap to the lower right comer of the
sheet. Next, snap to the second comer from the left at the top.

Click File > Iplot Set:  units mm
rotation 90
1000 scale 1:1
500 scale 5:1

Half Size Sheets- Select the Place Fence Block command. Snap to the third corner from the
right on the bottom (under the sheet no.). Next, snap to the bottom end of the blue line near the
upper left corner (on level 3).

Click File > Iplot Set:  units mm
rotation 0
1000 scale 2:1
500 scale 1:1

PRINTING ENGLISH PLAN and PROFILE SHEETS

Full Size Sheets- Select the Place Fence Block command. Snap to the yellow (color 4) snap
lines in the upper left and lower right corners.

Click File > Iplot Set:  units in
rotation 90
scale 100 for pnp sheets
scale 1 for title, typical, and detail sheets

Half Size Sheets- Select the Place Fence Block command. Snap to the green (color 2) snap
lines in the upper left and lower right corners.

Click File > Iplot Set:  units in
rotation 0
scale 200 for pnp sheets
scale 2 for title, typical, and detail sheets

\\.,4/
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PLOTTING SET FILES

The .set files help to simplify plotting in MicroStation. One should be created for each plotter
used. The .set files will preset pen codes and color tables. This is an example of a .set file for the
rur_half plotter in Roadway Design:

File name is rur_half.set
DSDPSO04 is the plot server
The half.pen bw.tbl must reside in the directory MicroStation will point to.

queue=\\DSDPS04\rur_half
units=meter
pen_table=c:\usr2\flib\half.pen
color_table=c:\usr2\flib\bw.tbl

rotation=0.0
units=m

Activating the MicroStation .set files:

and p

1. Click Start > Programs > InterPlot Utility

2. Select InterPlot Client Configure

3. Click Configure

4. Select Common > Edit

5. Locate and edit IP_SETTINGS_PATH=c:\usr2\flib (or what ever drive

ath you use)

6. Click OK

7. Select MicroStation > Edit

8. Locate and edit IPLOT_OUTPAT_DIR=c:\usr2\scr
9. IPLOT_COLOR_TABLE_PATH=c:\usr2\flib

10. IPLOT_PEN_TABLE_PATH=c:\usr2\flib

11. Click OK

When MicroStation is started and iplot is selected, activate the plotter and the set
file should automatically connect to the file.
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PEN TABLE FILES WITH CHARACTER STRING

The .pen file test an element against a set of conditions and modifies the elements
appearance on the plotted output if it meets those conditions.

Characters

The characters keyword enables you to replace the string in a text element with a
new string. By putting text elements in your design file to act as place holders,
you can later substitute these strings with useful information such as the
workstation, date and time the file was plotted or design file name, pen table and
color table .

We want you to have the following in your drawing files. Lower left corner (in
staple margin), 90 degree angle, font =3

$$date$$
We need the following to be put in all the .pen files that are used for plotting:

ENDIF
if (characters .eq. *$$datestamp$$°) then
characters = “TRFPC36 “+ip_design +" "+long_time +
"+ip_pen_table+" "+ip_color_table
ENDIF

+short_date+"

Here is what your output should look like.

Sample:

TRFPC36 D:\usr2\JOBS\J0928304\pp07.dgn 9:16:34 AM 8/15/00 D:\usr2\leroyh.pen D:\usr2\bw.ctb

. o

N
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Survey Division CADD Standards

The following pages are to explain standards implemented by the Engineering Support Group.
First is the surveying and mapping contract requirements by the Survey Division. Next is an
overview for the technicians to understand the parameters such as weights, levels, colors, and the
all important break line file. Surface feature file (.sff) or (.dtm) is just two different terms
meaning the same thing. Also, included is a copy of the ‘consultant pack’. With the consultant
pack, the consultant will receive three floppies with all the standard seed files, and formats of cell
libraries, font libraries, etc. ’

[

10.

11.

OKLAHOMA DEPARTMENT OF TRANSPORTATION
CADD Support files and formats
seede.dgn - English design file 2d formats (seed file).
seedez.dgn - Engii;h design file 3d format (seed file).
seedm.dgn - Metric design file 2d format (seed file).
seedmz.dgn - Metric design file 3d format (seed file).
Istyle.rsc - Line style resource file. (MicroStation 5.0 and up).
newfont.rsc - Font library file (MicroStation 4.0 and under).
newfont.fld - Font resource file (MicroStation 5.0 and up).
sur4.cel - Cell library
surct.tbl - Color table.
* ucm - User command for MicroStation.

bw.tbl - Black and white color table for plotting only.
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AERIAL MAPPING SPECIFICATIONS

SPECIAL PROVISIONS

July 1, 1996

Alfalfa County. US 64 from Jct. SH 8 North to Cherokee.
SWO 3823(1) - J/P No. 12565(01) - Photography Contract 94-12-1

Camera - Zeiss Top 15 Focal Length - 152.730 mm Date of photography - 03/03/94
Negative scale of photography 1:2400

ITEMS FURNISHED BY ODOT
Location map for project.
Calibration report for aerial camera.
One set of photographs and film positives. (2 flt lines 1/1-44, 2/1-9, 53 photo)
Targeted photo control.
Vertical profile on pavement at approximately 30 meter intervals.
All seed and cell files necessary for this project.

Successful bidder will perform the photo triangulation adjustment and topographic mapping. All
photos will be utilized in the analytical adjustment. Only models 1/4-5 thru 43-44 and 3/2-3
thru 8-9 will be used in compilation. Mapping boundary limits - Width of mapping band will
be 100 meters left and right of centerline. At major cross roads, (such as section line roads), and
major streams, the width will be widened out to 155 meters with 100 meters each side of cross
roads and drains.

TIME OF COMPLETION
Project will be completed and delivered to the Chief of Surveys, Oklahoma Department
of Transportation, 200 N.E. 21* Street. Oklahoma City, OK. 73105, within 60 calendar
days of receipt of purchase order.

Failure to deliver project on schedule may be cause to preclude Contractor from future
projects.

PRODUCTS TO BE DELIVERED

1. All items furnished by ODOT

2. The following computer files in MicroStation v5.0 format on 8mm certified data
cartridge tapes.
a. Topo file (SW03823T.DGN)
b. Surface feature file (SWO3823X.SFF)
c. Contour file (SW03823C.DGN)

3. Hard copy print of Topo and contour files at 1:1000 scale.

4. Print out and 3.5" disk of all analytical adjustment files.

N
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AERIAL MAPPING SPECIFICATIONS

SPECIAL PROVISIONS
July 1, 1996

INTRODUCTION

The intent of the specification, special provisions and associated maps is to prescribe the
details for performance and completion of the work which the Consultant undertakes in
accordance with the terms of this Contract. Where the specifications and special
provisions describe portions of the work in general terms, bet not in complete detail, it is
understood that only the best general practice is to prevail and that only materials and
workmanship of the first quality are to be used. Unless otherwise specified, the
Consultant shall provide all labor, materials, tools, equipment, and incidentals, and do all
the work involved in executing the Contract.

The scope of work consists of providing photogrammetrically prepared engineering maps,
meeting National Map Accuracy Standards, to be delivered in Intergraph design file
(DGN) format on 8mm certified data tapes using CPIO.

The location and identification of the project will be shown on maps included as part of
the special provisions.

Unless otherwise specified in the special provisions the following items will be delivered.

a. A printout listing file names and file sizes will be included with each tape.
b. One set of prints of the map files plotted at the requested map scale.
DELIVERY SCHEDULE

Refer to special provisions for time of completion, material to be delivered, and address.
STEREO PLOTTERS

First order analytical stereo plotting instruments will be required for compilation of this
project. The type of analytical stereo plotters that will be used by the Consultant is to be
submitted to ODOT for approval before award of the Contract to the Consultant.
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5.0

5.1

GENERAL MAPPING REQUIREMENTS

The Consultant must have an Intergraph system in-house and linked directly to the
steroplotters to be used. All compilation must be compiled directly into the specified
Intergraph design file (DGN) format. Translation from other software can be substituted
if prior approval is received and demonstrated that they exactly replicate line weights, line
codes, line colors, symbols, levels, patterns, and etc.

The maps shall be compiled at the scale and contour interval specified in the special
provisions if different from specifications as listed in item 5.1.f.

The mapping limits, numbering, dimensions, and orientation of the final maps shall be as
shown on the title sheet.

Adjacent map files shall butt match exactly. Match lines shall be delineated and labeled.

Where the meaning of symbols is obscured by adjacent topography, the object shall be
labeled.

Where symbols shown do not properly depict a planimetric feature, the Consultant shall
select an appropriate symbol and iabel the feature.

Labels shall be oriented along linear features or parallel to the flight line of the stereo
model, so that the project beginning shall be at the left and project end shall be at the
right.

GUIDE LINES FOR DIGITAL PHOTOGRAMMETRIC STEREOCOMPILATION

In order that maps be compatible with ODOT’s Intergraph CADD system, the following
requirements must be met:

a. Maps produced on a CADD system by the Consultant shall conform to ODOT’s
current CADD standards. This includes line weights, lines codes, colors, symbols,
levels, patterns, and etc. ODOT will furnish cell libraries, seed and resource files
to be used in compilation to meet this criteria.

b. The data files provided by the Consultant shall be Intergraph vector files which
can be manipulated with Intergraph software. Taster image files and all other file
formats (such as DXF for SIF) are not acceptable.

c. Use of reference files or pen tables to achieve particular plotted effects is not
allowed, each file must stand on its own.

d. The following is a list of 3D files to be generated and delivered to ODOT.
1. SWO—T.DGN = topo file

N’
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2. SWO—X.SFF = surface feature file

3. SWO—C.DGN = contours file

Unless otherwise specified, the entire project will be delivered in the three files
listed above.

The name of the design file must appear in the lower left corner of the final
plotted map sheet.

Files shall be compiled with coordinate values to the nearest hundredth (1/100) of
a millimeter. Coordinate values for all features shall be based on the grid system
indicated by the control data. The working units for the design files shall be:
UNIT NAMES
MASTER UNITS M
SUB UNITS CM

RESOLUTION
100 CM PERM
40 POS UNITS PER CM

WORKING AREA

1073741 M SQUARE
GLOBAL ORIGIN
LOWER LEFT

3D = GO = 0.0000, 0.0000, 536870.9120
(OKDOT seed file) FOR METRIC

STANDARD CONTOUR INTERVAL = .25 METER

ONE METER INDEX CONTOURS

.25 METER INTERMEDIATE CONTOURS

THREE INTERMEDIATE CONTOURS BETWEEN INDEXES

OTHER FILES ASSOCIATED WITH THE DESIGN PROCESS

font library = SURFT1.FLB 3d seed file = SEEDZ.DGN

3D cell library = SUR4.CEL resource file = FONT.RSC

color table = =SURCT.TBL line style =LSTYLE.RSC
USER COMMANDS LIBRARY
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Guide lines for the collection of planimetric features.

The topo file (SWO—T.DGN) will consist of a 3D - DGN format. Topographic features
will be patterned as per ODOT specifications (Refer to sur4.cel, Istyle.rsc, or one of many
user commands furnished in the consultant packet provided). Text will conform to ODOT
font library (newfont.rsc). All roads will be patterned using ODOT patterning standards
(asphalt, concrete, and dirt & gravel). Any feature not in ODOT libraries, feel free to use
your custom feature, however the feature must be labeled. Most features are in the library
provided.

a.

All planimetric features which are visible or identifiable on, or interpretable from,
the aerial photography shall be shown. Particular attention shall be given to
include utility and drainage features, fences, walls, and other indications of
property lines or lines of occupation.

The map shall show all roads, railroads, bridges, canals, streams, dams, fence
lines, wells, power and telephone poles, and billboards which are visible on the
photographs. They shall also show boundaries of timber and brush areas, slide and
slip out areas, orchards, and any other improvements or distinguishing features
which are visible on the photographs. Free standing trees having a crown diameter
of 4.5 meters or more shall be shown.

All schools, parks, playgrounds, cemeteries, public buildings, hospitals, churches,
institutions, and similar places of public gatherings shall be shown and labeled.
Published information may be used as a source for this data and field inspection or
verification will not be required.

Drainage lines shall be shown in all well defined features with line strings using
line style ‘drain3' or user command ‘drain30'. All drains will be shown, including
roadside ditches, showing direction of flow whether water is present or not.

Roads, streets, and sidewalks shall be shown as the separation between curb faces,
hard surface edges, travel paths, or shoulder lines, as the case may be. Roadway
lane striping shall be shown with the appropriate line style.

The surface type of all roads, drainage ditches, parking areas, and other improved
areas, except for private residential features, shall be identified and labeled as to
type, i.e., asphalt, concrete, dirt, etc., as interpreted from the aerial photographs.

Features which are interpreted from the photography as being under construction
shall be labeled as such, and partly completed planimetric features in connection
therewith shall be shown by dashed lines.
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Guide lines for digital terrain modeling (DTM) procedures.

Surface feature file (SWO----X.SFF) will consist of a 3D - DGN format with graphic
elements. Break lines will be line string and broken out on levels 52, 53, and 54 (See
consultant packet surface features). Generally, two types of data points, breaklines and
regular points, are used to generate a DTM. The following is a brief explanation of the
data points and how they should be captured.

The data collected is to be shown on the following levels. (See Consultant packet)

Type of Feature
Surface feature text
Regular break lines
Border edge

Ridge lines

Drain lines

Spot elevations
Regular points
Progressive sampling
Obscure area
Sub-Surface points
Index contours

Index text
Intermediate contours
Center line

Label and title information

Level
50
52
52
53
54
56
55
55
57
58
59
59
61
49
10

Breaklines (See Consultant packet) (SWO----.SFF file is a 3D design file .DGN - having
graphic elements). There are 3 major break lines needed for surface collection.

1) Ridge lines = level 53 (All pavement features, and major ridge features).
' EXAMPLE: Roadway center line, edge of pavement, shoulders, top of bank, etc.

2) Regular Break lines = level 52 (Supplemental break lines to enhance ridge
features). EXAMPLE: Edge of dirt road, toe of bank or to help define a feature.

€)) Drain lines = level 54 (All drains, ravine, and depression areas).
EXAMPLE: Ditches, streams, streams without water, linking to obscure areas of
pooled water. But not to be confused with obscure areas. (See obscure areas level

57).

NOTE: NO TEXT CAN BE ON THESE LEVELS!
NO PATTERN LINES, ONLY LINE STRINGS!
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5.3.c

5.3d

Regular points (Level 55 or 56. See Consultant packet)

There are 3 major kinds of points needed for surface collection. All points to be placed
with active point (X, y, & z). Place a cell symbol (X) for each point.

¢} Regular points = level 55 (DTM points). Random points to indicate large area of
flat lands. To enhance a flat area not defined by break lines. (color RED)
(progressive sample points - aerial use only).

2) Spot points = level 56 (Elev. Points). Depression, saddle, and high points, where
you might want to show the actual elevation (like on a QUAD. Sheet). (color
GREEN).

3) Sub-surface points (under water etc.) = level 58. (These are added for under water
shots as needed from the field crew only. (color BLUE)

NOTE: NO TEXT CAN BE ON THESE LEVELS!

Obscure areas

Obscure areas = level 57. (Mostly used for closed water area, ponds, lake pooling of
water in streams etc. Or where you do not want contours going through). NOTE: Obscure
areas MUST be defined as a CLOSED SHAPE!

Contours
Major contours and text = level 59. (color RED)
Minor contours = level 61. (color WHITE)

NOTE: If a feature is to be represented as both a topo and a surface feature it must be
placed on the appropriate levels.

Regular points shall be recorded on a separate level and shall not be taken on breaklines.
Regular points are x, y, z data points which may be captured randomly throughout the
stereomodel, however, they are usually captured on a uniform grid. The grid spacings
vary with the photography scale and the ruggedness of the terrain. Generally, the grid
spacing should be one-tenth of the photography scale. The grid should be perpendicular to
the line of flight and extend beyond the model and/or mapping limits to facilitate merging
of the models.

N
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7—10
OKLAHOMA DEPARTMENT OF TRANSPORTATION
CADD Support files and formats
seede.dgn - English design file 2d format (seed file).
seedez.dgn - English design file 3d format (seed file).
seedm.dgn - Metric design file 2d format (seed file).
seedmz.dgn - Metric design file 3d format (seed file).
Istyle.rsc - Line style resource file. (MicroStation 5.0 and up).
newfont.fld - Font library (MicroStation 4.0 and under).
newfont.rsc - Font resource file (MicroStation 5.0 and up).
sur4.cel - Cell library.
surct.tbl - Color table.
* ucm - User command for MicroStation.

bw.tbl - Black and white color table for plotting only.



STATE OF OKLAHOMA
DEPARTMENT OF TRANSPORTATION
ENGINEERING SUPPORT GROUP
CHAIRMAN - MIKE MAUPIN
(405) 521-4241
ISSUED BY THE SURVEY DIVISION
5-11-95

DESIGN WORKING UNITS AND GLOBAL ORIGIN — (METRIC)
(2d or 3d files)

UNIT NAMES
MASTER UNITS M
SUB UNITS CM
RESOLUTION
100 CM PERM
40 POS UNITS PER CM
WORKING AREA
1073741 M SQUARE
GLOBAL ORIGIN
LOWER LEFT
seedm.dgn 2d = Go = 0.0000, 0.0000
seedz.dgn 3d = Go = 0.0000,0.0000,536870.9120
(OKDOT seed file) FOR METRIC

Maximum triangle size for INROADS = 85 meters.
(NOTE: This is only a suggestion or starting place)

Standard contour interval = .25 meter

1 meter index contours

.25 meter intermediate contours

-3 intermediate contours between indexes

Standard plotting size = 1000:1 is approx. size of 1" = 100'
Other files associated with the design process.

font library = surftl.flb --—--- 4.0 Only

cell library = sur4.cel

color table = surct.tbl

font.rsc ------------—-—- 5.0 MicroStation and above
linestyle library = Istyle.rsc

Note: Text size is in ration to compile to leroy size guides.
Note: To check the global origin, type in at a command line in graphic ---- go=$

7-11
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STATE OF OKLAHOMA
DEPARTMENT OF TRANSPORTATION
ENGINEERING SUPPORT GROUP
CHAIRMAN - MIKE MAUPIN
(405) 521-4241
ISSUED BY THE SURVEY DIVISION
5-11-95

DESIGN WORKING UNITS AND GLOBAL ORIGIN — (ENGLISH)
(2d or 3d files)

UNIT NAMES
MASTER UNITS FT
SUB UNITS TH
RESOLUTION
10 THPER FT
120 POS UNITS PER TH
WORKING AREA
3579139 FT SQUARE
GLOBAL ORIGIN
LOWER LEFT
sdiseedm.dgn or seede.dgn 2d = Go = 0.0000, 0.0000
sacseedz.dgn or seedez.dgn 3d = Go = 0.0000,0.0000,1789569.7067
(OKDOT seed.dgn files)

Maximum triangle size for INROADS = 250 feet.
(NOTE: This is only a suggestion or starting place)

Other files associated with the design process.

font library = surft1.flb ----- 4.0 Only

cell library = sur3.cel

color table = surct.tb]

font.rsc ----------——--- 5.0 MicroStation and above
linestyle library = Istyle.rsc

Note: Text size is in ration to compile to leroy size guides.
Note: To check the global origin, type in at a command line in graphic ---- go=$
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AERIAL MAPPING SPECIFICATIONS

SPECIAL PROVISIONS
July 1, 1996
In standardizing the department the following has been noted aé “The Standard”.

(AS OF 2-1-96)
SURFACE FEATURES

$$55$55555355 555558555 55555$$$SSBREAK LINESSS$$$$$5$5$5$$$5$5SSSS$5S355S

There are 3 major break lines needed for surface collection.

1. Reg. Break lines = level 52 (All breaks but pavement features).
EXAMPLE: Edge of dirt road, toe of bank or to help define something.

2. Ridge lines = level 53 (All pavement features, and major ridge features).
EXAMPLE: Down center line, edge of pavement, shoulders, top of bank, etc.

3. Drain lines = level 54 (All drains, ravine and dcpfession areas).
Example: Ditches, streams, streams without water, linking to obscure areas of pooled
water. But, not to be confused with obscure areas. (See obscure areas level 57).

+##%*NOTE: NO TEXT CAN BE ON THESE LEVELS!
NO PATTERN LINES, ONLY LINE STRINGS !#####

$5555355555 5B SSSFSSSSSSSFSSSSSPOINTSSSSSSFHSSSSS$FF$FHSS$$3$$$$$5555S
There are 3 major kinds of points needed for surface collection. All points to be placed with
active point (x,y, & z). Place a cell symbol (X) for each point.

1. Regular points = level 55 (DTM points). Random points to indicate large area of
flat lands. To enhance a flat area not defined by break lines. (color RED)
(progressive sample points - aerial use only).

2. Spot points = level 56 (Elev. Points). Depression, saddle, and high point, where
you might want to show the actual elev. (Like on a QUAD. Sheet) (color GREEN)
**x%*x*NOTE: Text for these spots must be on level 62.

3. Sub-surface points (under water etc.) = level 58 (These are added for under water
shots as needed from the field crew only. (color BLUE)
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**%%*%*¥NOTE: NO TEXT CAN BE ON THESE LEVELS!*#%%%%
$55$$555$$$5555855$58$$$$Obscure areas are a little different. $$$$$S$SSSSSSSSSSESESSS

Obscure areas = level 57 (Mostly used for closed water area, ponds, lake pooling or water in
streams etc. or where you do not want contours going through).

***x+4*NOTE: Obscure areas MUST be defined as a CLOSED SHAPE!
$SSSSEH$$$5555555555$$$$SSDRIFT REMOVALSSFSSSSSSSSEESSSFSSE$SSE$$55$S

Drift removals for BR-Projects will be put on level 62 with line strings for the drift only, single

points will still be on level 58 sub-surface points. Level 62 will also be used for niscellaneous
surface information as needed, but must be noted as t what it is. (color GREEN)

$$55S5$555555555558555555$5$$SSSSCONTOURSS$$$$S$SHSSSSESSS$$$$$$$$$55$58$
Major contours and text = level 59 (color RED)

Minor contours = level 61 (color white)

sk GEEEPPH* AKX GEEEEHHHHHRHGEEEGHHHHAAAGEEGHFHHHAXHGEEEESHAHHHAGEE GGG H 4k

NOTE: If you want a feature to be represented as a topo feature, fine, BUT, if it is to be
considered within the surface features it must be on its respected level above.
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COGO POINT ASSIGNMENTS
REV. 8
SURVEY DIVISION 12-16-96
8:30 AM.

ALIGNMENT POINTS ASSIGNMENTS
TOTAL POINTS
MISCELLANEOUS POINTS 1 THRU 2999 (USE FOR YOUR TESTING) 2999
AND CENTER LINE POINTS

Center line profile will be numbered 3000 thru 3999 and placed on level 50 with point number and elevation.
NOTE: This profile is for Aerial uses only, not to be used for design.
Profile points will be consistent numbering with a description, .
noting center line profile (clp) or similar abbreviation.

POINTS ON SPIRAL 4000 4999 999
CURVES ASSIGNMENTS
POINT CURVE # I.D.
PI. 10011 100 1 1
P.C. 10012 100 1 2
P.T. 10013 100 1 3 ™
C.C. 10014 100 1 4 )

(10,000 = CURVES INFORMATION)

MISCELLANEOUS POINTS L.D.
PRESENT R/'W 5000 THRU 5999 999
P.I. W/O CURVES 6000 THRU 6999 999
PHOTO CONTROL 7000 THRU 7999 999
PROPERTY CORNERS 8000 THRU 8999 999

L2 3

SECTION CORNERS 9000 THRU

1/4 CORNERS 600 Total points

¥ ¥ ¥ ¥ ¥

CENTER SECTION 9600

9700 TO 9999 ARE TO BE USED BY OTHER DIVISIONS TO DO WITH AS THEY WISH.
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MISCELLANEOUS
- NT COMMANDS
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MSDOS COMMAND PROMPT

SENDING MESSAGES TO ALL WORKSTATION:
This will send a message to anyone on the domain with an NT computer.

From the MSDOS command prompt, key in:
net send /domain:okladotnt (your message) <Enter>

PRINTING A DIRECTORY LIST:
To print a listing of a directory to print.

1. Change directories to the one to be printed.

2. From the MSDOS command prompt, key in: dir /s>filename
3. Using wordpad or the preferred editor, open the file.

4. Edit, print or modify the file then, print it.

PING:
To check for network connections.

From the MSDOS command prompt, key in: . ping rdypc28 (example)

Things to know:

1. If there is no response, one of the workstations is having network problems.

2. If there is a response from using ping to contact other computers then, it is probably the
other workstation.

3. Ping Notes9a to see if there is a response from Lotus Notes.

4. If a specific address is known and can not be hit by name, try the address.

5. After determining which workstation is not communicating, first, check the network plug
to see that it is plugged in completely then, try a reboot or a complete shut
down/power off.. If this does not work, it may be necessary to contact the Information
Services Help Desk.
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NT TIPS AND HINTS

Ctrl + Alt + Delete:
Holding all three of these keys down at the same time while logged into NT will bring up the
Window NT Security box. There are six options:

Lock Workstation - The user and the administrator are the only ones who can
unlock the workstation. If you are in a file, lock your workstation, and the
administrator has to unlock it, your work may be corrupted or destroyed.

Logoff - This will log the user out of the workstation. This may also be done with
the Start button > Shut Down > click Close All Programs And Log On As
A Different User.

Shut Down - Will shut down the workstation so that it can be restarted or turned off.
This can also be done with the Start button > Shut Down window.

Change Password - If you are changing your password, make sure it gets changed
on the Domain or you will not be able to connect across the network.

Task Manager - This is used if a process is locked up or having problems.

There are three options: End Task - Stops a process
Switch To - Changes to another process
New Task - Select a process to start

RECYCLE BIN:
Anything that is deleted from Explore or off the desktop is sent to the Recycle Bin. Be sure
to empty this bin occasionally. If you have deleted something accidentally, look in the
Recycle Bin, if it is there, it can be un-deleted.

CREATING SHORT CUTS:
1. Find the .exe file that is to be put on the desktop under Explore.
2. Click on the name using the right mouse button.
3. Click on Create Shortcut.
4. Locate the shortcut in the directory and drag it to the desktop.
5. In some cases the shortcut will automatically go on the desktop (when using Start > Find
Files and Folders)
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LOTUS NOTES TIPS
1. When sending or forwarding mail, verify the names selected or keyed in. If a name is
keyed in, Lotus Notes will get the first one in either address book. Make sure you
know who you are sending the mail to.

2. Do not save junk mail. Either delete it or archive it. The mail is not resident on your
workstation and will use up space on the server.

The following are instructions provided by Information Services to create an
archive folder local to your workstation. This was printed from Employee News
on 10/1/98.

Open the Archiving view in you mail database above Agents and below Folders and Views.
Click on the Setup Archive Button.

Click on “Archive Documents” to place an “X” in the box, then fill in the number of days after
expiration that Notes should wait before archiving documents. For example, 5 days.

Click on “Archive documents which have no activity” to place an “X” in the box, then type in the
number to indicate how many days of inactivity are acceptable before Notes archives a document.
For example, 30 days.

Click on the Specific Archive Location button.

In the “Documents are archived field” choose Locally. DO NOT CHOOSE SERVER. Any
archived databases found on the Notes server will be deleted immediately without any warning.

Please leave the archive database name as the default. By default, the archive database name begins
with the character A_ followed by the first six letters of the name of your mail database. For
example, if you mail database if named PWHATLEY.NSF, the archive database if named
A_PWHATL.NSF.

Click on OK.

Click on the Save Profile button.

Click on the Close button.

Click on the Archive Now button.

Are you sure....click on Yes.

Since this is the first time it may take several minutes....click on Yes.

"
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After the archive has finished, press the ESC key to get to the Workspace desktop of Lotus Notes.
The following instruction will add the Archive Database Icon to your desktop:
click on the work File at the to of the screen.
Click on the word Database and then click on the work Open.
Make sure the server is Local.

Under Filename, type the archive database name (Ex. MAILNA. PWHATL.NSF) and click on Add
icon.

Click on done.

The next step is compacting your database, the following instructions will allow you to compact your
database:

right click on the icon where you read you mail (Example: Pam Whatley or Pan Whatley on Notes9a)
choose Database Properties.

Click on the Information tab (a white “i” with a blue circle around it) to move to the second page of
the properties dialog box.

Click on the Compact button.

Click on OK.

Notes compacts the workspace. It may take up to several minutes to compact the workspace
depending on the size of the database that is being compacted.

It would be best to email Jason Nichols or Pam Whatley rather than call the Help Desk on this matter
because of the quantity of users.

The next instructions are to activate Employee News:
After Lotus Notes has been loaded and the initial start up has been done, open your Lotus Notes.

1. Click on the word File at the top of the screen.

2. Click on Database and then the word Open.

3. Under Server change to Notes9a/ODOT and then click on the word Open.

4. Under Filename type the following mail\enews.nsf and then click on Add Icon.
5. Click on Done.

6. Double click on the Employee News on Notes9a icon.
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You will not be able to delete any of this mail as it resides on the server.
E-mail Attachments:

E-mail attachments, like any other mail, resides on the server. If it is to be kept, it should be
detached, otherwise it can be deleted like any other mail.

To Detach E-mail:
Double click on the attachment icon.
Click DETACH from the popup window.
Move the directory the attachment is to be placed.
Click DETACH.
Exit popup window.
Close mail.

To Hit Netscape From E-mail:

Click File > Mobile > Edit Current Location

Change Internet Browser to read Netscape Navigator

After this is done, an internet address that is sent through e-mail can be hit by double clicking
on the address in the e-mail.

~—
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- LEVEL,
WEIGHT, and

'COLOR GUIDE



SHEET LAYOUT
SHEET LAYOUT FONT CELLS LINE STYLES LINE LEVEL | COLOR | WEIGHT
CODES

Text 10 37 0 1
Detail Sheet DETSHT 35 0 1
Joint Layout Legend LEGEND 35 0 1
Lines 36 0 1
Plan Sheet Window' SHTBLK 36 0 1
Metric Plan Sheet Window METSHT 36 0 1
Revision Block CBLOK 35 0 1
Cross Section Axis 0 61 1 1
Cross Section Major Grid 0 60 1 0
Cross Section Minor Grid 0 59 1 0
Text - Cross Section 10 61

Profile (Existing Ground) 50 0 0
Profile (Finish Grade) 49 4 4
Station and Elevation Profile 10 50 4 0
Finish Grade Elevation (Profile) 10 49 4 0

\_
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PATTERNS
AREA PATTERNS FONT | CELLS LINE STYLES LINE | LEVEL [ COLOR | WEIGHT
CODES

Pattern 1 (Ground Pattern) PAT1 45 25 0
Pattern 2 (Single X-Hatch) PAT2 45 25 0
Pattern 3 PAT3 45 25 0
Pattern 4 (Lg. Ground Pattern) PAT4 45 25 0
Pattern 5 (Square Pattern) PATS 45 25 0
Pattern 6 (Slanted Ground) PAT6 45 25 0
Pattern 7 (‘X’ X-Hatch Pattern) PAT7 45 25 0
Pattern 8 (Short Dash X-Hatch) PAT8 45 25 0
Pattern 9 (Offset Dash X-Hatch) | PATY 45 25 0
Pattern 10 (Dot Pattern) PATI10 45 25 0
Pattern 14 (Triangle Pattern) PAT14 45 25 0
Pattern 17 (Cross Hatch) PAT17 45 25 0
Pattern 18 (Rip Rap) PAT18 45 25 0
Pattern 19 (Concrete Area) PAT19 45 25 0
Pattern 20 (Asphalt or Sand) PAT20 45 25 0
Pattern 21 (Single Weave) PAT21 45 25 0
Pattern 25 (Brick) PAT25 45 25 0
Pattern 27 (Wavy X-Hatch) PAT27 45 25 0
Pattern 29 (Lg. Dash X-Hatch) PAT29 45 25 0
Pattern 31 PAT31 45 25 0
Pattern 32 PAT32




RIGHT-OF-WAY PLANS

9-3

WEIGHT '

MISCELLANEOUS FONT CELLS LINE STYLES LINE | LEVEL | COLOR
: CODES
Arrow - Double RWDBLA 41 3 1
Box Around Number (1) BAN 1 25 5 1
Box Around Number (2) BAN 2 25 5 1
Property Line Symbol PLT 41 5 1
R/W Marker DOT 40 1 1
R/W Note Leader 40 0 1
Text CHANNEL R/W CHRWT 26 4 1
Text PRES. R/'W & PROP LINE PRWPLT 41 5 1
Text PRES. R'W PRWT 41 3 1
Text PROP LINE (P/L) PROPL 41 9 1
Text R'W ROFWT 26 3 1
Text SEC LINE SCLT 41 5 1
Text SEC & PROP LINE SPLT 41 5 1
Text TEMP R/W (CHANNEL) TMPCHT 41 5 1
Text TEMP R/W (CONST) TMPCOT 41 5 1
Text TEMP R/W (DETOUR) TMPDT 41 5 1
Text TEMP R/W (DRIVE) TMPDRT 41 5 1
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SURVEY
MISCELLANEOUS FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR ‘| WEIGHT
CODES

Miscellaneous Text 10 25 0
Land Tie & Geometric Data Sht 35 25 0
Bearing, Distance & Angles 35 25 0
Profile 50 25 0
Major Contours & the Text 59 25 0
Minor Contours & the Text 61 25 0
Ravines & X-Sections & Text 60 25 0
Drift Removai Information 62 25 0
Surface Features Only No Text

Brass Cap BC 1 0 0
Target TAR 1 0 0
Windmill WILMIL 1 0 0
Satellite Dish SDISH 1 0 0
Oil Well - Capped owcC 1 0 0
Monitoring Well MONW 1 0 0
Gauging Station GAUGS 1 0 0
1.D. Check Flag IDF 1 0 0,40
Possible Private Dump PPD 1 0 0,2
Landfill - Active LANFA 1 0 0,2
Landfill - Closed LANFC 1 0 0
Underground Storage Tank UNDST 1 0 0
Radioactive RAN 1 0 0
Biological Hazard BIO 1 0 0
Hazardous Waste Site HWS 1 0 0
Possible Contamination Site PCS 1 0 0
Wetlands WETL 1 0 0
Endangered Species ENDSPE 1 0 0
Historical Site HISTS 1 0 0,4
Indian Buriat Site INDBS 1 0 0,4
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EXISTING TOPO
PAVEMENT FONT CELLS LINE STYLES LINE LEVEL | COLOR | WEIGHT |
CODES
Text 23 12 0 0
Asphalt EXASPH 11 0 0
Bridge EXCONC 11 0 0
Curb CURB 11 0 0
Curb & Gutter EXCUGR 11 0 0
Dirt & Gravel Road EXGRDR 11 0 0
Guard Rail EXGRDRL 11 0 0
Concrete Road EXCONC 11 0 0
Sidewalk SIDEWK 9 0 0
Trail TRAIL 11 0 0

Y
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EXISTING TOPO
DRAINAGE FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR | WEIGHT
CODES
Text 23 16 22 0
Bridge Box EXCONC 15 22 0
CICI EXCONC 15 22 0
Culvert EXCONC 15 22 0
Dam DAM 13 22 0
Dikes/Berms EARDAM 13 22 0
Direction of Flow/Slope FLODIR 13 1 0
Drain 90 Foot (3 & 4) DRAIN3 14 1 0
Drainage Divide Line DRADIV 13 1 0
Drop Inlet EXCONC 15 22 0
Field Terrace TERRACE 14 22 0
Grates EXCONC 15 22 0
Paved Ditches EXCONC 15 22 0
Retention Ponds WTR 13 1 0
Rip Rap PATI18 13 1 0
Structures EXCONC 15 22 0
Swamp SWAMP 14 1 0
Toe of Bank TOEBNK 13 22 0
Top of Bank TPHIBK 13 22 0
Water Edge WIR 13 1 0
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EXISTING TOPO
IMPROVEMENTS FONT CELLS LINE STYLES LINE LEVEL | COLOR | WEIGHT
CODES

Text 23 18 4 0
Billboards 17 4 0
Buildings 17 4 2
Cattle Guard CATGRD 17 4 0
Fence FENCE 17 4 0
Hedge Row HEDGEROW 17 2 0
Mail Box MALBOX 17 4 0
Qil Well Derrick OowD 17 4 0
Shrub or Small Tree SHRUB 17 2 0
Slab EXCONC 17 4 0
Solid Line 2 17 1
Tanks 17 4 0
Timber TMBRLN 17 2 1
Tree TREE 17 2

"
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EXISTING TOPO
UTILITIES FONT | CELLS LINE STYLE LINE | LEVEL | COLOR | WEIGHT
‘ CODE

Text 23 26 5 0
Fire Hydrant FH 8 1 0
Gas Line GASLIN 19 4 0
Gas Meter GASMTR 19 4 0
Gas Valve GASVAL 19 4 0
Light Pole (Double) DBLP 22 3 0
Light Pole (Single) LP 22 3 0
Manhole MHEXST 24 5 0
Manhole Sanitary Sewer EXMHSS 24 2 0
Oil Line OILINE 19 4 0
Pipeline (Above Ground) 19 5 0
Power Cable Riser Box POWRIS 23 3 0
Power Pole POWPOL 23 3 0
Power Line (Underground) PUGLIN 23 3 0
Power Line (Overhead) POWLIN 23 3 0
Sanitary Sewer Line SANSEW 24 2 0
T.V. Underground TVUG 23 3

Telephone Pole TELPOL 25 6 0
Telephone Line Underground TUGLIN 25 6 0
Telephone Line TELLINE 25 6 0
Telephone Cable Riser Box TELRIS 25 6 0
Telephone Power Pole TELPOL 25 6 0
Transmission Tower PL 22 3 0
Water Line WATLIN 8 1 0
Water Meter WIRMTR 8 2 0
Water Valve WATVAL 8 1 0
Water Well (Drilled) DRLWEL 21 0 0
Water Well (Hand Dug) DUGWEL 21 0 0
Sanitary Sewer Line (Alt.) URBEXSANSEW 24 2 0
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EXISTING TOPO
RAILROADS FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR | WEIGHT
CODES
Text 23 28 9 0
Railroad RAILROAD 27 9 0
Railroad 50' RAILWAY 27 9 0

U



EXISTING TOPO

5-10

SIGNING

FONT

CELLS

LINE STYLES

LINE
CODES

LEVEL

COLOR

WEIGHT

Text

23

Crossover

29

Sign

© 29




9-11

EXISTING TOPO
GEOMETRY FONT CELLS LINE STYLES LINE | LEVEL | COLOR | WEIGHT |
CODES
Text 10 34 4 1
Angle of Variance 33 4 0
C/L,PC, PT etc... POTSUR 49 0 0
C/L Curve Tangent 49 0 0
C/LPI SURVPIL 49 0 0
Centerline 49 5 5
Curve Data EXCURV 31 4 1
North Arrow One NOARRI1 32 5 0
North Arrow Two NOARR2 32 5 0
Reference Point in Tree REFTRE 33 4 0
Reference Point X in Concrete REFPNX 33 4 1
Reference Point REFPNT 32 4 0
Text SEC.-TWNSHIP-RANGE STR 32 5 3
C/L Survey Text CLSURV 34 4 1
,. C/L CRL Text CLCRL 34 4 1
C/L Profile Text CLPROF 34 4 1
COGO Points 4 2 0

N
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EXISTING TOPO
STORM DRAINAGE FONT CELLS LINE STYLES LINE | LEVEL | COLOR | WEIGHT
DESIGN CODES
Storm Sewer Manhole MHEST 22 5 0
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EXISTING TOPO
RIGHT - OF - WAY FONT CELLS LINE STYLES LINE | LEVEL | COLOR | WEIGHT I
CODES

Text 23 41 0 1
City Limits CILI 51 0 1
Cooperate Boundary COPBDY 51 0 1
County Line COULIN 51 0 1-3
Property Line PROLIN 51 0 1
Proposed R/W Date Stamp PR

R/W Line PRESRW 39 1 2
R/W Line (Channel) PCR 39 1 2
R/W Line (Temporary) PRESRW 39 -1 2
R/W Line (with Access) XRWLA 39 1 2
R/W Line (with Fence) XRWLF 39 1 2
R/W Line (Fence & Access) XRWINFA 39 1 2
Section Line SECLIN 38 0 1
Section Line 1/4 QSECLIN 38 0 1
Section Line 1/16 STSELN 38 0 1

\\-//l
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NEW CONSTRUCTION
PAVEMENT FONT | CELLS | LINESTYLES | LINE | LEVEL | COLOR | WEIGHT
CODES
Text 10 44 4 1
Asphalt 43 4 1
Bridge 45 4 1
Curb NCURB 43 4 1
Curb & Gutter CANDG 43 4 0
Dirt & Gravel Road 43 4 1
Guard Rail NGRDRL 43 4 1
Concrete Road 43 4 1
Sidewalk 43 4 1
Trail 43 4 1
Construction Note Leader HLFARR 44 4 1
Detours 43 4 1
Dividing Strip i 43 4 1
Drive (Pvt. Type 1 Flared 5'R) TP1FD5 43 4 1
Drive (Pvt. Type 1 10'R) TP1D10 43 4 1
Drive (Comm. Type 2a 5'R) TP2ADS 43 4 1
Dirve (Comm. Type 2 15'R) TP2D15 43 4 1
Integral Curb NCURB 43 4 1
Longitudinal Joint 43 4 1
Median Openings 43 4 1
Note Leader 6 NOLEO6 43 4 1
Note Leader 9 NOLE09% 43 4 1
Ramp (WCR Type B 6" Curb) WCRB6 43 4 1
Ramp (WCR Type A 6" Curb) WCRA6 43 4 1
Ramp (Section Line) SLRP25 43 4 1
Ramp (Private) PVRPI15 43 4 1
Street Return STR25W 43 4 1
Tongue & Groove Joint 43 4 -3
Top of Cut/Toe of Slope 3 42 1 1
Walls 43 4 1
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NEW CONSTRUCTION
DRAINAGE FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR | WEIGHT, '
CODES

Text 10 46 4 1
Bridge Box 45 4 1
CICI 45 4 1
Culvert 45 4 1

Dam DAM 45 0 0
Dikes/Berms 45 0 1
Direction of Flow/Slope NFLODR 45 0 1
Drain 90 Foot (3 & 4) DRAIN4 45 0 1
Drop Inlet 45 4 1
Grates 45 4 1
Paved Ditches 45 0 3
Retention Ponds 45 0 1
Rip Rap PATI8 45 0 1
Special Ditches 3 45 | 0 1
Structures 45 4 1
Toe of Bank 3 45 0 1
Top of Bank 45 0 1
Ditch Direction of Flow DITCHFLOW 45 0 1

\J\

~
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NEW CONSTRUCTION
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IMPROVEMENTS FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR WEIGHT
CODES

Text 10 44 4 1

Cattle Guard CATGRD 42 4 1

Fence RWLINF 42 4 1

Fence Post FENPST 42 4 1

Mail Box NMLBOX 42 4 0
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NEW CONSTRUCTION
UTILITIES FONT | CELLS | LINESTYLES | LINE | LEVEL | COLOR | WEIGHT ' Y
CODES ’
Text 10 48 8 1
Manhole MANHOL 48 8 1
Manhole Sanitary Sewer 48 8 1
Sanitary Sewer Line NSNSEW 48 8 1
Sanitary Sewer Line (Alt.) URBSANSEW 48 8 1

\\ /
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NEW CONSTRUCTION
SIGNING FONT CELLS LINE STYLES LINE | LEVEL { COLOR | WEIGHT
CODES
Station Line CNTRIN 10 8 2
Pavement Marking PMARK 15 0 1




NEW CONSTRUCTION
GEOMETRY FONT CELLS LINE STYLES LINE LEVEL | COLOR | WEIGH.
. CODES

Text 10 47 4 1
Angle of Variance AOVAR 31 4 1
C/L, PC,PTetc... POTCON 31 4 1
C/L Curve Tangent TANGNT 31 4 1
C/LPI CONSPI 31 4 1
Centerline (CRL) 50 4 2
Curve Data NCURV 31 4

COGO Points 5 4 1
Bearing 10 35 25 0

JK_/
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NEW CONSTRUCTION
STORM DRAINAGE FONT CELLS LINE STYLES LINE | LEVEL | COLOR | WEIGHT
DESIGN ' CODES
Storm Sewer Manhole NMH 48 8 1
Storm Sewer 48 8 1
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NEW CONSTRUCTION
RIGHT - OF - WAY FONT | CELLS LINE STYLES | LINE | LEVEL | COLOR | WEIGHT,
CODES
Text 10 4] 3 1
R/W Line 40 3 4
R/W Line (Channel) PRESRW 40 4 3
R/W Line (Temporary) PRESRW 40 2 3
R/W Line (with Access) RWLFA 40 3 4
R/W Line (with Fence) RWLF 40 3 4
R/W Line (Fence & Access) RWLINF 40 3 4

-



Policy Directives and Administrative Orders

State Statutes, Transportation Commission Rules, Regulations.
Policies and Procedures and Published Rules of the Office of
Personnel Management and Merit Protection Commission shall
prevail when in conflict with approved Official Policies and
Administrative Orders of the Department of Transportation.

Signed copies of all Policy Directives and Administrative Orders

will be located in the Office of the Assistant Director-Administration.
This office will be glad to assist in any way and gratefully accept
your comments to better improve services to you.

Please send vyour comments via E-mail to Kookie Gerlitz.

You may notice slight variations in format from those policies on
line and those hard copies sent. This was done to standardize the
formatting. The content was not changed or altered.



Policy Directives and Administrative Orders Log

Section A - General

Section B - Administration

Section C - Planning / Programming
Section D - Engineering

Temporary Policies



August 23, 2004

POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS

LOG
SECTION A - GENERAL
A-101-1 11-08-82 INTERNAL COMMUNICATION SYSTEMS
A-101-2 07-01-85 POLICY DEVELOPMENT
A-101-3 09-01-94 LAND ACQUISITION
A-202-1 11-08-82 DEPARTMENTAL COORDINATING OFFICER FOR INTERNAL
COMMUNICATION
A-202-2 03-01-96 CIVIL RIGHTS - ASSIGNMENT OF RESPONSIBILITY
A-202-3 09-01-94 INTERNAL REVIEW
A-202-4 01-10-94 RISK MANAGEMENT
A-202-4-(2) 01-15-87 RIGHT OF STATE TO RECOVER DAMAGES FROM DEPARTMENT
EMPLOYEES
A-202-5 08-01-96 DISASTER MANAGEMENT TEAM
A-203-1 08-01-94 PRODUCTIVITY ENHANCEMENT EVALUATION COMMITTEE
A-301-1 10-03-91 ODOT SAFETY MANUAL
A-301-2 02-28-03 CENTRAL OFFICE EMERGENCY EVACUATION PLAN
A-301-3 07-01-90 HAZARDOUS MATERIAL
A-401-1 04-01-93 DRUG FREE WORK PLACE (Ref. B-502-1 Drug Free Awareness Program)
A-401-2 10-30-99 EMPLOYEE ASSISTANCE PROGRAM
A-401-3 01-01-95 THE AMERICAN WITH DISABILITIES ACT
A-401-4 08-31-04 ALCOHOL AND DRUG TESTING
A-404-1 02-28-03 WORKERS' COMPENSATION
A-501-1 03-01-96 ACCIDENT INVESTIGATIONS - CONFIDENTIAL




MARCH 1, 2006

POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS

LOG

SECTION B - ADMINISTRATION

POLICY NO. EFF. DATE TITLE

B-101-2 09-21-86 EMPLOYEE ETHICAL CONDUCT

B-101-2-(1) 01-04-94 EMPLOYEE ETHICAL CONDUCT - ACCEPTANCE OF OFFERINGS

B-101-2-(2) 07-01-90 EMPLOYEE ETHICAL CONDUCT - PERSONAL BUSINESS

B-101-2-(3) 01-02-92 EMPLOYEE ETHICAL CONDUCT - CONFLICT OF INTEREST

B-101-2-(4) 06-15-89 EMPLOYEE ETHICAL CONDUCT - NEPOTISM

B-101-4 09-06-89 MAILROOM AND FACILITIES

B-103-1 06-15-00 PROJECT MANAGEMENT

B-104-1 05-01-96 USE OF THE OKLAHOMA DEPARTMENT OF TRANSPORTATION
FACILITIES

B-105-1 06-02-03 RECORDS MANAGEMENT PROGRAM

B-105-1-(1) 06-02-03 MICROFILMING OF ODOT'S RECORDS

B-105-1-(2) 06-02-03 RECORDS MANAGEMENT PROGRAM - MAINTENANCE/STORAGE

B-201-1 12-21-83 FINANCIAL ACCOUNTING - ASSIGNMENT OF RESPONSIBILITY

B-261+2 62-14-84 REPORTINGCHANGES HN-HNANCIAE-ACCOUNTING
RESCINDED MARCH 1, 2006

B-201-3 05-01-98 AUDIT RESPONSIBILITIES - COGNIZANCE - NOTIFICATION

B-201-4 08-01-95 RESPONSE TO AUDIT FINDINGS

B-202-1 02-01-02 RECEIPT OF MONEY

B-202-2 11-01-99 BILLING, RECEIPT AND COLLECTION OF MONEY

B-203-1 04-03-95 PAYROLL

B-203-1-(1) 04-03-95 PAYROLL - TYPES

B-203-1-(2) 09-01-96 PAYROLL - WARRANT CANCELLATION

B-203-1-(3) 04-03-95 PAYROLL - LEAVE

B-203-1-(4) 09-01-95 PAYROLL - DEDUCTIONS

B-203-1-(5) 01-10-94 PAYROLL - EMPLOYEE'S BENEFIT COUNCIL

B-204-1 09-03-02 REIMBURSEMENT FOR OUT OF AGENCY USE OF ODOT AIRCRAFT
(OAC 730:1-7-1,2,3,4,)

B-301-1 10-01-96 GRIEVANCE MANAGEMENT INFORMATION
- Subchapter 19, Internal Agency Grievance Resolution Procedures (455:10.19)

B-301-1-(1) 09-01-95 GRIEVANCE MANAGEMENT INFORMATION
- Internal Agency Grievance Resolution Form MPC 900

B-301-2 04-28-87 EMPLOYEE RIGHT-OF-EXPRESSION AND COMMUNICATION

B-301-3 03-13-89 TARGETED ENGINEERING POSITIONS

B-302-1 05-01-05 CONFIDENTIALITY OF PERSONNEL RECORDS

B-302-2 07-01-90 OPEN RECORDS ACT




POLICY NO. EFF. DATE TITLE
B-303-1 04-03-95 FAIR LABOR STANDARDS ACT - OVERTIME PAY
B-303-1-(1) 02-23-94 FAIR LABOR STANDARDS ACT - CLASSIFICATION LIST - OVERTIME
ELIGIBILITY
B-303-1-(2) 07-01-00 FAIR LABOR STANDARDS ACT - RECORD KEEPING REQUIREMENTS
B-304-1 01-11-01 CONTRACT LABOR - TEMPORARY EMPLOYMENT AGENCIES
B-305-1 05-01-05 REDUCTION-IN-FORCE
- Merit Rules for Employment
B-305-2 06-17-87 APPOINTMENT TO VACANT POSITIONS
B-305-2-(1) 05-01-05 APPOINTMENT TO VACANT POSITIONS - PROMOTIONS
B-305-2-(2) 07-01-90 APPOINTMENT TO VACANT POSITIONS - TRANSFER
B-305-2-(3) 04-01-84 APPOINTMENT TO VACANT POSITIONS -REINSTATEMENT
B-305-2-(4) 07-01-90 APPOINTMENT TO VACANT POSITIONS - TEMPORARY
B-305-2-(5) 07-01-90 APPOINTMENT TO VACANT POSITIONS - DETAIL TO SPECIAL DUTY
B-305-2-(6) 07-01-90 APPOINTMENT TO VACANT POSITIONS - DEMOTION
B-305-2-(7) 07-01-90 APPOINTMENT TO VACANT POSITIONS - PROBATIONARY/PERMANENT
B-305-3 07-01-90 PROBATIONARY EMPLOYEE/PERIOD
B-305-4 03-01-96 SEPARATION FROM EMPLOYMENT
B-305-5 08-19-87 LIMITED/LIGHT DUTY RETURN TO WORK
B-305-6 04-01-92 EMPLOYMENT - COMMERCIAL DRIVERS LICENSE
B-306-1 03-01-96 REGULATORY SERVICES - TITLE VI AND THE DISADVANTAGED
BUSINESS ENTERPRISE PROGRAM
B-306-2 03-08-84 EQUAL EMPLOYMENT OPPORTUNITY AND AFFIRMATIVE ACTION
B-306-2-(1) 05-16-98 GRIEVANCE MANAGEMENT INFORMATION - DISCRIMINATION
B-306-3 09-11-91 SEXUAL HARASSMENT - DISCRIMINATION
B-307-1 05-01-05 LEAVE AND ABSENCE-FROM-WORK ASSIGNMENT
-36071- Rescinded ANNUALEEAVE
-3071- Rescinded WHNESSANBIURY-DUTYHEAVE
-36071- Rescinded EBDUCAHONALLEAVE
-36071- Rescinded ENFORCEDLEAVE
-36071- Rescinded HOHDBAYLHEAVE
-3071- Rescinded EEAVE-O-ABSENCE-WHTHOUTPAY
-36071- Rescinded MHEHARYEEAVE
-36071- Rescinded PROFESSIONALLEAYE
-36071- Rescinded SIEKEEAVE
-36071- Rescinded YOHNGEHEAVE
- -1- Rescinded INCEEMENTWEATHER PROCEBDURES—AUTHORIZED-ABSENCES

Rescinded




POLICY NO. EFF. DATE TITLE
-307-1- Rescinded FRAMNING-ABSENCE
- -1- Rescinded FAMHE-AND-MEBPICAEHEAVE
- -1- Rescinded STATEEMPEOYEEHEAVESHARING-
B-308-1 09-01-94 POLITICAL ACTIVITY
B-310-1 07-01-97 TRAVEL EXPENSES - REIMBURSEMENT
B-310-1-(1) 07-01-2001 STATE TRAVEL EXPENSES - REIMBURSEMENT
B-310-2 05-15-93 TRANSFERRED EMPLOYEES - PARTIAL PAYMENT OF MOVING
EXPENSES
B-310-3 10-19-88 TRANSPORTING PASSENGERS IN ODOT VEHICLES
B-310-4 05-01-05 VEHICLE USE - TO AND FROM EMPLOYEE RESIDENCE
B-311-1 03-01-96 EMPLOYEE PERFORMANCE APPRAISAL
- ODOT-HR199A, (8-94) Pages 1-4
B-312-1 08-01-92 DISCIPLINARY/TERMINATION ACTION W/FORMS
- Proposed Disciplinary Action: Notice of Disciplinary Action - PR543, dtd 03/95
- Specifics of Cause, dtd 2-87
- Notice of Forfeiture of Office or Employment, April 1995
- Petition for Appeal - MPC-200, dtd 08-95
B-312-1-(1) 01-02-92 PREDISCIPLINARY/PRETERMINATION HEARING PRIOR TO
DISCHARGE, SUSPENSION WITHOUT PAY, INVOLUNTARY DEMOTION
OR FORFEITURE OF POSITION W/FORMS
- Proposed Disciplinary Action: Notice of Predisciplinary Action - PR543, dtd 03-95
- Specifics of Cause, dtd 2-87
- Notice of Pre-Termination Hearing (Forfeiture of Office or Employment), NPH-April 1995
B-402-1 06-01-89 ODOT COMMUNICATIONS HANDBOOK
B-502-1 08-01-90 DRUG FREE AWARENESS PROGRAM
B-601-1 04-30-03 DEPARTMENT PURCHASING
B-601-1-(1) 04-30-03 REQUISITION FOR PURCHASING
B-601-1-(2) 11-01-98 SPLIT PURCHASING
B-903-1 10-01-85 ODOT GUIDELINES FOR PUBLIC AUCTION OF AUTOMOTIVE
EQUIPMENT
B-904-1 05-30-99 PREPARATION AND MAINTENANCE OF INVENTORY RECORDS
B-905-1 05-06-83 ODOT EQUIPMENT PREVENTIVE MAINTENANCE MANUAL
B-1003-1 03-01-84 PUBLIC ACCESS TO MEETINGS AND RECORDS
B-1101-1 11-01-94 REPORTING BURGLARIES, THEFTS AND VANDALISM AND
SAFEGUARDING ODOT PROPERTY AND EQUIPMENT.
B-1101-2 12-01-05 ACCESS TO DEPARTMENT FACILITIES
B-1201-1 07-01-00 USE OF INFORMATION SERVICES DIVISION RESOURCES
B-1202-1 07-01-00 INTERNET ACCESS
B-1203-1 07-01-00 ELECTRONIC-MAIL SYSTEM




POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS

LOG

SECTION C - PLANNING & PROGRAMMING

POLICY NO. EFF. DATE TITLE

C-101-1 12-01-85 STATUTORY ACCESS ROAD PROJECTS - ASSIGNMENT OF
RESPONSIBILITY

C-101-2 09-01-96 MUNICIPAL ANNEXATION OF PORTIONS OF STATE HIGHWAYS -
ASSIGNMENT OF RESPONSIBILITY

C-101-3 05-09-08 DEPT. PARTICIPATION IN ADDITIONS TO RAILROAD INFRASTRUCTURE

C-201-1 12-01-95 ADDITIONS AND DELETIONS TO THE STATE HIGHWAY SYSTEM

C-201-1-(1) 12-01-95 ADDITIONS AND DELETIONS TO THE STATE HIGHWAY SYSTEM

C-201-2 12-01-95 ENVIRONMENTAL MITIGATION

C-201-3 08-01-96 HIGHWAY NOISE ABATEMENT




POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS

LOG
SECTION D - ENGINEERING
POLICY NO. EFF. DATE TITLE

D-102-1 11-21-87 CLEAR ZONE

D-201-1 02-20-84 REPLACEMENT OF RIGHT-OF-WAY FENCES

D-201-1-(1) 02-20-84 DESIGN & CONSTRUCTION OF REPLACEMENT RIGHT-OF-WAY FENCES

D-202-1 04-28-83 REMOVAL OF ENCROACHMENTS

D-202-1-(1) 01-15-88 UTILITY REGULATIONS AND REARRANGEMENTS

D-302-1 01-10-94 TRAFFIC ENGINEERING

D-303-1 06-27-83 MINIMUM CLEARANCE WARNING SIGNS

D-303-2 06-27-83 "WATCH FOR ICE ON BRIDGE" WARNING SIGNS

D-401-1 05-12-83 CONTRACT ADMINISTRATION MANUAL

D-401-2 07-01-88 ENGINEER'S ESTIMATE - CONFIDENTIALITY

D-401-3 05-15-92 CONTRACT ADMINISTRATION - NONPAYMENT COMPLAINT AND
BONDING INFORMATION

D-402-1 05-12-83 CONSTRUCTION SPECIFICATIONS

D-402-2 07-06-83 WRITING, REVIEWING AND APPROVING SPECIFICATIONS, SPECIAL
PROVISIONS AND PLAN NOTES

D-402-2-(1) 07-06-83 GUIDELINES FOR WRITING SPECIFICATIONS, PLAN NOTES AND
SPECIAL PROVISIONS

D-402-2-(2) 07-06-83 SAMPLE FORMAT FOR SPECIAL PROVISIONS

D-404-1 05-12-83 SAMPLING AND TESTING METHODS

D-404-2 05-12-83 SAMPLING GUIDE

D-404-3 03-01-02 NONPAYMENT OF OVERWEIGHT DELIVERIES

D-404-4 02-01-04 NUCLEAR MEASUREMENT GAUGES

D-501-1 10-01-96 ODOT MAINTENANCE MANUAL

D-501-2 05-06-83 ODOT WAREHOUSE MANUAL

D-502-1 10-01-96 DRIVEWAY REGULATIONS

D-503-1 10-01-96 ODOT MOWING GUIDE

D-504-1 08-01-95 HERBICIDE PROGRAM

D-601-1 10-01-96 VALUE ENGINEERING

D-601-1-(1) 10-01-96 VALUE ENGINEERING




MARCH 1, 2006 POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS
LOG

SECTION - TEMPORARY POLICY

POLICY NO. EFF. DATE TITLE

11-15-85 HIGHWAY FENCING POLICY FOR CONTROLLED ACCESS
HIGHWAYS
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POLICY DIRECTIVES AND ADMINISTRATIVE ORDERS

LOG
SECTION A - GENERAL
A-101-1 11-08-82 INTERNAL COMMUNICATION SYSTEMS
A-101-2 07-01-85 POLICY DEVELOPMENT
A-101-3 09-01-94 LAND ACQUISITION
A-202-1 11-08-82 DEPARTMENTAL COORDINATING OFFICER FOR INTERNAL
COMMUNICATION
A-202-2 03-01-96 CIVIL RIGHTS - ASSIGNMENT OF RESPONSIBILITY
A-202-3 09-01-94 INTERNAL REVIEW
A-202-4 01-10-94 RISK MANAGEMENT
A-202-4-(2) 01-15-87 RIGHT OF STATE TO RECOVER DAMAGES FROM DEPARTMENT
EMPLOYEES
A-202-5 08-01-96 DISASTER MANAGEMENT TEAM
A-203-1 08-01-94 PRODUCTIVITY ENHANCEMENT EVALUATION COMMITTEE
A-301-1 10-03-91 ODOT SAFETY MANUAL
A-301-2 02-28-03 CENTRAL OFFICE EMERGENCY EVACUATION PLAN
A-301-3 07-01-90 HAZARDOUS MATERIAL
A-401-1 04-01-93 DRUG FREE WORK PLACE (Ref. B-502-1 Drug Free Awareness Program)
A-401-2 10-30-99 EMPLOYEE ASSISTANCE PROGRAM
A-401-3 01-01-95 THE AMERICAN WITH DISABILITIES ACT
A-401-4 08-31-04 ALCOHOL AND DRUG TESTING
A-404-1 02-28-03 WORKERS' COMPENSATION
A-501-1 03-01-96 ACCIDENT INVESTIGATIONS - CONFIDENTIAL




OKLAHOMA DEPARTMENT OF TRANSPORTATION
POLICY DIRECTIVE NO. A-101-1

SUBJECT INTERNAL COMMUNICATIONS SYSTEM pacenNo. 1 of 4
pDATED 11-08-82
EFFECTIVE DATE ISSUED BY APPROVED
11-08-82 DIRECTOR s/s R.A. Ward
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes Operating Memo No. 1 All 04-07-47
POLICY

THE OKLAHOMA DEPARTMENT OF
TRANSPORTATION WILL ESTABLISH
AND MAINTAIN AN OFFICIAL
SYSTEM FOR INTERNAL
COMMUNICATION WITHIN THE
DEPARTMENT.

Policy Directives, Temporary Policy Directives, Administrative Orders, and when so properly
designated, Departmental Manuals constitute the official Policy of the Department of
Transportation.

Assistant Directors and other supervisory personnel, when operating with the delegated authority
of an Assistant Director, may establish and issue whatever policies, instructions and guides, verbal
or written, necessary for the proper administration and operation of their areas of supervision when
the provisions of such policy, instruction or guide apply to and effect only those personnel and/or
areas of concern under their jurisdiction. Official Departmental policy shall prevail when in conflict
with these policies, instructions or guides.

All existing policies and procedures, manuals, official memorandum and other communication of
a policy nature will remain in effect until rescinded, replaced or otherwise incorporated into this
internal communications system; or until six-months from the effective date of this Policy Directive.

State Statutes, Transportation Commission Rules, Regulations, Policies and Procedures and
published Rules of the Office of Personnel Management and the State Ethics and Merit
Commission shall prevail when in conflict with approved official policy of the Department of
Transportation.



OKLAHOMA DEPARTMENT OF TRANSPORTATION
NO. A-101-1

POLICY DIRECTIVE

SUBJECT INTERNAL COMMUNICATIONS SYSTEM PAGENO. 2 of 4
pDATED 11-08-82
EFFECTIVE DATE ISSUED BY APPROVED
11-08-82 DIRECTOR s/s R.A. Ward
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes Operating Memo No. 1 All 04-07-47

The supervisor of each organizational division, (and each resident engineer's office and each
maintenance district), will maintain a complete file of current Policy Directives, and Administrative
Orders and manage his unit in conformance with the provisions of those directives and orders.

Supervisors are responsible for informing employees of the provisions of those directives and
orders applicable to them; and for honoring employee requests to review the written policies.
However, such employee reviews may be limited by the supervisor to a time reasonably
convenient to the work requirements of the unit.

DEFINITIONS
The official elements of the Internal Communication System are as follows:
A. Policy Directive
A numbered, dated, written statement, issued under the authority and signature of the
Director/Chief Engineer or his official designee acting with his authority in his absence. It will
remain in effect until rescinded, superseded, or amended in writing by proper authority.
Distribution is to all supervisory personnel and/or as directed by the Director/Chief Engineer.
The purpose of the Policy Directive is:
1. To govern the administration and operation of the Department; and/or
2. Toestablish and/or amend Department organizational structure; to effect, clarify and/or
amend major assignments in authority and/or responsibility; and to effect certain
personnel assignments.
A Policy Directive is intended for use only when the provisions of the Directive apply to,
and affect all, or a significant proportion of the personnel and/or jurisdictional areas of
the Department.
(They are not intended to be used for matters of a temporary or shortlived nature, or
those which are intra-divisional or intra-area.) Whenever possible, a Policy Directive

should be written using the following format:

Policy - A statement of the objective of the Directive in general terms.
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SUBJECT INTERNAL COMMUNICATIONS SYSTEM pPAaGENO. 3 of 4
pDATED 11-08-82
EFFECTIVE DATE ISSUED BY APPROVED
11-08-82 DIRECTOR s/s R.A. Ward
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes Operating Memo No. 1 All 04-07-47

IMPLEMENTATION (SPECIFIC)

Statements describing methods for implementing policy objectives that must be followed without
deviation. However, limits or boundaries may be substituted to allow for flexibility.

IMPLEMENTATION (ADVISORY)

Statements describing methods for implementing the policy objectives considered to be most
advisable, but not mandatory.

B.

Temporary Policy Directive

Anunnumbered, written communication similar in all aspects to a permanent Policy Directive,
but intended only to serve in the interim period until a permanent Policy Directive can be
issued, or to be in effect for a limited period of time. Such communication will contain either
an expiration date or the notation that it is intended to be superseded by a permanent Policy
Directive. A Temporary Policy Directive will not necessarily conform to the prescribed format
of a permanent Directive.

Administrative Order

A numbered, dated, written document issued under the authority and signature of the
Director/Chief Engineer or appropriate Assistant Director. It will remain in effect until
rescinded, superseded or amended in writing by proper authority. Distribution is as directed
by the issuing authority and to the Departmental Coordinating Officer for Internal
Communication, who will be responsible for proper distribution to all custodians of
Department Policy Manuals.

The purpose of the Administrative Order is to provide for additional guidance, definition and
implementation of Departmental Policy Directives.

Administrative Orders will be keyed by both number and title to a Policy Directive, and issued
on the form provided for Administrative Orders. No particular format is required.
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pDATED 11-08-82
EFFECTIVE DATE ISSUED BY APPROVED
11-08-82 DIRECTOR s/s R.A. Ward
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D. Manuals

Manuals issued by the Department, or portions thereof, may become a part of the official
policy of the Department when so approved and so directed by the Director-Chief Engineer.

E. Advisory Memorandum

An unnumbered, written, internal communication to all, or a portion of the employees of the
Department to convey information which is advisory only in nature. It has no effect on
Department policy, nor does it outline expected administrative or operational guidelines or
requirements. There are no restrictions on who can issue it and should be so identified as
an Advisory Memorandum. A copy should be sent to the Department Coordinating Officer
for Internal Communications.



OKLAHOMA DEPARTMENT OF TRANSPORTATION
POLICY DIRECTIVE NO. A-101-2

SUBJECT POLICY DEVELOPMENT paceno. 1 of 1
pATED _06-18-85
EFFECTIVE DATE ISSUED BY APPROVED
07-01-85 DIRECTOR s/s V.O. Bradley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-101-2 All 11-08-82
POLICY

THE ASSISTANT DIRECTORS,
OPERATING WITHIN THEIR
RESPECTIVE AREAS OF CONCERN,
ARE RESPONSIBLE FOR THE
DEVELOPMENT OF NEW AND
AMENDED POLICY DIRECTIVES,
BOTH PERMANENT AND
TEMPORARY.

IMPLEMENTATION (SPECIFIC)

All permanent Policy Directives will be drafted in final form by the appropriate Assistant Director
and reviewed by the Departmental Coordinating Officer for Internal Communications.

Proposed new and amended Policy Directives (and manuals when intended to be an approved
part of the official policy of the Department) will be presented to, and reviewed by, the Director and
the Director's staff, prior to adoption.

All Policy Directives must have the signature approval of the Director or his official designee acting
with his authority in his absence.

The Departmental Coordinating Officer for Internal Communication is responsible for timely and
proper distribution of all documents constituting the official policy of the Department.
IMPLEMENTATION (ADVISORY)

In instances where there is no Assistant Director, policy formulation for that area will be the
responsibility of the next higher authority.



POLICY DIRECTIVE

OKLAHOMA DEPARTMENT OF TRANSPORTATION

NO. A-101-3

SUBJECT

LAND ACQUISITION

PAGENO. 1 of 1

DATED _09-01-94
EFFECTIVE DATE ISSUED BY APPROVED
09-01-94 DIRECTOR s/s Jack C. Crowley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-101-3 All 04-28-83
POLICY

THE DIVISION MANAGERS OF THE
RIGHT-OF-WAY DIVISION AND THE
LEGAL & BUSINESS SERVICES
DIVISION ARE JOINTLY
RESPONSIBLE FOR THE
IMPLEMENTATION OF LAND
ACQUISITION POLICIES FOR THE
DEPARTMENT. THE POLICIES
CONTAINED IN THE LAND
ACQUISITION MANAGEMENT GUIDE
ARE HEREBY MADE A PART OF THE
OFFICIAL POLICIES OF THE
DEPARTMENT.



POLICY DIRECTIVE

OKLAHOMA DEPARTMENT OF TRANSPORTATION

NO. A-202-1

SUBJECT DEPARTMENTAL COORDINATING OFFICER FOR
INTERNAL COMMUNICATIONS

PAGENO. 1 of 1
pDATED 11-08-82

EFFECTIVE DATE
11-08-82

ISSUED BY
DIRECTOR

APPROVED

s/s

R.A. Ward

POLICY REPLACED
Yes

POLICY NO.

A-202-1

PAGE NO.

All

DATED

DUTIES AND RESPONSIBILITIES

POLICY

THE ASSISTANT DIRECTOR FOR

HUMAN RESOURCES AND TRAINING
IS ASSIGNED THE ADDITIONAL

DUTIES AS THE DEPARTMENTAL
COORDINATING OFFICER FOR

INTERNAL COMMUNICATIONS.

1. Review all proposed new or amended Policy Directives for clarity and consistency with
desired form, format and style.

2. Properly index, number and distribute approved official policy of the Department.

3. Verify that new or amended policy does not conflict with existing law or other mandatory
rules and regulations.

4. Maintain the official files of the Internal Communication System of the Department,
including a historical record of such communication.




POLICY DIRECTIVE

OKLAHOMA DEPARTMENT OF TRANSPORTATION

NO. A-202-2

SUBJECT CIVIL RIGHTS - ASSIGNMENT OF RESPONSIBILITY

PAGENO. 1 of 1
pAaTED _03-01-96

EFFECTIVE DATE

ISSUED BY

APPROVED

03-01-96 DIRECTOR s/s Neal A. McCaleb
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-202-2 All 07-01-90
POLICY

THE DIVISION MANAGER OF THE
OFFICE OF CIVIL RIGHTS IS
ASSIGNED THE DUTIES OF THE

DEPARTMENT'S

EQUAL

EMPLOYMENT OPPORTUNITY.

The Office of Civil Rights is assigned the responsibility for overall coordination of the Title VII Civil
Rights Program of the Department; individual segments of the program are assigned as follows:

1. The Internal EEO and Affirmative Active Program.

2. The monitoring and reporting of the ODOT Internal Equal Employment Opportunity

Program.

3. The development, monitoring and reporting of the ODOT Affirmative Action Program.

4.  Monitoring and complaint review of the Department's ADA program




OKLAHOMA DEPARTMENT OF TRANSPORTATION
POLICY DIRECTIVE NO. A-202-3

SUBJECT INTERNAL REVIEW PAGENO. 1 of 2
paTeED _09-01-94
EFFECTIVE DATE ISSUED BY APPROVED
09-01-94 DIRECTOR s/s J. C. Crowley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-202-3 All 10-11-84
POLICY

THE DEPARTMENT WILL MAINTAIN
AN ACTIVE INTERNAL REVIEW AND
AUDIT FUNCTION, BOTH AS A
SERVICE TO MANAGEMENT AND AS
THE COGNIZANT AUDIT GROUP WITH
RESPECT TO OUTSIDE AGENCIES.

IMPLEMENTATION (SPECIFIC)

The internal audit policy and responsibility will be maintained and effected by the Internal Review
Branch of the Operations Review and Evaluation Division which, as an independent function within
the Department, will report directly to the Director.

The Internal Review Branch is authorized and directed to review and evaluate every Department
function, activity, records and files, and report on controls, economy, efficiency, effectiveness,
program results, management of resources and records, and compliance with Department and
Federal standards and guidelines.

In order to accomplish the review/audit assignments, direct lines of authority may be crossed when
necessary.

All files, records, or other documentation relating to any Departmental activity, project, or function
shall be furnished to auditors of the Operations Review and Evaluation Division upon request,
regardless of the normal policy restrictions pertaining to confidentiality, whenever the request is
made in connection with a Departmental audit or investigation.

When it becomes necessary for internal auditors to review secure or confidential matters or data,
the auditors will be responsible for maintaining the security or confidentiality.

The Internal Review Branch is responsible for the performance of cyclical reviews and special
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paTeED _09-01-94
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operational audits of all Department activities. All audits will conform to the standards for audit of
governmental organizations, programs, activities, and functions established by the United States
General Accounting Office. In those areas of Department activity wherein federal requirements
must be complied with or reviewed for a federal agency, under the single audit concept, the
additional requirements will be met by the Department's internal audit function in order to establish
and maintain reliance with the federal agency.
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EFFECTIVE DATE ISSUED BY APPROVED
1-10-94 DIRECTOR s/s J.C. Crowley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-202-4 All 5-27-86
POLICY

THE DEPARTMENT OF
TRANSPORTATION SHALL BE
COMMITTED TO AN AGGRESSIVE
RISK MANAGEMENT AND ACCIDENT
PREVENTION PROGRAM. TO
ACCOMPLISH THE GOALS, THE
DEPARTMENT WILL MAINTAIN AND
FOLLOW VIABLE POLICIES,
GUIDELINES, AND PROCEDURES
PERTAINING TO RISK MANAGEMENT.

IMPLEMENTATION (SPECIFIC)

The General Counsel is hereby assigned the additional responsibility of the Department Risk
Management Coordinator.

The Department Risk Management Coordinator shall be responsible for the daily operation of the
Department Risk Management Program and will provide liaison between the Department and the
State Risk Manager, between the central office and field divisions, and within the central office.
The Risk Management Coordinator shall monitor the Department program and provide
investigative and other aid requested by Division Risk Managers.

The Risk Management Coordinator shall act as a clearinghouse for Risk Management information
to the various divisions and shall review each division's Risk Management Program for overall
conformance to Department policy, procedures, and guidelines.

The Department of Transportation Risk Management Program shall include, but is not limited to,
the following functions:

1. The Department shall, through the General Counsel, Risk Management Coordinator, and
Division Risk Managers, develop and implement an accident reporting and investigation
program.
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2. The Department shall develop and implement a system to analyze accident trends and
high accident locations, and shall study and evaluate significant accidents or incidents
with the ultimate goals of preventing or minimizing recurrence or risk. Recommendations
for correcting or improving high accident or potential accident locations requiring
Commission action will be sent to the Director with copies to the Deputy Director and to
the Chief Engineer.

3. The Department, through the Division Managers and Risk Managers, will identify training
needs targeted at improving the job safety, performance, and safety awareness of
employees. The Training Division will then develop and implement a training program,
or programs, necessary to meet the identified needs.

4. The Department will develop and implement a system of determining transportation
needs and converting them to input for use in planning, programming, maintenance, and
construction. Specific responsibility for utilizing the input and taking appropriate action
remains with the responsible authority.

5. Each division involved in field operations shall develop and implement a written Risk
Management Program designed to address the specific operational needs of that division.
While the specifics of the written program will vary according to the needs and operations
of the particular division, each written program should address:

(@) The overall responsibilities for risk management

(b) The duties of the division personnel in the division Risk Management Program
(c) Employee responsibility and procedures for reporting of incidents

(d) Accident investigation policy and procedure

(e) Problem area identification

() Prioritization

(g) Corrective action

6. Divisions not directly involved in field operations shall develop a written program which
specifically addresses the risk management function of that division.
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7. All levels of management will direct ODOT awareness, response, and communication
toward providing for the safety of the public and Department personnel.

Each division shall appoint or have assigned a Risk Manager.

1. Central Office Risk Managers will liaison between their division and the Risk Management
Coordinator. They will, under the direction of the Division Manager, develop and
implement the program, policies, and procedures for their specific division.

2. Field Division Risk Managers will liaison with the Risk Management Coordinator. They
will, under the direction of the Division Engineer, develop and monitor the Division's
written Risk Management Program, and will, in coordination with other division personnel,
develop specific policies and procedures; respond to, analyze, and investigate significant
accidents or incidents; investigate claims arising within the division; maintain appropriate
records; and require outside expertise and needed training of personnel.

IMPLEMENTATION (ADVISORY)

The Risk Management Program is a systematic loss reduction technique implemented by:
identifying risks, measuring those risks, identifying corrective measures and implementing them,
and periodic evaluation of results.
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DATED _05-27-86 ISSUED BY Asst. Dir. - Administration
s/s Michael F. Mayberry

It shall be the duty and responsibility of each division manager to implement procedures to inform
employees of the provisions of Section 160 of Title 51 of the Oklahoma Statutes (Governmental
Tort Claims Act).

The State of Oklahoma shall have the right to recover from any employee payments made by the
State for any judgment or settlement (including costs and fees) on the behalf of an employee's
defense in the following instances:

1. Ifltis shown that the conduct of the employee, which gave rise to the claim or action,
was outside the scope of his employment, or

2. If the employee fails to cooperate in good faith in the defense of the claim or action.
The division engineer shall also implement procedures to inform employees that conduct outside

the scope of employment, or failure to cooperate in good faith in the defense of a claim or action
brought under the Governmental Tort Clams Act, may result in disciplinary action.
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EFFECTIVE DATE ISSUED BY APPROVED
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POLICY

IN THE EVENT A DISASTER OCCURS ON
THE STATE TRANSPORTATION SYSTEM
OR ON PROPERTY UNDER THE
JURISDICTION OF THE DEPARTMENT,
THE CONTROL OF DEPARTMENTAL
ACTIONS IN RESPONSE TO THAT
DISASTER, FOLLOWING THE
NECESSARY IMMEDIATE ACTIONS BY
RESPONSIBLE DEPARTMENT OFFICIALS,
WILL BE UNDER THE DIRECTION OF THE
DEPARTMENT'S DISASTER
MANAGEMENT TEAM.

DEFINITION

A disaster is an occurrence, event, or condition of unusual or extraordinarily significant proportions,
which imposes, or threatens to impose, animmediate danger to life, property, and/or the environment.

IMPLEMENTATION (SPECIFIC)

The following individuals, identified by the position they hold in the Department, or their successors
or current designee, will constitute the "Disaster Management Team" of the Department:

Director

Deputy Director

Chief Engineer

Assistant Director for Operations.
Assistant Director for Administration
Assistant Director for Preconstruction
General Counsel

Team leader responsibilities are in the order listed above.

In the event of a disaster, it is the first responsibility of senior field personnel responding to the
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disaster call to take whatever immediate actions they deem necessary to safeguard the life and
property of the public immediately affected.

Consistent with this responsibility, and as soon as possible thereafter, they are to alert any member
of the Disaster Management Team. They are to communicate to that team member the following
information:

1. The cause, nature, extent, and location of the disaster

2. Any concerns for resultant effects of the disaster which in turn pose a threat to life and
property

3. The actions they have taken in response to the disaster

4, An assessment of the support or action needed from the Disaster Management Team,
or others

Immediately upon being notified of a disaster, it is the responsibility of that team member to notify all
other members of the team and to cause a convening of the Disaster Management Team.

The team will assume immediate command and control of all further actions taken by the Department
in response to this disaster.

Authority and responsibility of the Disaster Management Team includes, but is not limited to:

1. Proper and necessary notification of others, including civil defense, law enforcement,
executive members of state, federal and local governments, and the public.

2. The allocation and direction of all departmental resources necessary to make proper
response to the disaster.

3. Officially to request needed assistance and actions from other state entities and other

governmental bodies.

4. The control of all public information released by the Department concerning the
disaster.

5. If warranted, initiate and direct an investigation of the cause and effect of the disaster.

6. The delegation of responsibility and authority to others within the Department.

7. Any other legal and proper actions.

8. Document the facts associated with the disaster, its cause and effect, with particular

emphasis upon the response and all actions taken by the Department, and to prepare
reports and documentation as necessary and required.
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THE DEPARTMENT WILL
PARTICIPATE IN THE STATE'S
PRODUCTIVITY ENHANCEMENT
PROGRAM

ASSIGNMENT OF RESPONSIBILITY

The Director's office will appoint a seven (7) member committee and identify one individual who
will serve as the Committee Chair. The members of this committee will serve at the pleasure of
the Director.

IMPLEMENTATION (SPECIFIC)

The Productivity Enhancement Evaluation Committee is responsible for the conduct of this
Department's participation in the State's Productivity Enhancement Program, and for the
development of the internal program within the Department to facilitate such participation,
including, but not limited to:

1. The development of internal policies, procedures, guidelines, etc., relating to and
facilitating involvement in the State's program.

2. Communication of the program goals and opportunity for participation to Department
employees.

3. Acting as the recipient for all suggestions, ideas, and recommendations made by the

Department personnel under the auspices of the program.

4. Evaluating and recommending disposition of these suggestions, ideas, and
recommendations.

5. Reporting periodically on the work of the Committee to the Director.
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THE CURRENT OKLAHOMA
DEPARTMENT OF TRANSPORTATION
SAFETY MANUAL ISHEREBY MADE A
PART OF THE OFFICIAL POLICIES OF
THE DEPARTMENT.
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THE DEPARTMENT WILL ESTABLISH
PROCEDURES TO REDUCE THE
POTENTIAL IMPACT OF A DISASTER
ON DEPARTMENT EMPLOYEES AND
THE SERVICES THEY PROVIDE TO
THE PEOPLE OF THE STATE OF
OKLAHOMA.

ORGANIZATION

The State Maintenance Engineer will serve as the Department Emergency Manager. The
Department Emergency Manager will be responsible for management of this plan for the
Department of Transportation. The Safety Branch Manager will be responsible for the plan in the
Central Office. Each Division within the Central Office will name Emergency Coordinators. Each
Emergency Coordinator will be responsible for no more than 10 people. Each Emergency
Coordinator will have an alternate to act in their absence.

IMPLEMENTATION (SPECIFIC):

The Safety Branch Manager will develop the Central Office Emergency Standard Operating
Procedure to reduce potential harm to Oklahoma Department of Transportation employees in the
event of a natural or man-made disaster. This plan will also be used to limit the interruption of
critical services to the people of the State of Oklahoma.

The Emergency Coordinators will be trained in emergency evacuation/shelter in place procedures.
They will conduct an emergency procedures orientation for employees under their responsibility.

The Emergency Procedures Quick Index File will be provided to all Emergency Coordinators. This
desktop guide provides immediate access to procedures to be followed during specific types of
emergencies.

Each employee has been furnished an Emergency/Disaster Personal Procedures Card. This card
provides instructions to be followed in case of an emergency. This card also provides telephone
numbers for emergency services and for key personnel within the Central Office.
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Emergency training exercises will be conducted at a minimum of twice per calendar year. They
will be initiated by the Department Emergency Manager.

Emergency notification systems will be tested on a quarterly basis.

Emergencies are classified into five basic categories. They include natural disasters, fire,
hazardous chemicals, terrorism, and earthquakes. Each emergency has its own unique response.
These responses are outlined in the Central Office Emergency Standard Operating Procedure

The Emergency Coordinator will be responsible for notifying the employees under their
responsibility of the emergency situation. Employees will evacuate the building or shelter within
the building. They will follow procedures in the Central Office Emergency Standard Operating
Procedure.

Each Emergency Coordinator will be responsible for removal and transportation of critical
materials in their area. These materials may include first aid kits, cellular phones, critical files or
any crucial items that the Emergency Coordinator deems necessary. These items will be
delivered to the Command Post once evacuation or sheltering has been completed.

Employees will report to their Emergency Coordinator at the sheltering or assembly area and
assist the Emergency Coordinator as needed. Once employees have been accounted for or
determined to be missing, each Emergency Coordinator will report their status at the Command
Post. Employees will remain at the sheltering area or assembly area until instructed by the
Emergency Coordinator to return to their work areas or to go home.

The Division Manager for Public Affairs will serve as the Media Contact Coordinator and will act
as a spokesperson for the Department.

Post-crisis counseling will be made available for all employees as needed through the Oklahoma
Department of Transportation Employee Assistance Program.
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THE DEPARTMENT'S HAZARDOUS
MATERIALS ARE GOVERNED BY THE
"ENVIRONMENTAL PROTECTION
AGENCY (EPA) REGULATIONS,” CFR
TITLE 40 SECTIONS 190-399 AND THE
"OCCUPATIONAL SAFETY HEALTH
ADMINISTRATION (OSHA)
REGULATIONS,” CFR TITLE 29, 1910.
OKLAHOMA LAW AS ADOPTED AND
GOVERNED BY THE CORPORATION
COMMISSION, THE HEALTH
DEPARTMENT AND THE LABOR
DEPARTMENT.

The Oklahoma Department of Transportation Hazardous Materials Manual is hereby made a part
of the official policies of the Department.

The Department shall establish and perpetuate a program for compliance with state and federal
rules and regulations regarding hazardous materials. These policies will apply to all operational

units.
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THE DEPARTMENT IS A DRUG-FREE
WORKPLACE. ALL DEPARTMENT
EMPLOYEES ARE PROHIBITED FROM
UNLAWFULLY MANUFACTURING,
DISTRIBUTING, DISPENSING,
POSSESSING, AND/OR USING A
CONTROLLED SUBSTANCE IN OR ON
DEPARTMENT FACILITIES, PROPERTY
OR WORKPLACES.

DEFINITIONS

"Controlled Substance" - means a controlled substance in Schedules | through V of the
Controlled Substance Act (21 U.S.C. 812), and as further defined by regulation at 21 CFR 1300.11
through 1308.15.

"Conviction" - means a finding of guilt (including a plea of nolo contendere) or imposition of
sentence, or both, by any judicial body charged with the responsibility to determine violations of
the Federal or State criminal drug statutes.

"Workplace" - means any and all properties owned or leased by the Department, including
buildings, land and vehicles; and physical sites not owned or leased by the Department where
employees of the Department oversee and/or administer federal funds on behalf of the
Department.

IMPLEMENTATION (SPECIFIC)
As a condition of employment, it is the responsibility of every employee to adhere to the

requirements and provisions of this policy and to notify his/her supervisor in writing of his/her
conviction for a violation of a criminal drug statute occurring in the workplace no later than five (5)
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calendar days after such conviction.

A copy of that written notification will be forwarded immediately by the supervisor to the Division
Manager of the Human Resources Division, who is responsible for notifying the Federal
sponsoring agency in writing within ten (10) calendar days of receipt of such notice.

Notification to the Federal agency will include the position title of the employee and the
identification number(s) of each affected grant or cooperative agreement.

Employees who violate this policy and/or who are convicted for a violation occurring in the
workplace shall be subject to disciplinary action as provided for by Department policy, OPM Rules
and Regulations, and State statutes. Such action will be consistent with the requirements of the
Rehabilitation Act of 1973, as amended.

Any employee, whether convicted or not, who seeks drug abuse assistance or rehabilitation, may
do so by contacting the Employee Assistance Program in the Human Resources Division of the
Department.

IMPLEMENTATION (ADVISORY)
Supervisors should be familiar with the provisions of the Controlled Substances Act and the
disciplinary policies of the Department. The provisions of the Drug Free Workplace Policy of the

Department will be presented to all new employees at New Employee Orientation.

Any action taken by the Department in response to an employee's compliance with the notification
provisions of the policy, must begin with thirty (30) calendar days of such notification.
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ODOT WILL, THROUGH ITS
ESTABLISHED EMPLOYEE
ASSISTANCE PROGRAM (EAP)
PROVIDE ASSESSMENT AND
REFERRAL SERVICES TO ASSIST
EMPLOYEES WHO ENCOUNTER
PERSONAL PROBLEMS WHICH MAY
ADVERSELY AFFECT JOB
PERFORMANCE OR PERSONAL WELL
BEING. AS PROVIDED BY MERIT
RULE 530:10-21-1 THROUGH 9.

DEFINITION

The Department's EAP shall be a work site based program designed to assist in the identification
and resolution of productivity problems associated with employees impaired by personal concerns
including, but not limited to marital, family, financial, alcohol/drug, trauma, emotional, stress or
other personal concerns which adversely affect employee job performance and safety.

IMPLEMENTATION (SPECIFIC)

An employee's personal life becomes a concern of the Department when it interferes with
satisfactory work performance, reflects discredit on the Department or jeopardizes the safety of
the employee or others. Participation in the EAP is voluntary except where participation is
required by state law or federal regulations. The Department shall make known to employees the
existence of the EAP.

A. Employee's Responsibility



POLICY DIRECTIVE NO. A-401-2

OKLAHOMA DEPARTMENT OF TRANSPORTATION

SUBJECT EMPLOYEE ASSISTANCE PROGRAM pAaGENO. 2 of 3
pAaTED 10-30-99
EFFECTIVE DATE ISSUED BY APPROVED
10-30-99 DIRECTOR s/s Neal A. McCaleb
POLICY REPLACED POLICY NO. PAGE NO. DATED
No A-401-2 All 09-01-94

Establishing and maintaining satisfactory job performance is the employee's responsibility.
No employee shall have employment rights, security, career advancement, or benefits
jeopardized by participating in the EAP. Participation or non-participation in the EAP will
neither adversely affect nor excuse an employee in any phase of the corrective disciplinary
process. Self-referral is encouraged as it is the employee's responsibility to seek assistance
as needed either through his/her own resources or through the EAP.

Supervisor's Responsibility

Supervisors are responsible for posting current information concerning the EAP, making this
information known and available to all employees and maintaining confidentiality concerning
an EAP participant. Supervisors may advise employees who are subject to any phase of the
corrective discipline process that the EAP is available and document that they have done so.

EAP Field Representative's Responsibility

Each field division engineer shall appoint an appropriate, capable and willing employee to act
as the Employee Assistance Program Field Representative. The representative's duties will
include being the liaison between their division employees and the EAP Administrator,
willingness and ability to maintain confidentiality, provide information by distributing printed
materials and refer all employees needing services to the EAP Administrator.

Periodic training will be provided to the EAP Field Representatives by the EAP Administrator.
Employee Assistance Program Administrator's Responsibility

The Employee Assistance Program Administrator, under the supervision of the Human
Resources Division Manager, administers the EAP throughout the Department and has
primary responsibility for developing, implementing and coordinating the program; for
compiling and maintaining a directory of qualified professionals and organizations both public
and private for referral purposes; for making referrals to appropriate resources for employees
who seek or are referred for services; and for maintaining records of the EAP in a confidential
manner.
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E. Confidentiality

Information and insurance records concerning employees who have been referred to the EAP
shall always be maintained in a confidential manner, separate and apart from personnel
records. Such records relating to an individual's participation in an EAP shall be confidential
unless a participant poses athreat to deliberately harm himself or others. Such determination
shall be made by an Employee Assistance Professional as certified by the National Employee
Assistance Professionals Association. The ODOT certified professional is the EAP
Administrator. Insurance/medical information pertaining to concerns addressed through the
EAP will be confidential and released only upon the employees' authorization.

F. Leave Usage

Employees are permitted to consult with the EAP without loss of pay or accumulated leave.
Sick, annual, or leave-without-pay can be used by EAP participants for receiving services.

G. Insurance Coverage
Behavioral health benefits (substance abuse or mental health) are covered by all state

insurance carriers. Benefits are detailed in the insurance carriers’ directory or the annual
enrollment guide.
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THE DEPARTMENT OF
TRANSPORTATION IS COMMITTED TO
THE PRINCIPLES OF "THE AMERICAN
WITH DISABILITIES ACT." EVERY
EFFORT WILL BE MADE THROUGH
ITS SUPERVISORS AND MANAGERS
TO COMPLY WITH THE ACTS
REQUIREMENTS.

DEFINITION

The American with Disabilities Act, Public Law 101-336, gives civil rights protection to people with
disabilities. These rights are similar to those provided on the basis of race, sex, national origin and
religion. It guarantees individuals with disabilities equal opportunity in employment, public
accommodations, transportation, state and local government services and telecommunications.
The American with Disabilities Act requires:

« That employers may not discriminate against a "qualified individual with a disability"

« Thatemployers mustaccommodate the disabilities of qualified applicants or employees, unless
it would be unreasonable to do so

« Thatemployers may reject applicants or fire employees who pose a "direct threat" to the health
and safety of other individuals in the work place and

» That employers may not discriminate against an applicant or employee based on a family,
business, social or other relationship or association that person has with another person who
has a disability.

A qualified person with a disability is a person that has a disability, and is qualified to perform the
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essential functions of the job either with or without a reasonable accommodation.

A disability is a physical or mental impairment that substantially limits one or more of the persons
major life functions. For a disability to be considered a substantial limitation on a person's ability
to work, it must keep the person from working in a class of jobs or a broad range of jobs. A
disability includes any physiological or psychological disorder that restricts important activities of
aperson, such as caring for oneself, performing manual tasks, walking, seeing, hearing, speaking,
breathing, learning, working and participating in community activities.

Essential functions are the fundamental job duties of a position. A particular function would be
essential, for example, because: the reason the position exists is to perform that function; or there
are a limited number of employees among whom that function can be distributed; or the function
is specialized to his or her ability.

Reasonable accommodations are changes to the duties of a position or to how the duties are
performed. Types of accommodations include helping devices, reassignment, modified work
schedules, job modification, relocation or a change in the physical plant. In deciding whether or
not a particular accommodation is a reasonable accommodation, an organization must determine
if providing the accommodation would impose an undue hardship on the operations of its
programs. The relationship between the cost of the accommodation and the salary of the position
is not relevant in determining whether an accommodation would impose an undue hardship.

IMPLEMENTATION (SPECIFIC)

The Office of Civil Rights is responsible for monitoring the Department's compliance with ADA and
for handling complaints statewide.

Supervisors and managers may not discriminate against a qualified individual with a disability in
any aspect of the employment relationship. Any aspect of the employment relationship includes:

® recruiting, advertising, and the processing of applications for employment;

® hiring, upgrading, promotion, award of tenure, demotion, transfer, layoff, termination,
right of return from layoff and rehiring;

® rates of pay or any other forms of compensation and changes in compensation;

® job assignments, job classification, organization structures, position descriptions, lines
of progression, and seniority lists;
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® |eaves of absence, sick leave, or any other leave;

e fringe benefits available by virtue of employment, whether or not administered by the
employee;

® selection and financial support for training, including apprenticeships, professional
meetings, conferences and other related activities, and selection for leave of absence
to pursue training; and

® employer sponsored activities, including social or recreational programs.
NOTE: The ADA does notrequire a person to prove that the discrimination in employment was
based solely on a disability. Instead a violation occurs where discrimination on the basis of a
disability is a factor. The ADA prohibits both intentional discrimination and unintentional
discrimination. A neutral employment practice that adversely effects disabled employees
("disparate impact") may be challenged under the ADA.

To comply with the employment section of ADA an employer, through its supervisors and
managers, must determine:

® the essential functions of the job,

e whether a disabled person, with or without accommodations, is qualified to perform
these duties, and

e whether any accommodations needed by a qualified individual is reasonable.
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u An Important Note: The employer's duty to search for accommodations starts after the

applicant or employee with a disability indicates that accommodation is needed. When
selecting the accommodation that is most appropriate for both the employer and the
person, the employer should work with the person and consider what the person says is
needed.

mm  |fanaccommodation is considered unreasonable by an employer, there are several options
available. Contact your central personnel office or the Office of Civil Rights for further
information and/or assistance.

Retaliation or Coercion

Section 36.206 implements section 503 of the ADA, which prohibits retaliation against any
individual who exercises his or her rights under the act. The ODOT will adhere to the above
provisions at all times. Questions about the above section should be directed to the Division
Manager, Office of Civil Rights.

IMPLEMENTATION (ADVISORY)

When Scheduling the Interview

Some applicants with visual or mobility impairments will phone in, prior to the appointment date,
specifically for travel information. Also, interviewers need to know whether or not the job site is
accessible and should be prepared to answer accessibility-related questions. The scheduler
should walk the travel path in order to provide applicants with detailed directions.

° For applicants using mobility aids, make sure the place where you plan to conduct the
interview is accessible by checking the following:

* Are there appropriate parking spaces available and nearby, and is there a ramped or
step-free entrance?

* Are there accessible restrooms, and water fountains and telephones at the proper
height for a person in a wheelchair to use?

e If the interview is not on the first floor, does the building have an elevator?
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If an interview site is inaccessible (e.g. steps without a ramp, or a building without an
elevator), inform the person about the barrier prior to the interview, and offer to make
arrangements for an alternate interview site.

There are other things you should know before scheduling an interview.

* When giving directions to a person in a wheelchair, consider distance, weather
conditions, and physical obstacles such as stairs, curbs, and steep hills.

* Use specifics such as "left a hundred feet" or "right two yards" when directing a person
with a visual impairment.

People with disabilities utilize a variety of transportation services when traveling to and from
work. Be aware that the person may be required to make a reservation 24 hours in
advance plus travel time. Provide the applicant with an estimated time to schedule their
return trip when arranging the interview appointment. Also, be considerate of the additional
travel time that may be required by a person with a disability.

Expect the same measures of punctuality and performance from people with disabilities as
are required by every potential or actual employee. People with disabilities expect equal
treatment, not special treatment.

When the Applicant Arrives

Know where accessible restrooms, drinking fountains and telephones are located. If such
facilities are not available, be ready to offer alternatives (e.g. the private/employee
restroom, a glass of water, your desk phone).

When introduced to a person with a disability, it is appropriate to offer to shake hands.
People with limited hand use or who wear an artificial limb can usually shake hands.

» Allow a person with a visual impairment to take your arm (at or about the elbow). This
will enable you to guide rather than propel or lead the person.

» Offer to hold or carry packages. Example: "May | help you with your packages?"

* When offering to hang a coat or umbrella, do not offer to hang a cane or crutches,
unless the individual requests otherwise.
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° Relax. Do not be embarrassed if you happen to use accepted, common expressions, such

as "See you later" or "Got to be running along," that seem to relate to the person's
disability. The person with a disability is aware they have one. You won't suddenly remind
them and hurt their feelings.

DURING THE INTERVIEW

General Information

As always, the focus of the interview should be on performance of the job. Emphasize
abilities, achievements and individual qualities.

Conduct your interview as you would with anyone. Be considerate without being
patronizing.

If it appears that a person's ability inhibits performance of a job, ask, "How would you
perform this job?" For example:

* Inappropriate: "I notice that you are in a wheelchair, and | wonder how you get around.
Tell me about your disability."

» Appropriate: "This position requires digging and use of a wheelbarrow, as you can see
from the job description. Do you foresee any difficulty in performing the required tasks?
(If so) Do you have any suggestions as to how these tasks can be performed?"

Interviewing People Using Mobility Aids

When talking with a person in a wheelchair for more than a few minutes, use a chair,
whenever possible, in order to place yourself at the person's eye level to facilitate
conversation.

Never lean on the person's wheelchair. The chair is a part of the body space that belongs
to the person who uses it.

Enable people who use a cane, wheelchair or crutches to keep them within reach.

Be aware that some wheelchair users may choose to transfer themselves out of their
wheelchairs, into an office chair, for the duration of the interview.

Interviewing People with Vision Impairments
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When greeting a person with a vision impairment, always identify yourself and others who
may be with you. Say, for example, "On my right is Penelope Potts." When conversing in
a group, give a vocal cue by announcing the name of the person to whom you are
speaking.

If the person does not extend their hand (to shake hands), verbally extend a welcome.

Speak in a normal tone of voice. Do not shout at a person who is blind or visually impaired
- he/she can hear you.

Indicate in advance when you will be moving from one space to another, and let it be
known when the conversation is at an end.

When offering seating, place the person's hand on the back or arm of the seat. A verbal
cue is helpful as well.

If you move to another area, ask the person if they want your arm. Normally, the person
will hold onto your arm at or slightly above the elbow. Give warnings of any coming
obstacles, such as stairs or signs sticking out from the wall.

Interviewing People with Speech Impairments

Listen attentively when you are talking to a person who has a speech impairment. Keep
you manner encouraging rather than corrective. Exercise patience and stifle any urge to
complete a sentence with or for the applicant.

When necessary, ask short questions that require only short answers or a nod or shake of
the head.

Never pretend to understand if you are having difficulty doing so. Repeat what you
understand, or incorporate applicants' statements into each of your following questions.
The person's reactions will clue you in and guide you to understanding.

If you have difficulty communicating, be willing to repeat or rephrase a question.

Do not raise your voice. Most people with speech impairments can hear and understand.
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Interviewing People Who Are Deaf or Hearing Impaired

Use a normal tone of voice when extending a verbal welcome. Do not raise your voice
unless requested. Shouting won't help. Shouting distorts sounds accepted through
hearing aids and inhibits lip reading.

Not all persons with hearing impairments can lip-read. If the applicant lip reads,

» Look directly at the applicant, speak clearly at a normal pace and do not exaggerate
your lip movements or shout.

» Speak expressively because the person will rely on your facial expressions, gestures
and body movements to understand you.

« It will help if you place yourself facing the light source and keep your hands and food
away from your mouth when speaking.

In order to facilitate conversation, be prepared to offer a visual cue to a hearing impaired
person especially when more than one person is speaking. You might nod your head or
point to the person speaking if they are out of the applicant's field of vision.

To get the attention of a person with a hearing impairment, tap the person on the shoulder
or wave your hand slightly.

Brief written notes may be helpful.

If an interpreter is present, he or she usually sits beside the interviewer, across from the
applicant. This allows the applicant to see the interpreter more easily.

Interpreters facilitate communication. They should not be consulted or regarded as a
reference for the applicant. Remember to maintain eye contact with the applicant, and
direct your questions to the applicant, not to the interpreter.

Expectthe interpreter to interpret everything, not just your direct questions. The interpreter
is acting much like the ears of a hearing person.
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IT IS THE POLICY OF ODOT TO ENSURE
THE ESTABLISHMENT OF AN ALCOHOL
AND DRUG-FREE WORKPLACE AND TO
FOLLOW FEDERAL PROCEDURES
OUTLINED IN 49 CFR, PARTS 40 AND 382,
AND THE STANDARDS FOR
WORKPLACE DRUG AND ALCOHOL
TESTING ACT, OKLAHOMA STATUTES
TITLE 40, SECTION 551, ET. SEQ.

IMPLEMENTATION (SPECIFIC)

1.

Policy Communication

This policy shall be conspicuously posted in all working units of the agency in
the same manner as personnel postings. All affected ODOT employees and all
prospective employees who have been given a conditional letter of employment
shall receive a copy of this policy and all future updates. Each division is
responsiblefor obtaining written documentation that each affected employee has
received a copy of this policy as well as any future policy changes. Each division
head shall designate a division employee to coordinate all aspects of the drug
and alcohol testing program. The Division’s Drug & Alcohol Testing Coordinator
will be responsible for both the Commercial Driver’s License (CDL) equipment
operators and all other employees.
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2. Affected Employees

All permanent and temporary employees are subject to this policy.

3. Type

a.

s of Testing

Pre-Employment - All persons accepting a conditional offer of employment with
ODOT must take a pre-employment drug test. All candidates conditionally offered
transfer or promotion into positions requiring CDL licensure must submit to testing
for drugs. Positive test results will prohibit the hiring of an individual and the
promotion or transfer of a candidate into positions requiring CDL licensure.
Internal candidates testing positive on a drug test will be referred to the Employee
Assistance Program (EAP).

If the hiring is in the Central Office the official making the conditional offer of
employment will arrange for drug testing for the candidate through the Safety
Branch/Maintenance Division. Field division personnel will follow testing
procedures established for the field divisions.

Random Testing - Equipment Operators with CDL'’s will be subject to random
alcohol and drug testing. A minimum annual testing, at the rate of 50% for drugs
and 10% for alcohol, will be administered. These tests will be unannounced and
spread reasonably throughout the calendar year. The division will provide a list
of the names, social security numbers and work locations for all affected
employees. ltis the division's responsibility to keep this list current and inform the
alcohol/drug testing vendor of any changes.

Reasonable Suspicion - All employees are subject to reasonable suspicion
testing. Reasonable suspicion means a belief that an employee is using or has
used drugs or alcohol in violation of the employer’s written policy. Reasonable
suspicions are drawn, in light of experience, from specific objective and articulable
facts and reasonable inferences drawn from those facts. It may, among other
things, be based upon:
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(1) Observable phenomena:

(a) the physical symptoms or manifestations of being under the influence
of a drug or alcohol while at work or on duty, or
(b) the direct observation of drug or alcohol use while at work or on duty.

(2) Report of drug or alcohol use while at work or on duty, provided by reliable
and credible sources and which has been independently corroborated.

(3) Evidence:

(a) that an individual has tampered with a drug or alcohol test during his
employment with ODOT, or

(b) thatanemployee isinvolved in the use, possession, sale, solicitation or
transfer of drugs while on duty, on ODOT premises or operating an
ODOT vehicle, machinery or equipment.

Reasons for submitting an employee to this type of testing must be documented
by the immediate supervisor or the supervisor in charge and another supervisor
who both have received the required 2 hours training under 49 CFR, Section
382.603. All supervisors are required to receive the training. The training
documentation will be maintained by the Division’s Alcohol & Drug Testing
Coordinator. Each reporting supervisor must have completed one hour of training
on alcohol misuse and one hour of training on drug misuse prior to referring the
employee for reasonable suspicion testing.

A reasonable suspicion form must be completed and signed off by both
supervisors. Following completion of the reasonable suspicion form, the time
constraints for testing will conform to those under section 3d, Post Accident
Testing. Testing will be arranged through the respective division office. Following
testing, the reasonable suspicion form will be forwarded to the Division’s Alcohol
& Drug Testing Coordinator and filed according to section 7, Confidentiality.

Post-Accident Testing

(1) All employees are subject to post-accident testing. Equipment Operators
with CDL’s who are involved in a vehicular accident in an ODOT vehicle will



POLICY DIRECTIVE

OKLAHOMA DEPARTMENT OF TRANSPORTATION

NO. A-401-4

SUBJECT ALCOHOL AND DRUG TESTING paceNo. 4 of 9
DATED 8-31-04
EFFECTIVE DATE ISSUED BY APPROVED
August 31, 2004 DIRECTOR s/s Gary M. Ridley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-401-4 All 07-20-02

be tested for both drugs and alcohol under the circumstances indicated in the following table.

Type of Accident

POST-ACCIDENT TESTING

Citation Issued to The

Tests Must Be

Involved Driver Performed
Drug & Alcohol

Human Fatality Yes Yes

No Yes
Bodily Injury With Yes Yes
Immediate Medical No Yes
Treatment Away from
the Scene.
Disabling Damage to Yes Yes
Any Motor Vehicle No Discretionary

Requiring Tow Away.

(2) All employees are required to undergo post-accident drug and alcohol
testing if there is a reasonable suspicion that the employee or another
person has sustained a work-related injury or that ODOT property has
been damaged as a direct result of the employee’s use of drugs or
alcohol. This includes damage to equipment in an amount, reasonably
estimated at the time of the accident, to exceed $500.00.

(3) If the employee has not submitted to an alcohol test within 2 hours of the
accident, the supervisor must record the reason(s) a test was not given. If
the employee has not submitted to an alcohol test within 8 hours, the
supervisor must cease attempts to have the alcohol test administered and
record the reason(s) a test was not given.
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(4) If the employee has not submitted to a drug test within 32 hours the
supervisor must cease attempts to have the drug test administered and
record the reasons a test was not given.

(5) If the employee tests positive the Progressive Discipline table in section 5b
will show the minimum guidelines. Depending on the accident, more
stringent discipline can be implemented.

Return-to-Duty Testing

Employees will undergo a return-to-duty drug or alcohol test after engaging in
prohibited conduct regarding drug or alcohol misuse. Before an employee returns
to duty he/she will undergo a return-to-duty alcohol test if the conduct involved
alcohol The test result must indicate a breath alcohol level of less than 0.02. A
controlled substance test, with a verified negative result, is required if the conduct
involved use of a controlled substance. Employees will be assigned duties, in the
unit or division, which will not require the performance of a safety-sensitive
function. They will not be allowed to operate a motor vehicle until such time as the
results of the return-to-duty test are received. Employees will not be required to
pay for the return-to-duty test.

Follow-Up-Testing

After engaging in prohibited conduct regarding drug or alcohol misuse, each
employee will be subject, upon the recommendation of the Substance Abuse
Professional, to a minimum of 6 follow-up drug or alcohol tests. These tests will
be administered in the first 12 months following the date of testing that resulted in
a positive test for drug or alcohol misuse. These tests will be performed by
ODOT's current contract vendor and the employees will be responsible for the cost
of follow-up testing and will pay for these tests in advance.

Upon return to duty the employee will submit, to the Division’s Drug & Alcohol
Testing Coordinator, a cashier's check or money order made out to the drug
testing vendor. The cashier's check or money order will be in the amount of the
contract price for one drug and/or alcohol test depending on the recommendation
of the Substance Abuse Professional. After each follow-up test the employee will
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submit another cashier's check or money order made out to the drug testing vendor, thus
ensuring the employee has paid for his/her next test. Once follow-up testing has been
completed, the last cashier’'s check or money order will be returned to the employee. Failure to
submit a cashier’'s check or money order will be treated the same as positive test results and
appropriate discipline will be progressively applied. See section 5b, Progressive Discipline table.

4. Types of Drugs and Drug Testing Procedures

a.

In accordance with federal regulations, drug testing will be conducted for the
following drugs:

(1)
(2)
(3)
(4)
(5)

Marijuana (THC metabolite)
Cocaine

Amphetamines

Opiates including Heroin
Phencyclidine (PCP)

Testing is a two-stage process:

(1)

(2)

First, a screening test is performed. Ifitis positive for one or more of the five
drugs listed, then a confirmation test is performed using gas chromatography/
mass spectrometry analysis. Positive results must be reviewed by a Medical
Review Officer (MRO).

Second, the MRO will personally contact each employee having a positive
drug test result to determine if there is a medical reason for a positive test
result. The MRO will provide the final report to the appropriate Division’s
Drug & Alcohol Testing Coordinator. Split-specimens will be collected at the
test site. In the event of a positive test result on the first specimen the
employee may submit a written request to the Division’s Drug & Alcohol
Testing Coordinator asking that a test be conducted on the second
specimen. This must be done within 72 hours of receiving a positive test
result. The employee must pay ODOT’s current contract vendor in advance
for the second specimen testing. If the test results on the second specimen
are negative, the employee will be reimbursed by the Department. Testing
for alcohol will be performed using breathalysers as specified in federal
regulations.
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5. Actions When Test Results Are Positive
a. Removal of the Employee from Safety Sensitive Functions

Alcohol concentrations of .02 to .039 will necessitate removal of the employee
from safety sensitive functions for a minimum of 24 hours as required by 49 CFR,
Section 382.505. Employees will not be allowed to operate a motor vehicle during
this time.

b. Progressive Discipline

The following table indicates minimum required levels of discipline and program
requirements on positive test results. Employees may also be suspended or
discharged for any offense depending on documented poor job performance and
disciplinary record. Part of the documentation required in the disciplining process
is the completion of the EAP referral form.

PROGRESSIVE DISCIPLINE
ALCOHOL
ALCOHOL LEVEL .04 AND HIGHER
1% Offense 15 Day Suspension Without Pay
2" Offense 30 Day Suspension Without Pay
3" Offense Discharge
DRUGS
1% Offense 30 Day Suspension Without Pay
2" Offense Discharge
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Employees refusing to take a drug or alcohol test will be subject to return-to-duty
and follow-up testing as previously described. Refusals will be treated the same
as positive test results and appropriate discipline will be progressively applied with
each refusal.

An adulterated test specimen, as determined by the testing laboratory, will be
deemed a positive test.

Suspension with Pay

Upon notice of a positive drug or alcohol test the employee will be given written
notice of disciplinary action. The employee will be placed on Suspension With Pay
in accordance with Merit Rule 530:10-11-120 from the time of notification of
positive test results until the time of the pre-disciplinary hearing.

6. Employee Assistance Program Referral

a.

It is mandated that all employees with positive test results will be automatically
referred, by the appropriate division head, to the ODOT Employee Assistance
Program (EAP) Coordinator. The employees will immediately contact the EAP
Coordinator who will then refer them to a Substance Abuse Professional (SAP).

These employees are required to be evaluated by a Substance Abuse
Professional (SAP) for each positive test, including follow-up tests. The SAP will
determine what assistance the employee needs in resolving problems associated
with alcohol misuse and controlled substances abuse. These employees cannot
return to work, perform safety sensitive functions, or operate a motor vehicle until
they have been evaluated by a SAP and have successfully complied with SAP
recommendations.

In addition, each affected employee identified as needing assistance in resolving
problems associated with alcohol or controlled substances will be evaluated by a
SAP to determine that the employee has followed the rehabilitation program
prescribed. Failure to successfully comply with the SAP’s recommendations will
result in more stringent disciplinary action up to and including discharge.

7. Confidentiality

All tests and all information related to such tests referred to in 49 CFR 382.401
(memoranda, reports, statements, etc.) are confidential. All such reports must be
maintained in secure files, marked confidential and kept separate from personnel files.
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The records may not be released to any person other than the applicant, affected employee, or
any person directly involved in disciplinary action or assistance referral, and by lawful court order.
An employee may obtain their records by submitting a written request to the Division’s Alcohol &
Drug Testing Coordinator.

IMPLEMENTATION (VOLUNTARY)

Employees may volunteer as participants in a drug and alcohol random testing program. These
volunteer participants may not be counted toward the random testing totals referenced in section
3b, Random Testing. Volunteers must contact the individual division head in writing requesting
voluntary program participation. Under no circumstance will anyone be coerced or otherwise
influenced to volunteer. The names of volunteers will be submitted by the division head directly
to the testing laboratory service, who will select participants on a random basis in the same
percentage as that established in section 3b. Positive test results will be handled in the same
manner as mandatory participant test results.

ASSIGNMENT OF RESPONSIBILITY
The statewide Drug & Alcohol Coordinator will be the Branch Manager of the Safety Branch/

Maintenance Division, and will ensure compliance with Title 40, Oklahoma Statutes, Section 551 -
565 and 49 CFR, Parts 40 and 382.
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POLICY

OKLAHOMA  STATE STATUTES
PROVIDE THAT ALL STATE
EMPLOYEES SHALL BECOVERED BY
WORKERS' COMPENSATION
INSURANCE THROUGH
COMPSOURCE OKLAHOMA (85 O.S.
§ 2.1), AND ENSURES THAT
EMPLOYEES RECEIVE THE BENEFITS
TO WHICH THEY ARE ENTITLED
FOLLOWING A WORK RELATED
ILLNESS OR INJURY.

No employee shall be discharged because he/she has filed a Workers’ Compensation claim.

IMPLEMENTATION (SPECIFIC)

. WHEN ACCIDENTS RESULT IN INJURY/ILLNESS

A. Reporting Work Related Injuries/llinesses

Employees who sustain injuries/illnesses while performing work related tasks are
responsible for reporting the injury to their supervisor as soon as possible after the
accident occurs. Failure to report an injury within thirty (30) days may cause a claim to
be disallowed by the Workers’ Compensation Court (85 O.S. § 24.2) .

B. Investigating Accidents

The supervisor shall ensure that the accident is investigated, all possible verification is

obtained, and a record of the reported accident is maintained.

Division Safety

Coordinators and Division Heads shall immediately be advised of the circumstances of
the accident and the extent of the injury/illness.
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C. Medical Assistance

The supervisor shall ensure that prompt medical treatment is rendered. If employees
require medical treatment they shall be provided with a Certified Workplace Medical
Plan “Authorization to Treat Form.”

Il PROCESSING WORKERS’' COMPENSATION

A.

Form No. 2, “Employer’s First Notice of Injury”

The employee’s immediate supervisor shall prepare a Form No. 2 “Employer’s First
Notice of Injury” and the Oklahoma Department of Transportation’s “Supervisors First
Report of Injury” in each instance where an employee claims to have suffered an on-
the-job injury for which compensable work time is lost or medical attention away from
the work site is received (85 O.S. 8§ 24.1). In every instance where the employee will
be off work due to the claimed illness or injury for more than three (3) consecutive
calendar days (including regular days off), a statement, Form M-29, must be provided
which indicates whether or not any leave will be used.

The supervisor shall fully investigate the accident and report all findings on the
Oklahoma Department of Transportation’s “Supervisor’s First Report of Injury.” Both the
“Employer’s First Notice of Injury” and the “Supervisor’s First Report of Injury” shall be
signed by the supervisor.

All forms shall be forwarded to the Division Workers’ Compensation Coordinator
as soon as possible. The Division Workers’ Compensation Coordinator will report
the injury/illness to CompSource Oklahoma through Teleclaim or through the internet
and forward a copy of all paperwork to the Safety Branch.

Benefits
1. Medical Expenses (85 O.S. § 14-15)
Benefits include all medical, surgical, nursing and hospital services, medicines,

crutches, and prosthetic devices, as well as documented travel expenses outside
the employee’s city of residence.



OKLAHOMA DEPARTMENT OF TRANSPORTATION

POLICY DIRECTIVE NO. A-404-1
SUBJECT WORKERS' COMPENSATION pAaGENO. 3 0of 8
pDATED 02-28-03
EFFECTIVE DATE ISSUED BY APPROVED
02-28-03 DIRECTOR s/s Gary M. Ridley
POLICY REPLACED POLICY NO. PAGE NO. DATED
Yes A-404-1 All 01-10-94

The Division shall forward any received bills or statements which reflect service
rendered in connection with the work related injury to CompSource Oklahoma or
the Safety Branch.

Employees may not seek medical treatment other than from the original treating
physician, unless referred by that physician, or with the prior approval of
CompSource Oklahoma or the Certified Workplace Medical Plan.

Compensation

a.

Temporary Total Disability

Claims for Temporary Total Disability compensation are generally initiated
when the employee files a Form No. 2, “Employer’s First Notice of Injury.”

Employees who are off work more than three (3) consecutive calendar days
will receive Temporary Total Disability payments. The compensation benefits
normally start on the fourth day of Temporary Total Disability. At the option
of the employee, Temporary Total Disability payments may be supplemented
by any Sick Leave or Annual Leave to the extent that the employee shall, if
he/she has the accruals, receive full wages during the employee’s work
absence.

Payments for Temporary Total Disability are equal to 70% of the average
weekly wage of the employee (limited to the State’s average weekly wage)
and may be collected for fifty-two (52) weeks, reviewable by the Workers’
Compensation Court after forty-two (42) weeks. Upon a finding that benefits
should be extended beyond the initial fifty-two-week period, compensation
may be continued for an additional successive fifty-two (52) week period,
provided the employee has requested review of the case at forty-two (42)
weeks during each period involved and upon a finding by the Workers’
Compensation Court that benefits should be extended (85 O.S. § 22. [2]).
Total payments of compensation for Temporary Total Disability may not
exceed a maximum of one hundred fifty-six (156) weeks.

If the employee takes full paid leave and receives a Workers’ Compensation
payment for that period, the next available pay check will be reduced by the
amount paid in excess of regular wages for that period. The same policy
applies to Terminal Leave payments. Applicable leave will be reinstated if
regular wages are reduced.
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Immediately following the return to work of any employee who was receiving
Temporary Total Disability, CompSource Oklahoma and the Safety Branch
will be notified of the date of return.

Temporary Partial Disability (85 O.S. § 22. [4])

Payments for Temporary Partial Disability are available to employees who
return to work at a wage less than that which they were earning prior to the
injury. Temporary Partial Disability may be collected for fifty-two (52) weeks,
reviewable by the Workers’ Compensation Court after forty-two (42) weeks.
Upon a finding that benefits should be extended beyond the initial fifty-two
(52) week period, compensation may be continued for additional successive
fifty-two (52) week periods. This is provided that the employee has
requested review of the case at forty-two (42) weeks during each period
involved and upon a finding by the Workers’ Compensation Court that
benefits should be extended. Total payments of compensation for
Temporary Partial Disability may not exceed a maximum of one hundred fifty-
six (156) weeks. Payments equal 70% of the difference between the
employee’s average weekly wages and the employee’s wages while on
Temporary Partial Disability.

Permanent Disability.

Determining disability shall be the responsibility of the Workers’
Compensation Court and any claim for permanent disability must be
supported by medical evidence (85 O.S. § 17).

(1) Permanent Total Disability (85 O.S. § 22.[1]) benefit payments are
designed for workers who are incapacitated because of accidental injury
or occupational illness and are unable to earn any wages in any
employment.

Total Disability shall be determined by the physician’s reports,
agreements made between the employee and CompSource Oklahoma
and decisions of the Workers’ Compensation Court.

(2) Permanent Partial Disability (85 O.S. § 22. [3]) payments are designed
to reimburse an employee for any disability which is permanent in
nature but which is not totally disabling.
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Payments shall be made for a scheduled number of weeks, depending
on the nature of the disability.

3. Death Benefits (85 0.S. § 22.8)
Death Benefits are available to dependents of an employee who dies as a result
of an occupational injury or illness. Payments are available in a variety of ways,
depending on marital status and number of dependents.

4. Rehabilitation (85 O.S. § 16)

Payment for physical or occupational rehabilitation services may be provided by
Workers’ Compensation insurance.

RELATED PERSONNEL TRANSACTIONS

The Division shall explain to the employee applicable Merit Rules and review the following
information:

A.

Leave Requests

Employees may elect to supplement their Temporary Total Disability with accumulated
Sick or Annual Leave or request Leave-Without-Pay (74 O.S.8 840- 2.21). Request for
Leave-Without-Pay for up to one year shall be granted by the Division Head.

A written request from the employee and a medical statement which indicates the
employee is unable to perform the required job duties and which specifies a date by
which the employee should be able to return for work shall be submitted as soon as
possible after injury, preferably before the start of Leave-Without-Pay. If, however, it
is not possible for the employee to submit a written request or medical statement
immediately after the injury or prior to the start of Leave-Without-Pay, the employee
may be granted a period of Leave-Without-Pay, not to exceed fourteen (14) days, in
which to submit the request and statement.

Any extension of Leave-Without-Pay beyond the initial fourteen (14) days must be
requested in writing and be accompanied by a medical statement. Extensions of leave
without pay beyond one year may be granted in accordance with Merit Rule 530:10-15-
47(a)(1), at the discretion of the Division Head, not to exceed one additional year.
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Leave-Without-Pay may be canceled or not extended, in accordance with Merit Rule
530:10-15-47(a)(5), should the employee fail to return to work at the end of a Leave-
Without-Pay period, or fail to submit the required medical statement, or fail to return
when the medical statement indicates the employee is medically able to perform the
duties of the original position.

Me